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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - EISEE O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Oradke Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracle andior fs afflstes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andlor s af filates. Otfer names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your lcense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, modify, liense,
transmit, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice i
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inciuding any operating system, inegrated
software, any programs installed on the hardware, andior documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, & Sign Out[QA]
Change Password

m  UserInfo i3]

— Change Password — Click to change the current password.
L 7 I— TR

-
ek

Ir

s
e
-
-
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions | Users -
Database Server Log Files
View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 D2/18/2016 06: 1% 11 AD »
ALERT lob 395 02/22{2016 03:58:16 AN_|
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSYPRC_EN_100_01_DB12C_3854338 lob 116750 02/22/2016 05:36:42 A} 7
JSVPRC_EN_000_01_DB12C_2004362 lob 5706 02/18/2016 10:57:09 AP =
4 m ] r
r
File Content
View = Format ~ Freeze I Detach &l Wrap o0} 7 Beginning @ End  # of Lines ' 50 [E] Show File
Text
0 7:44:11: 45:FLL:1v_use BI::¥ [
o 7:44:11: cmnsyp cl_DOD_Dl.get_syp parameter value value: weblagic
0 4:11 .get_syp parameter value value: http://ofss2221142.in.oracle.com:.
0 4:11 .get_syp_parameter_value value: http://ofss2221142.in.oracle.com:
o 4:11 .get_syp parameter value value: /scratch/work area/DEV/QAL43REL/r. |
0. S JSV_BI_USER
o} 4:11 1.get_syp_parameter_value parame J5V_REPORT_ARCHIVE_DIRECTICRY
0 4:11 1.get_syp_parameter value parameter: JSV_REPORTS SERVER TIMECUT A

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

» DashBoard
> Origination
Servicing
Eles 5
Customer Service Il
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management |
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @ | Access x (0 Gose
Applcation Retrieval{Originatior) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild Fpadd || ZEdt | [Fvien || At
, 3
Account Documents(Servicing) Vew~ Fomat~ | B Freeze (o Detach virap ®
Access(Setup User)
P ————— Organization Divion Company Branch Alowsd
‘rsnssc ors(sevieng ntefoces e R AL AL ¥
Applcation Entry(Origination) e e AL AL ¥
Audit Tables(Setup Systerm) e B AL AL \
Advances(Servicng Batch Transactions) e P04 AL AL A

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

RACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA + [=}

Sales ead x Close
> DashBoard s L.

/Le;aknl’l’v Follow-p | Maintenance
% Fresze

Applicant Information

= )
e

L-00003002 121772015 uso1 £onD rES rorE
L-o0002002 121212015 uso1 usii PIANINDRA ciioa tore
L-o0002004 12/12/201 uso1 usii DoRCH oocRT 1ot X
Looooco02 02/02/2010 uso1 usiio N 20510 CONSULTATION  OFTLINC APPLICA.. 1IOM ADD1 A
Loooo1001 121072015 uso: usko ANDRES ManTInez o8/06/1980 CONSULTATION  wes ENTRY HowE LeAD ey 22
L aoooson2 122372015 uso: usko A san 11232901 HowE UNITEDSTATES 123 ronce

ke || Reauest

b add || Z oo |[ Elview || o ave
rrrrrr 2 petact @

rrent

Te
CARJMOBILE PHONE

Phone Cur
(0045323923 ¥
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You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
5

o Efioctach

AUL) PAULA 02/09/2010 crarceporr error VeRourru
20160100014000:000 SUmAN G2ioa/200 Clianccoorr CRnon Vemoun
uetach wee | @
Vue e
o350t ¥
\ Y

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE' 1 ABSHEKAR ¥ g Signout O
Financial Services Lending and Leasing

a‘| Origination » || Origination 5 | Crigination x = Origination x (36 Close
Search/Task  Funding: 0000001010 | Review Requests (Pendng: 0) £
> DashBoard
Origination Application: 0000001010: MILLEN JOHN Elvew | o Audt
- - Fresze i Detach 0 virzp v Wam v
pr—— View ~ Format B i P W overide ok jarming CK MANUAL Contract
ot A= Sub Unit Status nanasen SE8E  produce tame mrd‘::fr COMBEL o geting Customer  Dupicate Appication Cantact 3
imple Application Entry
07/25/2036 0000001030 UNDEFINED APPROVED - FUND... FUNDED MN-00004: SOUT.. (612)451-2211 N ¥
Application Entry = & .
Underwriting
Funding
Application Retrieval
S Anys Summary | Appicant | Request | Decision | Contract | Colateral | Comments || Trackng | Document | Verification | Correspondence | Tools
Application Documents
Image Mantenance At
Reports
Producers Applicant
s Pl Relation Type First Name Last Name Brth Dt Own fRented
2| PRIMARY JOHN MILLEN 07/17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IfPmt Amt. Assets Amt Lisbilties (3 Net-Worth Amt
> 0 0.00 0.00 0.00 0.00
Bureau
> Servicing
> Collections Bureau
> WEP Buresu Report Name FICO Score Tradelines Auto Tradelines ¢ P BI® Notices (FE)  Type ot
> Tools [ » [o0 CREDIT REPORT ... JONATHAN JENKINS 536 % % o 0 MANUAL 07/26,
> Setup bl . -

1-7 ORACLE



Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |:to toggle the view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" # Welcome, VavAIDYA - ESTROWIGN O
Financial Services Lending and Leasing

Close.
> DashBoard Origination x —

origination Search/Tosk | Funding: 0000000378 | Review Requests (Pending: 0)

Application: 0000000378: TIFFANY RUSSEL / GRACE B view || o audt
Vieww Format~ B ] Freeze i Detach wap | @) OvemideOK ¥ WamingOK ¥

— Hentfication
Applcation Coptac ' i
01/01/2012 0000000378 UNDEFINED APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Origination Stage

ot App Sub Unit status e

pre
Producer liame Co Bxisting Customer
t
, Summary
Requested  Approved
1500000 1500000

8.9900 43900
3 3

Summary | Applicant | Request || Decision | Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

> Applicant

‘ » Ratios

> Bureau

> Checklist Change Status

Status APPROVEE

Collateral

Collateral

Asset Type SubType Primary  Year Hake Hodel Hileage New Wholesale Value
~ Servidng VEHICLE AR Y 2012 CHEVROLET. MONTE CARLO on 10,000.00
> Collections Type =
3 Sub v
RAWED Trade-In Type
> Tools * Comment
> Setup Trade-In > -

Add Comment
= Alert

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Customer service EE
seach
Quick Search
Elven || Pasit ek
foen ® @ B ©CurenO shon O GoupFolowss
bt At = ot DayspastDue urency PayOfiAnt  amountue Stais OdestoueDt  DiQesson
oETED 0170100010057 | LOANVEHICLE () o 153855 2,21 (R opoporr steameToR.
Bwat| [ @oex
Servee | AcountDetal | Customer Detals | Customer Prferences | Transacion story | Pt Modes || Benknptcy | Repoffrecoare | Defency | Clatrl | Bureau | Timelne || Crossfp sl Acotes | Extena nterfoces
Q= =
Aerts Condtions
B tiextAccont
Alerts Conditions
At Account Condien ConditonstartDt Folowp 0t
. o e Accant
Nodata o deply Repossession pmy ooz L
oemaET csmy o P —
e RESAA 5]
sy B
Account Details OtherInformation o
Dues Colateral Information
sy ejomy  oomy  oeomy  osiop Py Descon Uertfatm s Year At AmetTipe  SbTie
g =m0 =0 3 9 sz v P6CEROETHONECRLO DR BAPASGORIRIS2 205 N Wz om
s 2
3 Customer Information Hpostgoment | | @0
T = e etien = oD o e oliaiil
7 oo HAOHAN ORACE ProwRy o casiises noened o =
ot ozwn «
=
o1 EDULSRSIQOMAL COM E . =
s Actve [
P Corrspdence N
Colector DEMOCOLL
Address Information =
pemsson
e Coment PSS ey adkess e )
Activities e v v e s &
x Charge offot =
- ity Dty N "
i 2 5 Employment Information

B Postcal ctvity | [ @ Clesr

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘ldentification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to

increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.
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Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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1.4.2

1.5

1.5.1

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pau\ewR!qhe:t‘\Penmng:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt
Vieww Format 5} Freeze PfiDetach | Jwap | @) & @ Curent O showAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eun'n'al‘,‘ Customer Service = Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankruptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSeH»‘-L‘t\‘,‘\tie:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Follovup Dt Time Zone Adj Folloviup Dt Con
AT PH ANSWERING MACHINE N 12/30/2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM

b

You can click # to view the hidden tabs, if any.

Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬂr Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

LI b showal
| Freez= + Product |
Detadh + Description ,
#ork » ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| e
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column = I

Column DESCRIPTION

width | 100 ] [pixels [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format{ Freeze i Detach o1l Wrap o)
¢ | | @) %) i_
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
! I | | |cotiateral Sub Tyoe |CreditBureau
Jproduct et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B 12 Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED
LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
LOAN-UN i &1 /01/1800 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT
LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT
s NORMDSER. 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT
o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
opacLe
Financial Services Lending and Leasing g C)

—— Ly customer serce =
> Origination Search | G : quest (Pending: 0) -
Servicing
Setiia Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view || «2 Audt
Cusbootns Senice Vieww Formatw [ Freeze 5 Detach o wrap W & @ curent O ShowAll C: Group Follow-up
Securitization Company Branch Sub Unit Account Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 2012020000231 LEASEVEHICLE 01 000 0.00 ACTIVE o2j10/2015

Post Date Checks
Escrow Transactions =
e Summary | Customer Service | Account Details | Customer Details | Transaction History | Pmt Modes || Bankuptcy | Repo/Foreclosure  Deficiency  Collateral | Bureau | Cross/Up Sell Activites
ccount Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence  Letters Document Tracking

Repoits
Producers
Vendors Transaction Batch Information padd | At || Fview | & Auit
Batch Transactions Views Formatv [ Freeze B Detach Wrap W Frrost [ vod
bk Transaction Status Batch

ADD CUSTOMER ADDRESS PHONE POSTED
TERMINATE ERROR

Interfaces TERMINATE VoID 4
nunbnts EEusION o
Detached Table *
View~| Format v [ Frecze [[EBetadh vap @ ot [5hvoid
Date Monetary Transaction Status Batch
0aj10ja016 N ADD CUSTOMER ADDRESS PHONE POSTED 0
01/07/2016 id TERMINATE ERROR N
oy/05/2016 v TERMIATE von N
01/06/2016 i EXTENSION Vol N
Lot v PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze £ Detach wap @
> Collections Transaction Processing Detils
SWER. (] | Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE" % Welcome, VAVATDYA v o

Financial Services Lending and Leasing
i Customer Service x Wcloe
> Origination Search | G quest (Pending: 0)
Serviding
sarviing Account(s): 20151200010012: MADHU BOBBURI Eview |[ Pt

Customer Service View v Fomaty [ Freeze i Detach Nrap W & ® curent O showAll O Group Follow-up

Securitization Company Branch Sub Unit Account = Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt

skl uso1 usHg 2015120001002 LOANVEHICLE (FR), 5031881 ERUERT] ACTIVE:DELQ:NON PERFO.. (BTN

Transaction Batch Information

Escron Transactions 5
g B Sunmary | Customer Service | Account Detals || Customer Details | Transaction History | Pt Hodes || Bankruptcy | RepojForedos’ ¢ 2= =
Collateral Management Call Activities Maintenance Commen ts || Promises | Checkists | Tracking Attributes || References  Correspondence | Letters [ Jgearch T —
® a1 O any
Transaction Batch Information f o add |/ gat iew || < Audit
View v Formatv [ Freeze ! Detach Wrap (5] EPost  [G1 Void cription
Date Wonetary Transaction ACCOUNT CL r 3
a/10f2016 ¥ pltase Search: Transacti
‘ 01/25/2016 [ ACCOUNT SUB UNIT TRANSFER AiSTET
03/22/2016 », ACH MAINTENANCE esciplion Seany s
oyj072016 [ ACH ONE TIME PHONE PA pl i L
/ i ACHON NE PAY ADIUSTIENT Match @ all © Any
GLTransactions 12/15/2015 v ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD by
o 5

Reset | | AddFields ~|| Rearder

Date 02/10/2016
* Monetary @

ok || Cancel
> Collections B | [ Freeze £ petach )
Cil Required
MR o data to dicplay.
> Tools
bisen Result ,

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02 : PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
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1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a

combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt +y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the

keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Operating

monic

Browser Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
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1.7

1.8

1.8.1

1.8.2

1.8.3

Shortcut Action

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
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Usage of styles and formatting elements
Documentation in simple language to ensure easy understanding

Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE
Financial Services Lending and Leasing

Nelcome, PRAKRRAO v o

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

&P Reset Criteriz || @8 Search
View = Fomatv  [E| @Fresze Fivemch | o Wrap &

e ~]
Lixe = =
Lixe ~l
EQU [~
LIKE ~]

Lie vl
EQUAL =
e I~
ke ~
EQuAL ~]
e [~
e ~]
LIKE >l
Lixe ~]
Lixe ~T
Lixe [~ =
) Lixe ~1
e

<

L Open Account

Search Results
View » Fomatv B Frecze A Detsch oo | @
> Collections ‘Company Branch Account F Date Title Product Status. dD:y«:quency Amount Dus

v I
g

> WFP No data ta display.
<

> Tools

> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002
Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL . o .
Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817°)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817°)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

e 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
o 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an
application number greater than or equal to 0000000278.

Criteria Comparison Operator | Value

FIRST NAME EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria Comparison Operator | Value

FIRST NAME LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR

e JAN FISHER

e JANE MEYERS

e JANETTE NORDSTROM
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Application Status

While you are searching for an application in the Origination screens, the Search Result/
Task tab lists all the available applications and also the status of each application for edits.
The following table indicates the application status:

ORACLE’
Financial Services Lending and Leasing

DashBoard Origination (] Close
‘Origination SeardﬂTask Application Entry: 0000001023~ Review Requests (Pending: 0)
s -
;;;:ZG:S‘E:::;" ey App % D0DDDDIS37 SN Identification # B submit
Underwriting
Funding Queue [] | B Next Application
Application Retrieval
Scenario Analysis > Search Criteria
Application Documents
Image Maintenance ﬂl New Application D Open Application @ View Application Unlock Application
Reports
Producers Search Results/Task
Vendors View Fomaty [ Freee EiDetach | dwep @) vewAl M
Critical Locked  Allowsd  Company Branch Datz Tite Product Status Sub Status
e s USHQ 12/12/2015 CHODA PHANINDRA /... LEASE VEHICLE APPROVED FUNDED
0 UsoL UsHQ 12/14/2015 MADHU BOBBURI / BA... LOAN VEHICLE (FR) NEW BLANK i)
@ us01 USHQ 093 06/01/2015 HONEYSINGH YOYO LEASE VEHICLE APPROVED FUNDED
@ usot UsHQ 56 12/15/2015 BOND JAMES LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ UsoL UsHQ 62 02/02/2016 55AM LOAN VEHICLE (FR) APPROVED FUNDED
1 @ usoL UsHQ 05 08/01/2015 HOOD MARK LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ usot USHQ 01/04/2016 KABADE KIRAN LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL USHQ 02/02/2016 VANKAYA JOGAIAH LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL UsHQ 94 12/19/2015 MARTINEZ ANDRES / A... LINE HE (FR) APPROVED VERIFYING
@ UsoL UsR1 58 02/01/2012 LEWISJERRY [ JEAN LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 03/01/2012 JONATHAN RYAN / JUL... LOAN VEHICLE (FR} APPROVED FUNDED
%] NLZ NLRI [ PETER [ SHAR... LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 05/01/201 LKER SIDNEY / SAM... LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsR1 J0i: ER ANDY [ JEAN  LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 01/01/2012 TIFFANY RUSSEL/ GR.. LOAN VEHICLE (FR) APPROVED FUNDED
& Usot UsHQ 02/01/2012 TOLMAN GREG [EVA  LOAN VEHICLE (FR) APPROVED AUTO APPROVED
@ usot UsR1 03/01/2012 STANDFORD MICHEAL.. LOAN VEHICLE (FR) APPROVED FUNDED v
@ UsoL UsR1 04/01/2012 SAXTON MARTIN / CH... LOAN VEHICLE (FR) APPROVED FUNDED
< >
» Servicing
> Collections
> WEP
> Toals
» Setup

Description | Example Expression

CRITICAL Whenever any application is updated with dealer comments, a system
generated alert will be posted in the application and a critical icon would
be displayed in this column against that application. Once User has
acted on the critical item, the alert flag should be manually be
unchecked by the User to remove the 'Critical’ flag on the application.

LOCKED An application already opened by another User will have a lock icon in
this column against the application. User with appropriate privileges can
unlock the application and proceed.

ALLOWED This field displays whether you can open the application from the
respective Origination Screen or not i.e. if the application is in decision
stage, a red flag will be displayed in Application Entry stage indicating
that the application can only be viewed and User has to open the appli-
cation in Underwriting for actioning. User can also see a green flag in
Underwriting against this application indicating that it can be actioned in
Underwriting.
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2.2

2.21

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE" - 5
Financial Services Lending and Leasing
Cl
e DashBoard 5 [] Close.
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Product End Date Batch Job Status
Process Files No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App # Fricrity
No data to display.

My Pending Review Requests By Priority
Priority Count
No data to display.

5 Servicing Producer Vendor
Number of Queues Hard Assigned
A Producers Count By Status Vendors Count By Status
Queus Description Count
TR Status Count Status Count
ACTIVE 2 ACTIVE 35
Number of Accounts Pl eisc A
Queue Description R Producers Expiring in Next One Month Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.
My Pending Review Requests By Accounts
AcE Priority
No data to display.
> Origination My Pending Review Requests By Priority
Priority Count v
> Servicing No data to display.
> Collections
> WFP
> Tools
> Setup

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Lease origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2-6 ORACLE



Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE
Financial Services Lending and Leasing

inatie Close
TeT Origination E]
Origination Search/Task | Application Entry | Review Requests (Pending: 0)
Quick Search

Simple Application Entry . e ) = .

Application Entry App # sEN Identification # [ submit

Undenwriting

Funding Queus [] | [ next Application

Application Retrieval

Scenario Analysis > search Criteria

Application Documents

Image Maintenance P New application | | (L Qpen Application || [5] View application Unleck Application

Reports

Producers Search Results/Task

Vendars View~ Format~ [ Freeze [fiDetach | ol wrap W viewan O]

Crit Loc AlloCompany  Branch App 3 Date Title Product Status Sub Status Qu
Mo data to display.
< >
Columns Hidden 1
Pl

> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE
Financial Services Lending and Leasing

Origination x

DashBoard

Searci/Task || Application Bty || Review Reuuets (Pordiu: 0)
© Qulck search

Search Criteria

view - rormatw  [E¥] [ Fresss EfiDsmon ol wrep =N

~
Comparicon Oparator Bl vaive
EquaL <
EquAL ~
CREATER 1 HAN Ok ELUA -~ £
e =] =1
e < <
Like =
e =
Lice =
ke =]
e =
Like <l
Like ~
ke =l
e =
=F [~
e =
- New anpiicarion | | () Gnen Appiicarion | | (] view appiicarion Linkeric Applicarion
Search Results/Task
\iew ~ rormat—  [ER Froaza Eili Detach 1 wirsp @ view A ]
Bearh s + Oal Tt Product Status Sub Stats Qu

> Servicing
> Collections
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Lease origination, the results are sorted according to the priority of application
and application identification number. However you can sort the records using any
criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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2.2.2

The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
S Close
DashBoord Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Requests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || 2 audt
View v Fomat~ g Freeze i Detach Wrap @ OverideoK v  Waming OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  RTOdUCE! Bxsting Customer  DURHCR® Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACEH... (818)-761-2277 N
>
Summary || Applicant || Business || Request || Dedision || Contract || Collateral || Comments || Tracking || Document | Verification || Correspondence || Toals
Venders > Applicant
> Ratios
> Bureau
4
“
> Checklist
Collateral
Collateral
Asset Type Sub Type Primary  Year raka Model Mileage New Wholesale Volue  Retail
VEHICLE = ¥ 2015 Aupr A oy 15,000.00 18,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification * Year Make Model BaseRetail Amt  Addons
> Serviang vERICLE 2015 DODGE RAM... 3GCPCRECSEG145195 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
vErICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools
> Requested -
> Setup

You are now ready to begin work on the application.

Quick Search section

Quick Search enables to search for an application using any one of the following values -
Application Number, SSN, Identification Number or Queue.

To load an application using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. Inthe Quick Search section’s App # field, specify the application number you want to load
and click Submit.

You can also load the application by specifying the last 4 digits of the SSN Number. System
retrieves only those applications where the searched SSN is of the Primary Applicant. If
multiple matches are found, system displays an error message as ‘Multiple Matches found for
the SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

Queve <1 ([ Next Appication

Search Results/Task
i Format+ B Freere i ntach T viewan O]
ny = Date Title

> Servicing
> Collections
> WEP

> Tools
> Setup

The system loads the selected application.

To load an application from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Application.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

2.2.2.2 Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Lease information, credit
bureau data, and collateral information. The new application will have status/sub status as
NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE
Financial Services Lending and Leasing

P —— Origination i (3 Gose

Origination (@ Information

Application copy successful. New application # success
Search/Task | Underwriting: D00DDD1S57 | Review Requests (Pending: 0)

Quick Search
pp £ | 0000001537 SSN Identification £ [ submit
Queue [~] | BB Next Application
> Search Criteria
(] open Appication || [E] view appication | | Py unlock Application | £ [{Z] o
Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar O
Crit Loc Alle Company  Branch fop # Date Title: Product Status Sub Status Qu

No data to display.

> Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

Financial Services Lending and Leasing
iginati Close
mET Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
N Application: 0000001533 SIGG MARK Zede | Evew | o aude
simple Application Entry 7 —
Application Entry View - Format~ [ Freeze i Detach Wrap W overideok v  Waming Ok v
Undenwriting Origination Stage Producer Contact q Duplicate
i Dt App # Sub Unit Status Code Producer Nama Nuribar Existing Customer application ‘Conttact
Application Retrieval 05/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary  Applicant = Business Request Decision Bureau = Collateral Comments  Tracking Document \Verification ~Comespondence  Tools
Froducers
Vendors
Comments
i Elsaveandstay || [ save and Retum || G Retum
View v Format~  [Bp Fresze (i Detach 1l Wrap =)
Alert Type Sub Type ‘Comment Comment By ‘Comment Dt
O REGULAR [v] | LoAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
o
DECISION_MULTI OFFER LETTER GENERATED. ~ i
O SYSTEM GENERATED SYSTEM GENERATED {CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST ID: ¥
CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©1/29/2016 11:24:13 PM
> Servicing
> Collections
> WFP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" 2 Welcome, PRAKRRAO ~ o
Financial Services Lending and Leasing

i Close.
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

Sales Lead Quibchiseanch

Simple Application Entry ’ _ T 2 =
Apolication Entry App ¥  DO00001622 E=Y Identification # B submit
Underwriting & Warning *

Funding Queus 2 By

Boplication el [ [l Application is locked by: KGOUDU Phone: 0 - Ext.: 0

G Aol > search Criteria (oK)

Application Dacuments ||| — | e -

Image Maintenance (] Cpen Application | | [Z] view Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View » Format v [0 Freeze 5 Detach Vrap W viewan []

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status Qu
No data to display.
<

 Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service

screen. The search tab available in the screen enables you to locate an account or customer

using a broad range of search criteria.

To view the Search screen during Lease servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.

ORACLE

Financial Services Lending and Leasing

> DashBoard
» Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
‘Account Documents
Collateral Management
Reports
Producers
Vendars
Batch Transactions
Advances
Payments
Fees
> Collections
> WP
> Tools
> setup

@ Customer Service

m

Search | Customer Service || Review Request (Pending: 0)
Quick Search
Ac# Customer 1d
Queue/ Condition [=]

I Search Criteria

4 Search Results

Vien~ Format~ [Ef [[Freez= Eivetach

¢
Company Branch Account #
usot uso 0123456
uso usHo 1008226531
uso1 usHQ 11111111
uso1 usHQ 12
uso1 usHQ 1236459789
uso1 usHQ 20000100010385
uso1 usHQ 20000100010533
uso1 usHQ 20000100011820
uso1 usHQ 20000100011846

Queue Assignment.

ssh Identification #

autoRun [0 | B Nextaccount | | [5§ Hitered Account

= @
)
Date: Tite Product Status
01/20/2000 Downprtamt Test . LOAN VEHICLE (<R} CHARGED OFF
01j01/2017 BAUER CHRISTIAN  LOAN VEHICLE (FR) ACTIE:DELQ
01/20/2000 Downpmtamt Test ... LOAN VEHICLE {FR) CHARGED OFF
012012017 ORACLEMADHAN  LOAN VEHICLE (FR) ACTIVE
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 ALIVE PRI /DEAS... LOAN VEHICLE (FR) CHARGED OFF
01/20/2000 ALIVE PRI [DEAS... LOAN VEHICLE (FR) CHARGED OFF

@ chse
|
B submt

) 0pen Account
Sizuuency it o S;t:::dmg
o 0.00 0.00 -
217 158288 g0m.00 [
Gl 0.00 0.00
35 0.00 8,226.25
0 0.00 0.00
0 0.00 0.00
a 0.00 0.00
0 0.00 0.00
0 0.00 0.00 -

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating

‘Cannot open secured account’.

3. Click the Search Criteria tab.

ORACLE’

Financial Services Lending and Leasing

> DashBoard
> Origination
Servicing
Serviding
Customer Service
Securiization
Transaction Autherization
Post Date Checks
Escrow Transactions
Account Documents
Collaeral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfoces
AP Transactions
GLTransactions
CASA Recandliation
Conversion Accounts

> Collections
> WFP
> Tools

> setup

Customer Service

Search | Customer Service || Review Request (Pending: 0)

Quick Search

‘Search Criteria

View~ Format~ [Ep Freeze  {fiDetach Wrap
Criteria
ACCOUNT &
ACCOUNT STATUS
PRODUCT
CUSTOMER SSN
CUSTOMER LAST NAVE
CUSTOMER FIRST NAME
CUSTOMER D
BUSINESS NAME
N
YEAR
MAKE
MODEL
ASSETTYPE
PRODUCER #
PRODUCER NAME
ACCOUNT CONDITION
QUELE NAME (UNDEFINED FOR DEFALLT)
QUELEE DESCRIFTION

Comparisan Cperator

i W
LIKE [+]
e =
EQuAL [=]
i W
e =]
EQUAL [+
e [=]
LIKE [=]
EquAL [=]
Lxe [=]
i [=]
e W
LIKE [=]
LE =]
e [=]
i 7]
e =]

[ ese

Search Options: @ Acseunt € Customer () Business

& Reset Criteria. || @8 Search

i

Value

£3]

SLOAN%

=

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and
Value columns.

2. Click Search. System displays all accounts that meet the search criteria in the Results

tab.

3. Onthe Search Results/Task screen, select the account you want to load and click Open

Account.
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2.31

The system loads account on Customer Service screen.

ORACLE'

Financial Services Lending and Leasing

 DashBoard
' Origination
Servicing
Servidng
Customer Service
Seauritization
Transaction Authorization
Post Date Chedks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
Conversion Accounts

» Collections
> Wrp
 Tools

7 Setup

=
Customer Service ] QJ@\!

Search  Customer Service: 20160700010141  Review Request (Pending: 0) ~ Queue Assignment

Account(s): 20160700010141: KLM NAVEEN Elven | o hudi
Vien~ Formatv (B Freeze  ifi Detach ] Wrap B & ©curent® show Al O Group Folow-p
Company Branch Sub Unit Account # Product Days PastDue Currency Pay Off Amt. Amaunt Due St
[ uso1 USRHQ UNDEFINED 0160700010141 LOAN VEHICLE (FR) -24 UsD 27,021.00 0.00 At

i[ 1 '

Summary =~ Customer Service  AccountDetails — Customer Details | Transaction History = PmtModes = Bankruptcy | RepofForedosure | Defidency | Collateral | Bureau | CrossfUp Sel Activi » ™

Alerts Conditions
Alerts Conditions
Hert Conditon Start Dt Followup Dt
No data to display. ON ACTIVE MILITARY DUTY 07[26/2016 07/ (0%
DO NOT CHARGE OFF 07/26/2016 07/26/20%6 -
Account Details Other Information
Dues | | Collateral Information ‘
Desaiption Identification # Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 | 0TOYOTA CARY 0 NEW VEHIE |
T i oIl | i a
DelgDue 0.00 TodaysPayoff 27,02100  AmtPeid Excess 0,00 Y—
LcDue 0.00 FutrePayoff 27,0500 MemoExcess 0.00 Gastomel Tnfgrnatin
NSFDue 0.00 Future Payoff 06/12/2016 Amount Cusmj Name Relation = National |
Date PaidTerm 0 |
Other Dus 0.00 ) 000000... NAVEENKLM PRIMARY Xt 5665 -
Total Due 0.00 Future PmtDt 08/26/2016  RemainingTerm 12 T il
OldestDue Dt 08/26/2016  Days to Tme Bar . | p
N nciamos Tofasmninm 1 i,

Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/

Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform customer service task on the application, click Customer

Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE ) . SSHEKAR y g oo ©
Financial Services Lending and Leasing
@ Customer Service x [ Close
Search  Custome: Service | Review Request (Pending: 0) | Queve Assgnment
> DashBoard Quick Search
> Origination
Servicing Acc# Customer Id SSN Identification # 3 submit
S
Customer Senvice Quete/ Coniton [#] Autorn [ | 3 NextAccount | | (5§ Fitered Account
Securitization
Transaction Authorization » Search Criteria
Post Date Checks T
Escrow Transactions 3
A(Tun( I‘Z)n[umenfs 4 Search Results
Collateral Mz it =
S vien~ Fomat~ || [[[Frezze EiDetach U
Reports 4
Producers ¢ %
Deli Qutstandi
eriors Company Branch Account # Date Tite Product Status de'”q”E”q Amount Due B“‘ S prog
Batch Transactions ays alance
o n— No data to display.
‘ i ] v
Payments
Fees -
> Collections
5 WEP
> Tools
> Setup

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria
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Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

s Clase
> DashBoard Customer Service 5]
 Grigkation Search | Customer Service  Revien Request (Pending: 0) i
Servicing > Quick Search
Servicng
Customer Service Search Criteria
Securitization Search Options: () Account @) Customer ©) Business
Transaction Authorization
Past Date Checks & resetCritera | @@ Search
Escrow Transactions View v Format~ Freeze i Detach Wirap ®
Account Documents Criteria Camparison Operatar Valuz
Colateral Management  cusTomER = s =l
Henis CUSTOMER FIRST NAME Lne [=]
Producers
Ve CUSTOMER LAST NAME LIKE [=]
Baiteh Transactions CUSTOMER S5N EQUAL [l
Advances CUSTOMER NATIONAL ID LIKE [=] =
“
Payments CUSTOMER PASSPORT NUMBER LKE [=]
i CUSTOMER PHONE NUMBER EQUAL [=]
e CUSTOMER ZIP CODE LIKE [=]
AP Transactions =
GL Transactions
Conversion Accounts TR
Search Results
View > Format> P Freeze [ Detach ol wrap o)
Customer 1d National ID First Name Last Name ssn Passport = zp
No data to display.
» Collections
AL vew~ Fomatv B [lFreeze [iDetach e | @
> Tools Company Branch Account # product Currency Pay OFf Amt Amount Due Status Oldest Due Dt Type
b Setup No data to display.
B i 7l |

1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.

ORACLE
Financial Services Lending and Leasing

Customer Service

»» DashBoard

> Origination Search | Customer Service | Review Request (Pending: 0)
Servidng Quick Search

Serviang

Customer Service Ac# Customer Id

Securitization

Conversion Accounts

> Collections
> WP

> Tools

> Setup

=

Transaction Authorization Queue/ Condition [=] autorun [ | [ NextAccount

Post Date Checks

Escrow Transactions » Search Criteria

Account Documents

Collaterl Management

Reports

Producers Search Results

Vendors View ~ Format~ [ Freeze i Detach )

Batch Transactions Customer Id National ID
Advances 31030 45-632-1789
Payments jd
Fees

Interfaces -

S A View v Format+ [ Freeze [fiDetach | o wrap ®
GL Transactions Company Branch Account # Product Currency
uso1 usHQ 20160200015584  LOAN VEHICLE (FR) USD

First Name
SATKRISHNAN

Pay Off Amt
5,037.08

Identification #

Last Name
K

Amount Due
422.78

SsN
0o0e@S56

Status
ACTIVEDELQ

[gose

[ submit

(2] Qpen Account

Passport # Zp
00775

Oldest Due Dt Type

03/01/2016 PRIMARY

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Product

The Lease product of the account.
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2.3.3

In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE
Financial Services Lending and Leasing

Close
e Customer Service [EE
[ Ot Search | Customer Service || Review Request (Pending: 0)
S LY » Quick Search
Serviang
Customer Service Search Criteria
Securtzation Search Options: @ Account (©) Customer () Business
Transaction Autharization
Past Date Checks & Resetiiteria || @8 Search
Escron Transactions Vien ¥ Format~ B Freeze  {f Detach Wrap W L
Account Documents Crteria Comparison Operator Value 1
Collateral Management EEANT R e =
R ACCONT STATUS e = |
Producers
e propucT e = o
EaE—— CUSTOMER SSN EQUAL =
Advances i CUSTOMER LAST NAME LKE =
Payments CLSTONER FIRST NAME e =
= CUSTOMER 1D EQuAL [=]
Interfoces =
S BUSINESS NAME LKE -
L Transactons v 3 =
CASA Recandlton e e =
Conversion Accounts MAKE e =
MODEL LIE [=l
ssser e e =
FRoDUCER = e =
> Collections PRODUCER NAME LIKE [=l
> WEP ACCOUNT CONDITION LIKE ] [=]
> Tools 'QUEUE NAME (UNDEFINED FOR DEFAULT) LIKE [=]
> Setup ‘QUEUE DESCRIPTION LKe [=] s

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the accounts that meet your search
criteria on Results screen.

ORACLE’
Financial Services Lending and Leasing

> DashBoard {Customer Service

> Origination

feaoy Quick Search
Senvidng
Customer Service Acc

Seauritzation
Transaction Authorization
Post Date Checks

Escrow Transactions

Queve/ Condition

» Search Criteria

Account Documents
Colateral Management
Reports
Producers Search Results
Vendors View v Formatv [
Batch Transactions
q Company Branch
Advances
Payments usoL usio
Fees usot usHo
Interfaces usoL usHg
AP Transactions us0L UsHQ
GL Transactions uso1 UsHQ
CASA Reconcliation uso1 usHQ
Conversion Accounts s usHQ
usoL usHQ
usoL UsHQ
usoL UsHQ
usoL usHQ
> Collections usot usHo
> WP ERE UsHQ
usoL UsHQ
> Tools T o
> Setup <

Search Customer Service | Review Request (Pending: 0)

Customer 1d s5N Identification # [ submit
[ Auorn [ [ B NextAccount
(L Gpen Account
Frecze  fiDetach weo @

Account £ Date Title Broduct Status ::‘Y‘Z""E"EV Amount Due :;:f:d‘”g Producer
0151200011060 12/10/2015 NATHNATH LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002: RAND) +
DISIWO0LI0L  12/18/2015 MADELLASURESH  LOAN VEHICLE (FR) ACTIVEDELQ 1 147182 25030.00  CA00002:RANDY
2151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002: RAND"
151200012349 12/17/2015 SOF SDF LOAN VEHICLE (FR) PENDING 0 0.00 0.00 AK-00001 : FELL
DIS1V0012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002 : RANDY
2151200012894 12/24/2015 ASHOKPADMA  LOANVEHICLE (FR) AcTIvE 12 0.00 20,00000  CA-00001:DEMO
DISIVO0L3008  12/30/2015 i3 LOAN VEHICLE (FR) ACTIE -18 0.00 100,000.00  CA-0000S : HARR
0160100013082 01/06/2016 SPARROW MARYY  LOAN VEHICLE (FR) AcTIvE 2 0.00 S0,000.00  CA-00001:DEMO
2160100013216 01/14/2016 IONES ANGELINA  LOAN VEHICLE (FR) AcTvE % 0.00 S0,000.00  CA-00001:DEMO
210100013274 01/18/2016 RANADE SHIWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 500,000.00  CA-00001: DEMO
2160100013414 01/19/2016 DALEALAN LOAN VEHICLE (FR) AcTIvE £ 0.00 200000 CA00002: RAND'
DIE0100013563  01/20/2016 0 LOAN VEHICLE (FR) ACTIVE -0 0.00 1500000 GA-00002: ADVAM
2151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING ] 0.00 0.00 CA-00002: RAND"
DIDI00L4145  01/20/2016 HEGDE SUBHASH /... LOAN VEHICLE (FR) ACTIvE 4 0.00 1500000 GA-00002 : ADVA
160100014206 01/20/2016 HEGDE SUBHASH ... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00

GA-00002 : ADVAM +
i v

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Lease product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.
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The system loads the account under the tab

ORACLE
Financial Services Lending and Leasing

#, Welcome, VAVAIDYZ

234

ustomer Service x lose
> DashBoard Sistomen 56 =
> origination Search  Customer Service: 20151000011054 _ Reviev: Request (Pending: 0)
Servicing
e Account(s): 20151000011054: K NAVIN [l view |[ 2 auit
Customer Senvice Vieww Formatv B3 | ([[|Freeze PliDetach | owrep @ & © Curtent O Showall O GroupFollowup
Securitization Company Branch Sub Unit Account # Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usia UNDEFINED 2015100011054 LOAN VEHICLE (FR) 531462 0.00 ACTIVE 10012016
Post Date Checks
Escrow Transactions
e Summary | Customer Service || Account Details | Custamer Details | Transaction Hstory | Pt Modes | Bankruptcy || RepojForecosure | Deficency | Collteral | Bureau | Cross/up Sell Actites
Collateral Management
Reports Alerts Conditions
Producers
Vendors Alerts Conditions
Batch Transactions Alert Condition Start 0t Followup Dt
A TEST No data to display.
s
Fees
Interfaces
AP Transactions
6L Transactons
Chsh Reconcliation
b Account Details Other Information
Conversion Accounts ‘
Dues Collateral Information
Descrption Hentfication = Year hssetTwe  SubType
om0 0 00 000 om0 o 0 1 2
0 0 1 2
DelgDue 0.00 Totsl ue. 20,00 Future Pt DE 10/01/2016 o 0 i 2
LCDue 0.0 Todays Payoff 4531462 Oldest Due Dt 10/01/2016
NFDue 2000 Future Payoff 45376.30 Amt Paid Excess 0,00 5
Other Due 0.00 Future Payoff Date 02/27/2016 Customer Information
. . Customer . me Relation S5 Birth Dt Gender
Delinquency Information *
0 96 150 (80 [Caeooy [baw 000000... RAVINK; PRIMARY o 008677 0/12/1967
0 0 0 0 0 0 0 a7 000000... RICHARD MURRAY 3R PRIMARY o332 12081985 UNDEFINED
,
nsF(Ufe) 1 Collector DEMOCOLL
wsF(vear) 1 Enmil Privacy Opt Out ¥
Language ENGLISH Active Military Duty N
Activities Marital Status top ¥ Time Zone
> Collections ) chRe a
Acive Dt 12/40/2015 App# 0000001013 Last Pt Amt. 0,00 orrespondence
> WFP Last Activity Dt 02/17/2016 Paid Off Dt Charge Off Dt
> Tools Due Day 1 Effective Dt 10/12/2015 .
Last Pmt Dt Current Pmt 3,981.80 Address Information
> Setup Customer Grade B Last Bll Amt 0.00 Type current PEMISH aiing address Phone. i

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen
On the Oracle Financial Services Lending and Leasing home screen, click Servicing >

Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

ORACLE’
Financial Services Lending and Leasing
68 Customer Service [ Close.
Search | Customer Service | Review Request (Pending: 0) | Queue Assignment =
> DashBoard » Quick Search
> Origination
Serviding Search Criteria
E Search Options: Account () Customer @) Business
ervidng
R & Resetciitera | @@ search
Seauritization
Transaction Autiorizstion ey~ papets | | Mo ffivses we | @
Post Date Checks Criteria Comparison Operator Value
Escrow Transactions BUSINESS # LIKE =
Account Goauments BUSINESS NAME e [+]
Collateral Management — — =
Reperts STaRTDATE GREATRTHANOREQUA.  [=] Y
Producers < =
Wiy PrONE NUVBER cqun =
Batch Transactions I CODE L =
Advances
Payments =
:W“E" (LA Open Accaunt
ees
Interfaces
Search Results
2P Transactions .
S View~ Formatv Freeze ffi Detach rap @
PoRETE Business # Business Name. Tax1d Start Dt Phone Number Zp
No data to display.
> Collections
> WFP View v Format v | Ep Freeze  {oft Detach wrap [o:)
e Company Branch Account # Product Currency Pay OFf Amt. Amount Due Status Oldest Due Dt
00 No data to cispay.
> Setup

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear

the Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the records that meet your search

criteria on ‘Search Results’ section.

ORACLE'
Financial Services Lending and Leasing

=)

@  Customer Service

Search Results

Vew v Formatv | Freeze i Detach ap
> DashBoard 5 i L
- Business # Business Name
> Origination 0000021005 oFsiL
Servicing
Servidng

Customer Service Ve Fomatv [ Fresze i Detach wap | @
R AR X Company Branch Account # Product
Transaction Autherization Uso1 usHQ 20170200029956  LOAN VEHICLE (FR)
Past Date Checks

Escrow Transactions
Account Documents

L Transactions

Conversion Accounts Addresses | Telecoms | Partners || Affiiates | Tracking Attributes

T Address Information
view ™ Formatv [ Freeze Efpetach | o wiep 5}
il Address Type Current Country Address =
7 Tools WORK Y UNITED STATES
> setup 1 I}

Collateral Management e
Reports
Producers i Business Details
Vendors
Batch Transactions
Advances view = Format~ B | [[[Frecce fiDetach weo | @
Payments
el OrganizatonType  Type of usiness  Business Category  Name of the Business
Interfaces ccorp CORPORATE CORPORATE orsiL
1P Transactions ‘ I

[ ose
TaxId Start Dt Phone Number Zp
5523 02/08/2010 (000}-000-0000 01152
Currency Pay Off Amt ‘Amount Due Status Oldest Due Dt
usp 10,000.00 0.00 ACTIVE 03/15/2017
[E vew
LegalName T = sertot ofEmployess(ar) s of
OFsLL X0000t5236 02/08/2010 200
] »
B
state Postal Type StreetPre Street Name Street Type st
MASSACHUSETTS  NORMAL ADDRESS
F

You can view the view the following information for each business record:

In this field: View this:

Business #

The registered business number of the company.

Business Name

The name of the business.

Tax ID The taxation identity number of the business.

Start Dt

The date when the business was initiated.

Phone Number

The contact number of the business.

Zip The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Lease product of the account.

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.

Amount Due

The total amount due on the account.

Status The status of the account.

Oldest Due Dt

The oldest payment due date on the account.
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Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the tab

ORACLE'

Financial Services Lending and Leasing

> DashBoard

> Origination

Servicing

Senvidng

Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers

GL Transactions
CasA Reconciliation

Conversion Accounts.

> Collections
> WP

> Tools

> Setup

Customer Service x [ close
seah| G + 2015100011054 quest (Pending: 0)
Account(s): 20151000011054: K NAVIN Byew | o audgit
View v Formatv B [[]Freeze i Detach wap | @ & © cument O showall O Group Fallov-up
Company Branch Sub Unit nt = Product Days Past Due Currency Pay OFF Amt Amount Due Status Oldest Due Dt
uso1 ushg UNDEFINED 2151000011054 LOAN VEHICLE (FR) 227 UsD 4531362 0.00 A 100172016,
Summany || Customer Senice | Account Details | Customer Details | Transaction History | P Modes | Bankruptcy | Repo/Foreclosure | Deficiency | Collateral | Bureau | Cross/Up Sell Activities
Alerts Conditions
Alerts Conditions
Aert Condition Start Dt Followup Dt
esT o data to display
Account Details Other Information T
Dues Collateral Information
Description Hentification = Year AssetClass AssetTpe  SubType
000 000 000 000 000 0 0 1 i
0 0 x i
Delg Due 0.00 Total Due 2000 Future Pt DE 10/01/2016 0 0 1 i
LCDue 0.0 Todays Payoff 4531462 Oldest Due DE 10/01/2016
NF Due 2000 Future Payoff 45,376.30 At Paid Excess 000 :
& Customer Information
Other Due 0.00 Future Payoff Date 02/27/2016
: . Customer e Relation = Bith Dt Gender
Delinquency Information *
e 30 0 @ 20 0 180 Category Days 000000... KAVIN K PRINARY 010068677 02/12/1987
e £ 5 5 : & = 000000... RICHARD MURRAY JR PRIMARY 00009332 12/08/1585 UNDEFINED
,
BR(Lfe) 0 NSF(Life) 1 Collctor DEMOCOLL
ep(Year) 0 NsF(Year) 1 Email Privacy Opt Out Y
o Language ENGLISH Active Mitary Duty N
Activities Marita Status Stop N Time Zone
Adive Ot 12/10/2015 App # 0000001013 LastPmt Amt. 0.00 Correspondence
Last Actiity Ot 02/17/2016 Paid Off Dt Charge Off Dt
Due Day Effective Dt 10/12/2015 N "
LastPmt Dt Current Pt 3,981.80 jAddress Information
Customer Grade B Last Bil Amt 0.00 e Curent PSS hing address Phone -
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

ORACLE" i ) = Welcome, PRAKRRAO ~ =
Financial Services Lending and Leasing

DashBoard B glose

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. Product End Date Batch Job Sttus
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priorty Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A~ Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority o
> Servicing | prienty Count

> Collections

> WFP

> Tools

> setup

Features

Following are the features of Dashboard:
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3.3

3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing
Lease origination and servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination).The system
updates these details on daily basis.

Using the User Productivity Setup screen, you can review the following daily tallies:

e Number of applications entered, by user

e Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by
user

e Number of funding decisions (verified or funded), by user
e Number of applications entered, by queue

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing Underwriting/Funding tasks

Daily tallies from the

e Collector Activity

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.
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To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:

e Users

e Activity Details

2. In the Users section, you can view the following information.

ORACLE

Financial Services Lending and Leasing

PRAKRRAQ + o

DashBoard
DashBoard
Dashgoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

Users
View~ Formaty [
User
No data to display.

Users Productivity x

Apglication Ertry | Underwiting || Funding | Origination Queues | Collector Activity: | Senvice/Collection Queuss:

Activity Details
Vieww Fomat~ [ Freeze
Queue Name
No data to display.

LeftMessages  Promise To Pay

Neme

No Answer

[ Close

Accounts Call Activities

Other Total

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. Inthe Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field:

View this:

Queue Name

Displays the queue name.

Left Messages

Displays the left message activity count.

Promise To Pay

Displays the promise to pay activity count.

No Answer

Displays the no answer activity count.

Other

Displays the other activity count.
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3.4

3.4.1

Field: View this:

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Parked Transactions

e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
e Batch Job Sets
e Batch Jobs
e Batch Jobs Threads
e Request Details
e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE’

Financial Services Lending and Leasing

DashBoard

Users Productivity

System Monitor

Producer Analysis
Process Files

<

<

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

Batch Jobs

Set Code
SET-AML
SET-ACR

View ~ Format +

System Monitor ¢

Jobs || Services | Database Server Log Files | Parked Transactions | Users

Batch Job Sets
View = Format +

5 Fresze i Detach
Job Set Description  Status
ACOOUNT CREATL.. READY
ACCRUALS AND D... READY

Batch Jobs
Vieww Format~ B b

i Detach
S=q Job Type Job Code
1 PROCEDURE

2 PROCEDURE

Batch Job Threads

Thread Status
1IDLE

i} Detach

Request Details
View w Format +

i Detach

Request Type Status
No data to display.

Request Results
View~ Formate [ Fresce
Requast Result
No data to display.

& petach

AAIPRC_B1_100_01 COMPLETED
TXNACT_B]_100_01 COMPLETED

Wirap @) B Re-submit Job Set

Frequency Frequency Value
DALY, DALY
DALY DAILY

Wrap @) BB Re-submit Job
Status Job Description
APPLICATION TO.
AGOOUNT ACTIVA.

Errors
[}

End Dt

Wrap W

Description

Start Time:
10:00 AM
10:30 PM

Encbled
N
N

Threads.

1

Records
0

Run Start Dt

Commit Count:

PRAKRRAO ~ o
[ Close.
Critical Last Run Dt Next Run Dt
N 08/08/2003 08/03/2003 A
¥ 08/07/2003 08/08/2003 VW
>
Errors Allowed Weskend Holiday
E
100 50 Y Y
>
Trace Level Encblzd
oy
Run End Dt Process Dt
>

A brief description of the fields is given below:

Field:

View this:

Set Code

Displays the code for batch job set.

Job Set Description

Displays the description for batch job set.

Status

Displays the job set status.

Frequency Code

Displays the frequency at which the job set is to be executed.

Frequency Value

Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent

batch jobs.
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e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.

Job Type Displays the batch job request type.

Job Code Displays the batch job request code.

Status Displays the job status.

Job Description Displays the batch job description.

Threads Displays the number of threads used by the job.

Commit Count Displays the number of rows after which auto-commit is
triggered.

Errors Allowed Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job
Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.
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A brief description of the fields is given below:

Field: View this:

Thread Displays the name of thread.

Status Displays the status of thread.

Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.
Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).
Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.
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To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE’

Financial Services Lending and Leasing

System Monitor x

Batch Jobs | Jobs

Job Details

View ~ Format

Request Type

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE
<

Services || Database Server Log Files

Batch  Back Ground || Credit Request

-
Status

COMPLETED.
COMPLETED
COMPLETED
COMPLETED
COMPLETED
COMPLETED

Freeze  pfiDetach

Parked Transactions | Users

§) viewlsst @ 1Day() 1week© 1MonthByDate StartDt EndDt @ view ©) Failed ® All

Valid Execution
Job Set Job Description Thread Errors Records Run Start Date/Tme Run End Date/Time  Process Dt Period Start

DateTime
SET-TRE TXNDDT_B1_100_. TXNDDT_B1_100_ 2 0 2 09/19/2017 11:52: _ 09/18/2017 11:52: . 03/20/2017 08/18/2017 11:52;
SET-TRE TXNDDT_BJ_100_.. TXNDDT_B1_100_ 1 0 & 09/19/2017 11:40: . 09/18/2017 11:41:. 03/20/1017 08/13/2017 11:40
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 0 2 09/19/2017 03:31: . 09/18/2017 08:31: .. 08/20/2017 08/13/2017 09:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 [ 2 09/19/2017 08:31:... 09/18/2017 08:31:... 08/20/2017 08/13/2017 08:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 o 2 09/18/2017 07:31:... 09/18/2017 07:31: .. 08/20/2017 08/13/2017 07:31
SET-QRT QCSPRC_BI_I00_ . QCSPRC_BI_100_ 1 0 2 09/19/3017 06:31: .. 09/18/2017 06:31:... 08/20/2017 08/13/2017 06:31

7

[ Close

Job Detail Description
THNDDT_B_100_0 1. TXNDDT_B1_100_01(6006)

Job Results
View » Formatv [P

Request Result
in Ani St

Freeze i Detach

Description

2. Onthe Job screen, you can select any of the following type of jobs which are available in

separate tabs:

Select: System Displays:
Batch Batch jobs (used primarily for the nightly processes).
Back Ground User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.

1 Month All the types of jobs selected in Jobs Type section in last one-month.

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.
Job Set Displays the job set code.
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3.4.3

Field:

View this:

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.
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2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE’
Financial Services Lending and Leasing

& Welcome, PRAKRRAO o

o Cose
e —— System Monitor 5 [E3fe
DashBaard
Dashgcard

Users Productivity .
System Monitor Services

Producer Analysis View  Format~ Ep Freeze
Process Files Service

BatchJobs  Jobs | Services Database Server Log Files | Parked Transactions | Users

! Detach Wrap @) @ status st Clstop
Description

CREDIT BUREAU SERVICE (EFX TEST FILES)
UREAL SERVICE (EXP TEST FILES)

Company Branch
v AL AL
sV AL ALL CRED)
v AL AL CREDIT BUREAU SERVICE (TUC TEST FILES)
BC AL ALL JOB SCHEDULER
sV AL AL JOB SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE" . . 5w ABSHEKAR ~ 1@ Signout
Financial Services Lending and Leasing
@ Svstem Monitor (3] Close:
Batchlobs Jobs | Services  Database Server Log Files | Parked Transactions | Users 2
DashBoard
DashBoard - Database Server Log Files
DachBoard | “i‘e"'t B 1 O e @ T Mo e B B D2k Erd Dt % @@ Vien © Alert® Debug @ Interfaces
as
Users Productivity = -
View v Format » Freeze i Detach Wrap iSUstFies [ Download File =
System Maritor e & E W == G2
¥t A L File Name File Type File Size File Time
o T xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6574056.log fie 171338 08/28/2017 07:42:07 PM [
JSVPRC_EN_000_01_DB12102_7283859.log file 19897 09/10/2017 10:39:59 AM
g XAEUPD_EM_100_02_FMWW 116_7203940.log fie 26704 09/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log fie 1108 09/08/2017 06:00:34 AM -
> Origination Fle:Conimat
View = Format = Fr i Detach firap @ Begmning D End 2 ofLines 50 Show File
> Servicing = 50} 5]
- Text
& Colerions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WEP 08/31 :32: cmnsyp_cl 00 get_syp paramever value parameter: XAEPRC EM_100_02_DEBUG_LEVEL
> Tools 2: xaeprc_em submit for Bpp No:
: User code: INTERNAL
> Setup = x
2: 1v_statement - SELECT ptc_cur_currency code FROM xae ptc_evw WHERE FTC_COMEANY = :bl 1 |-

2. Inthe Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start D’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.

6. To sortthe view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

3.4.5 Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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To monitor users who have logged on to the system
1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE' e, ABSHEKAR 1 Signout &
Financial Services Lending and Leasing

System Monitor [®Close
BatchJobs Jobs  Services Database Server Log Files | Parked Transactions  Users b2
User Logins
View v Formatv [y Freeze i Detach 0 Wrap Q) View Last @ 1Day © 1Week® 1Month @ By Date  startDt ) End Dt @ View User () Current User @ Al Users
User User Name: Detaiis Login Date and Tine L0002t Date and
Time.
SURABHI SURABHI DESAL 09/20/2017 04:56:... 12/30/4000 12:30:...
SURABHL SURABHI DESAL 09/20/2017 04:44:... 12/30/4000 12:30:...
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30:...
SKSK SAISK 09/20/2017 03 ... 12/30/4000 12:3
» PRITAM PRITAM JENA 09/20/2017 03 ... 12/30/4000 12:30:... =
NAVEEN NAVEEN REDDY 09/20/2017 03 09/20/2017 04:55:
JAYANTA JAYANTAC 09/20/2017 02:37:... 12/30/4000 12:30;
SKSK SAISK 09/20/2017 02:35:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/20/2017 02:08:... 12/30/4000 12:30;
PRITAM PRITAM JENA 09/20/2017 01:45:... 12/30/4000 12:30;
JAYANTA JAYANTA C 09/20/2017 01:45:... 03/20/2017 02:37:
PRITAM PRITAM JENA 09/20/2017 01:27:... 12/30/4000 12:30;
Svsv SHRIVATS SINGH 09/20/2017 01:20:... 12f30/4000 12:30:
NAVEEN NAVEEN REDDY 09/20/2017 01:14:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/20/2017 12:39:... 12f30/4000 12:30:
ABSHEKAR ANAND SHEKAR 09/18/2017 11:45:... 12f30/4000 12:30:
PHACHODA PHANINDRA CHODA 09/18/2017 11:37:... 1230/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:32:... 12f30/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:21:... 05/13/2017 11:32: b

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.

User Name Displays the user name.

Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

3.5 Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE’ . . 5 & Welcome, PRAKRRAO v o
Financial Services Lending and Leasing
Producer Analysis 5
Select Criteria
Users Productivity
System Monitor Company ALL [] Territory - Funder AL & —
Producer Analysis Branch ALL[w] Sales Agent ALL [~] Status - = v
Process Files
TmeEhE Region AL [v] Undenwriter ALL [v] zip v
Producers | Terrtories Activity | Volume || Mix
> Dealer
> o
Recent Activity
MonBE th digiy, Last Funded Approved Funded Comments
No data to display.
Recently Approved Applications
Applicant Name _ Application # Amt Collateral Desc
Mo data to display.
1
Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4
Recent Comments
& Detach Wrap
Date Comment Desc
No data to display.
> Origination
> Servicing
> Collections
> WFP
> Tools
> Setup

[ Close.

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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3.6

Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH
UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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3.6.1

Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system for immediate processing.

ORACLE’

Financial Services Lending and Leasing

SHEKAR v 1 sgnout O

Process Files

Incoming Process File  Outgeing Process File

Incoming Process File

view ~ Format + B
¢en

Select Al [

Freeze  FfiDetach

Directory Name

" uploaded Files
View * Format~  [EF

File Name

SampleR esponseAssets.json
SampleResponseAssets. json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupRespanse\WithLookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithLookupDescPassedAs_CALC json
LookupResponselithLookupDescPassedAs_CALC json
LookupResponseWithl okupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json

Freeze  EfiDetach

2= List Files

@

File Name

[} Jscratchfwork_area/DEV/DE. . callactivity_test XV.tet

B upload

File Type

W) Viewlast © 1Day® 2Days® 5Days@® Al Days

Fie Type

FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD

File Dt

08/14/2017 12:41:17 PM
08/14/2017 12:39:22 PM
08/04/2017 01:07:23 PM
08/04/2017 11:45:18 AM
08/04/2017 01:26:24 AM
08/04/2017 01:20:29 AM
08/03/2017 09:37:30 PM
08/03/2017 09:34:58 PM
08/03/2017 02:23:56 AM
08/03/2017 02: 18:27 AM

[E@ Download Bad Data
Status
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED

File Siz=(bytes)

39 08/12/2016 05:23:01 AM NONE

[ Download Log Data

File Date

[®] Close

)

Status

User
INTERNAL INT %
INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT —

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is stored.

File Name

View the name of the file.

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date

View the date and time when the incoming file was placed in

the directory.

Status

View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click

Select All check box to perform a bulk upload of all the listed files.
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3.6.1.1

3.6.2

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click 2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

Financial Services Lending and Leasing
Process Files 5 [®]Close
Incoming Process Fle  Outgoing Process File 2
Outgoing Process File
View v Format~ Freeze L Detach o] irap @R G Download  View Last @ 1Day (D 2Days (D) 5Days @ Al Days
selectal ] File Name File Type File Date: File Sizz(bytes) Status
] customer_ach OUT PUT DATAFILE 07/10/2017 05:29:20PM 533 GENERATED -
[E customer_ach OUT PUT DATAFILE 07/10/2017 05:29:13 PM 533 GENERATED A
lal customer_ach OUT PUT DATAFILE 07/10/2017 05:29:18 PM 533 GENERATED 1
customer_ach OUT PUT DATAFILE 07/10/2017 05:20:17PM 533 GENERATED
) customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED 1
M customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED
data_change_lien_07102017_172914.dat OUT PUT DATAFILE 07/10/2017 05:29:14PM 0 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 13PM 533 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 12 PM 533 GENERATED
customer_ach OUT PUT DATAFILE 07/10/2017 05:29:11PM 533 GENERATED -
History
View = Format~ [ Freeze ffiDetach gl Wrap 0}
User Download Dt
DILEEF GRANDHI 08/10/2017 06:42:22 PM
DEMO SUPERUSER 07/31/2017 03:28:20 PM. -

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.
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On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click 3 to refresh the grid
data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:
Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4. Sales Lead

The Sales Lead screen enables you to record information gathered during a sales query or a
call from a potential borrower. A sales representative can then use the Sales Lead screen to
follow-up with the borrower. This is not a mandatory screen. You can always begin the lease
origination process directly using the Application Entry screen.

Information on the Sales Lead screen can be attached to the Application Entry screen as
optional information. Attaching a lead to an application can help the sales department analyse
the effectiveness of following-up with prospective borrowers. Once a lead is attached to an
application from the Sales Lead screen, Oracle Financial Services Lending and Leasing
changes its status to COMPLETED.

Lead Entry Screen

The Lead Entry screen enables you to record information regarding prospective borrowers
from a sales query or a call to be used in a follow-up call. The initial status for the lead can be
set as NEW or FOLLOW-UP.

To complete the Lead Entry screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. Onthe Sales Lead screen, click Lead Entry.

ORACLE 8 Welcome, PRAKRRAO ~ [=)
Financial Services Lending and Leasing

Sales Lead (36 Close

DashBoard

Lead Entry | Follow-Up | Maintenance

Applicant Information

12081987
v1pLIISNY
o 07

& Save and Add
Address
“
Lead # UNDEFINED =
s UNITED STATES 2
- NORMAL ADDRESS ~
B
>
=)
[~ j
[~
Telecoms | | Comments || Documents || Requests
— — Telecom Information radd || 7 o | View || o7 Audit
> Servicing View~ Format~ | B rresze  §AY Detach (50

> Collections
> WFP

> Tools
> Setup

3. Onthe Lead Entry screen select the applicant you want to work with, in the Applicant
Information section.

e If you click Previous, Oracle Financial Services Lending and Leasing displays
information for the previous applicant. If you click Next, Oracle Financial Services
Lending and Leasing displays information for the next applicant.

4. In the Applicant Information section, enter, view, or edit the following information:

In this field: | Do this:

Lead # View the sales lead number (display only).

Lead Date View the sales lead date. The default value is the current
date (display only).
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In this field: | Do this:

Company Select the company name (required).

Branch Select the branch name (required).

First Name Enter the applicant’s first name (required).
Last Name Enter the applicant’s last name (required).
Birth Dt Select the birth date from the calendar.
Channel Select the channel of the sales lead (required).
Source Select the source of the sales lead (required).

5. Inthe Address section, enter, view, or edit the following information:

— If you are creating a new record, click Add.

In this field: Do this:

Type Select the address type (required).

Country Select the country code (required).

Address # Enter the address number

City Enter the city (required).

State Select the state (required).

Postal Type Select the postal address type (required).
Street Pre Select the street prefix (directional) (optional).

Street Name

Enter the street name (optional).

Street Type

Select the street type (optional).

Street Post

Select the street postfix (directional) (optional).

Apt #

Enter the apartment number (optional).

Address Line 1

Enter the first address line (optional).

Address Line 2

Enter the second address line (optional).

Zip Select the zip code (required).
Note: For non US country, you have to enter zip code.
Email Enter the e-mail address (optional).

Alternate Email

Enter the mobile e-mail address (optional).

Assigned By View the user code creating the sale lead (display only).
Status Select the status for the sale lead (required).
Status Dt View the last sales lead status change date (display only).
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In this field: Do this:

Follow-up Dt Enter the sales lead follow-up date (required).

— If you entered a new record in the Address section, click Save.

411 Telecoms sub tab

The Telecoms sub tab records additional phone numbers for the sales lead.
To complete the Telecoms sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

ORACLE"
Financial Services Lending and Leasing

2. On the Sales Lead screen, click the Lead Entry tab, then click the Telecoms sub tab.

Clos=
DashBoard Sales Lead % £l

ongmaton Lead Entry || rollow-up || Mamntenance

Applicant Information = add
View v Format~ B ez [ Detach 1 wrap 5
Lesd = Company Branch First Name
UNDEFINED
L-00002006
Looao160z
Looo0s002

NLO2 NLHQ ROSEMARY ~
uso1 usHQ TesT

uso1 usHQ BOND
L-00002002 uso1 usri PHANINDRA
L-00002004 uso1 ustQ BOREN
L-00005002 uso1 usHQ NITIN
109004004 12/15/2015 uso1 usHo ANDRES MARTINEZ

CONSULTATION  OFFLINE APPLIC\
CONSULTATION  WEB ENTRY.
>

Applicant Information
& Save and Add

licant Information Address

UNDEFINED S — =
03/04/2018
= Country UNITED STATES ]
1= NORMAL ADURESS 52
227}
=1
2}
< -~ Status Dt 02/04/2016
= =] = Followup Dt =2
Tetewoms | Commeits || Duments || Rt
= Telecom Information =k add || Edit = view || <7 Audit
LR Ve Fanete |6 Freeze i Detach vrop (=)

> Collections
> wEP

> Tools
> Setup

3. On the Telecoms sub tab, enter, view or edit the following information:
— If you are creating a new record, click Add.

In this field: | Do this:

Telecoms section

Telecom Select the type of telecommunications device
Type (required)

Phone Enter the phone number (required)

Current Select the Current check box to indicate the phone

number is in service.

— If you entered a new record in the Telecoms section, click Save.

41.2 Comments sub tab

The Comments sub tab records any comments regarding the sales lead.

To complete the Comments sub screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.
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2. On the Sales Lead screen, click the Lead Entry tab, then click the Comments sub tab.

ORACLE

Financial Services Lending and Leasing

P —— o

DashBoard

Origination

> Servicing
> cCollections
> wEp

> Tools

> Setup

Sales Lead

Lead Entry | Follow-Up | Maintenancs

Applicant Information
View v Fomat v

rresze Effoetscn | ol wen | @
s

tead or

L-00002008 12/15/2015 NLO2 NLHQ ROSEMARY
L-00001002 usoL usrg TesT
L-00003002 uso1 usHg ND
L-00002002 uso1 usHg PHANINDRA
L-00002004 uso1 usHg soREN
L-00006002 uso1 usrg NITIN
L-ouusuus s usrg AnDRES
L-0goosa02 uso1 UsHo v

<
Telecoms  Comment s || Documents || Requests
Comments
“
View ~ Format~  [Ep Freeze  Efi Detach ap o
Comment Type Sub Type Comment
[ [~]]
TesT
CUSTOMER WALK-IN meouND
L-00002006
CUSTOMER WALK-IN INBOUND

11/11/1991

Ikl save and Stay | kel Save and Retumn || G Retum

Comment Dt Comment By

02/04/2016 02:41:38 AM PRAKRRAO

12/21/2015 03:19:03 AM

LMANGALA

12/14/2015 09:45:52 PM PHACHODA

3. On the Comments sub tab, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field: | Do this:

Comments section

Comment Select the comment type (required).

Type

Sub Type Select the comment sub type (required).

Comment Enter the comment (required).

Comment View the date the comment was entered and saved (dis-
Dt play only).

Comment View the user id of the person who entered and saved
By the comment (display only).

e If you entered a new record in the Comments sub tab, click Save.

413

Documents sub tab

The Documents sub tab needs to be completed if:

e The customer had requested any documents

e Any document has been sent to the customer during sales lead entry.

To complete the Documents sub screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.
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2. On the Sales Lead screen, click the Lead Entry tab, then click the Documents sub tab.

ORACLE

Financial Services Lending and Leasing

DashBoard

Origination

> Sarvicing
> Collections
> wre
> Tools

> setup

Sales Lead »

Lead Entry | FollowUp Maintenance

Applicant Information

Vieww Format~ B Freeze

Company
L-00002006 12/15/2015 NLOZ
L-ono01002 12/02/2015 uso1
L-00003002 /2015 uso1
L-ooooz002 uso1
L-00002004 uso1
Lonoosooz usos
L-onoo4004 uso1
L-0ooos002 uso1

<

Telacams || Comments || nocument v | [ Reuess

Documents

View v Fomot~ | B Fraza i Detach

Documen t Type Sub Type
BROCHURE SOFT copY
BROCHURE <oFT copy

Documents

=
=

Enter the doct

(3 close

dhadd || Aedt || [ view || o2 audi

ol
ROBERT 12/01/1970

08K
MARTINEZ 08/08/1983
sam

B ssveand add || [ Ssveand sty | [ Sve and Retum | <3 Retum

Dt 02/04/2016
By PRAXRRAC
nts

3. Onthe Documents sub tab, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field: | Do this:

Documents section

Document Select the document type (required).

Type

Sub Type Select the document sub type (required).

Documents | Enter the document (required).

Document View the date the document was entered and saved (display
Dt only).

Document View the user id of the person who entered and saved the
By document (display only).

— If you entered a new record in the Documents section, click Save.

Requests sub tab

The Requests sub tab records the product the customer is interested in and the requested
amount for each product.

To complete the Requests sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales

Lead master tab.
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2. On the Sales Lead screen, click the Lead Entry tab, then click the Requests sub tab.

ORACLE"
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Sates Load [38] Close.

Lead Eutry | Follow-Up | Maintenarics

Applicant Information
=4

View + Format + Frecze EfiDetsch | ol wep | @R
Lend # Lesd 0t Commpany Branch First Name Last Narme birth Dt Channel =
L-00002006 12/15/2015 NLO2 NLHQ ROSEMARY BLACK 12/08/1987 CONSULTATION ‘WEB ENTRY
L-oo001002 12/02/2015 = UsHo Test TESTLAST NAME  02/01/1350 ESTATEAGENT  FAXIN
L-0000s002 12/17/2015 uso1 usHo BoND. 2aMES o1/01/1957 wes WEB ENTRY
L 00002002 12/12/2015 uso1 usHo PHANINDRA CriopA 10/10/1982 CONSULTATION  WEB ENTRY
L-00002004 12/12/2015 uso1 usHo BOREN ROBERT 12/01/1970 wes WeB ENTRY
L 000000z 02/02/2016 uso1 usro TN J08H1 07/25/1988 CONSULTATION  OFFLINE APPLICA
L 00004004 12/19/2015 usor uso AnoRes MaRTINEZ osjoe/ 1080 ConsULTATION  WeEB ENTRY
L-0000s002 12232015 uso1 usHo sam sam 11/11/1081 oTHERs WEB ENTRY
<
Telecoms | Commen = Documents | Requests
Request Details & Add & Edit =| View 2 Audit
View~ Format~ B Frecze B Detsch e | @
4 Product Requested Amt
.00
LEASE VEHICLE 47,900.00

Request Details
[ Ssve and add || [ Ssve and stay | [ Ssve and Retum | <3 Retum

= Procuct ~l

~Requested Amt 0.00

> Servicing
> Collections
> wrp

> Tools
> Setup

3. Onthe Requests sub tab, enter, view or edit the following information:
— If you are creating a new record, click Add.

In this field: Do this:

Requests section

Product Enter the requested product as loan (required).

Requested Amount Enter the requested amount (required).

e If you entered a new record in the Requests sub tab, click Save.

4.2 Follow-Up screen

The Follow-Up screen enables you to update customer information based on sales lead
follow-ups with the customer.

To use the Follow-Up screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. On the Sales Lead screen, click the Follow-Up tab.

SieAaci e
Flhancia T Services Lending and Leasing

3. In the Status section, click:
— New to view all leads on the Follow-Up screen with the status of NEW.
-or-
— Follow Up to view all leads on the Follow-Up screen with the status of FOLLOW UP.
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— All to view all leads on the Follow-Up screen.

4. Inthe Assigned section, click:
— Assigned By to view all leads on the Follow-Up screen assigned to the current user.
-or-
— All to view all leads on the Follow-Up screen assigned to any user.
5. On the Follow-Up screen, enter, view, or edit the following information:
In this field: | Do this:
Company View the company name of the sales lead (display only).
Branch View the branch name of the sales lead (display only).
Followup Dt | Select the follow-up date of the sales lead (required).
Lead # View the sales lead number (display only).
Lead Dt View the creation date of the sales lead (display only).
Name View the applicant’s name (display only).
Last Name View the applicant’s last name (display only).
First Name View the applicant’s first name (display only).
Assigned View the user assigned to the sales lead (display only).
by
Status Select the status of the sales lead (required).
Status Dt View the last sales lead status change date (display only).

6. Click Save on the Follow-Up screen.

Maintenance screen

The Maintenance screen enables you to attach a sales lead to a different or missed

application or change status of lead to NEW.

To attach a sales lead to an application

1.

On the Oracle Financial Services Lending and Leasing home screen, click the Sales

Lead master tab.
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2. On the Sales Lead screen, click the Maintenance tab.

> sctup

3. Inthe Lead Details section, view the following display only information:

In this field: | Do this:
Lead # View the sales lead number.
Last Name View the last name of the sales lead.
First Name View the first name of the sales lead.
Status View the status of the sales lead.
Company View the company of the sales lead.
Branch View the branch of the sales lead.
Days of Inac- | View the number of days of inactivity regarding the sales
tivity lead.
4. Inthe Lead Details section, select the sales lead you want to attach to the application.
5. Inthe Action section, click Attach to an Application.
6. Inthe Action section, select the application number to which you want to attach the sales
lead in the unlabeled App # field.
7. Inthe Action section, click Post.
8. Inthe Application section, view the following display only information:
In this field: | View this:
Priority The priority of the sales lead.
Application# | The application number of the sales lead.
Date The date of the application.
Title The title of the application.
Product The product of the application.
Status The status of the application.
Producer The producer of the application.
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If the wrong sales lead was attached to an application, detach it from the existing application
by clicking Change to New Status in the Action section, then attach it to the correct
application clicking Attach to an Application, completing the App # field, and clicking Post.
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5.2

5. Simple Application Entry

Introduction

The first step in the Lease origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Simple Application Entry screen
enables you to specify information from the credit application into the system and request a
credit bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in the Applications
section. The product defines the type of credit application: Lease as well as any collateral,
such as vehicles or homes, associated with the Lease. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Lease such as Lease amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by the credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

To enter a new application

1. Click Origination > Origination > Simple Application Entry.
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2. The Simple Application Entry screen appears, opened at the Search link’s Results

screen.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Appiication Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools
 Setup

Origination x

Bearch/Task | Simple Application Entry || Review Requests (Pending: 0)

Quick Search
App = ssN Identification #
Queue [l Next Application

» Search Criteria

o New Application
Search Results/Task
View» Formatw [ Freeze 5 Detach P W vewarl [
Critical Locked Allowed Company Branch App # Date Title Product

No data to display.
<

() Op=n Application

Status

(36 Close
Submit
[El View Application Unlock Application
Sub status u
>

The Recreate Instance button appears only when the BPEL parameter is YES.

3.

ORACLE’

Financial Services Lending and Leasing

In the Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Simple Application Entry tab.

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

Servicing
Collections
WFP

Tools
Setup

Origination 3

SearchfTask  Simple Application Entry: 0000001537 | Review Requests (Pending: 0)

Application: 0000001537: RODRIGUEZ ROBINSON

Vieww Fomatv P Freeze i Detach J Wrap @) ovemdeok v Waming OK v
[ App # Sub Unit Status ORONSIE I producer Name(FIPCET otk
I 03/05/2015 0000001537 APPROVED - FUN... FUNDED €A00003 : ACEH... (818).761-2277
<
Application
App # 0000001537 Billing Cyde MONTHLY
Dt 09/05/2015 Purposs VEHICLE LOAN OR LEASE
Product LEASE VEHICLE Producer DEALER
Channel WEB ENTRY Producer Name  CA-00003 : ACE HEADQUARTERS INC{ ACTIVE }
PrEsiy. NORMRL Producer (818)-761-2277
Company US01 Contact
" Branch USHQ Number
Sub Unit P11 Region ALL
Status APPROVED - FUNDED Temitory ALL
Origination Stage Code FUNDED Existing_
Custome!
Duplicate
Application
Loan Currency USD
Applicant || Business | Request | Collatersl | Comments | Tracking | Verification
Applicant
Applicant
View v Formatw (5 Freeze i Detach | Wrap (5]
Relation Type First Name M1 Last Name Suffix 5N Birth Dt
10 PRIMARY ROBINSON DOUGLAS RODRIGUEZ ®» 00000346 01/03/1365
<
Address || Employments | Telecoms

[38) Close:
A
D] o ms
Existing Customer  Duplicate Contact
Agplication
N N
>
A Retum
Class SMALL BUSINESS
Sales Agent DEMOSUPR
Joint
‘4
Warning OK ¥
Sl view || o audit
License # License State u
COLORADO ]
>
v

For field description refer Applications of the Underwriting chapter:
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5.3

Copying Lead details

After selecting the sales lead number in the Lead # field and on clicking Copy Lead Details,
the applicant details which were captured in the Sales Lead screen are populated in the
Simple Application Entry screen. The Copy Lead Details button will be enabled only when you
select the lead number in the Lead # field.

Pre-qualifying an Application

After entering the basic details of the applicant like identification and demographic details
along with the address, employment, assets, liabilities and other income information and
requested details, the user has to check whether the application pre-qualifies or not by
clicking Pre-qualify Application button. This is governed by a set of Pre-qualification edits.

If pre-qualified edits are satisfied, the status is changed to NEW-PREQUALIFY APPROVED
and user can modify or update any further details in the Application Entry screen.

If the edits are not satisfied, application will be pushed to REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY REJECTED. You can also view rejected
pre-qualification in the Underwriting screen.

When specific services listed in Dashboard -> System Monitor -> Services tab are 'stopped’,
the application status will display 'NEW PRE-SCREEN APPROVED' and user will not be able
to change the status manually to move it to Underwriting queue. In such cases, services
should be started post which the application is processed automatically by the system and
falls in the appropriate queue as per work flow.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes

e Summary

e Credit Scores

e Duplicate Applicant

e Existing Accounts.
The system uses information on Financial and Liabilities sub tabs to determine the applicant’s
net worth. The system uses information on Employments tab and Other Incomes sub tab to
calculate applicant’s debt-to-income ratio.

Note the following while completing frequency fields:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information, refer appendix Payment Amount Conversion.

53 ORACLE



5.4

To complete the Applicants Details screen

1.

(o)

On the Simple Application Entry tab, click Applicant > Applicant.

RACLE"

3 - i i i SHEKAR + 1 Signout ‘&
Financial Services Lending and Leasing

> Originati Close
> DashBoard rigination 3]
Origination
Applicant Elvew || < Audit
Origination _ o7 e "
T vew+ Fomatv | B [[l|Freeze EifiDetach we | @
Simple Appiication Entry Relation Type First Name MI LastName Suffix ssN Birth Dt License # License State Language
Application Entry 2
No data to display.
Underwiting TRt -
Funding
Application Retrieval i
Scenario Analysis Applicant
Appication Documents CaRetun
Image Maintenance
n Ty Prior Applica oy
Reports Relation Type rior Applicant __ Bankruptcy Discharge Dt
Producers Salutation Existing Customer __
Vendors First Name Existing Customer ID KYC
Mt Existing Customer #
Last Name Reference #
h Famiy Name Other Details Status “
Suffix =
Birth Dt Name in Local Language FATCA
Gender
SSN
e Mother's Maiden Name Birth Place
e Edication Birth Country
L Permanent US Resident Status __
Time Zone g
Dependents
Power of Atterney
Identity Information Marital Status
EnoR Power of Attorney __
Natonaity i Holder Name:
National ID Ethnicity
> Servicing " 3 Address
Passport # Disability __ Country
P ST Passpart Issue Dt Privacy Opt Out _ bl
> WFP Passport Expiry Dt Insurnce Optiout. Telephone Number
> Tools Visa # Marketing Opt Qut _
License # Share Credit Opt Qut __
Eadsu License State Prior Bankruptcy __ =

2.

B

About.

For details on this screen refer Applicant Tab of the Underwriting chapter.

usiness Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving Lease
application during underwriting. The Business Applicant screen is available for Lease and
contains the following sub screens:

To
1.

Address
Telecoms
Financials
Liabilities
Partners
Affiliates
Other details

complete the Business tab

If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on Application Entry screen.
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2. On the Application Entry

screen, click Business.

ORACLE
Financial Services Lending and Leasing

i Close
g Origination 5 [E3fe
Origination Search/Task ~ Simple Application Entry: 0000001537 = Revisw Requests (Pending: 0) -
Qrigination
Sl Application: 0000001537: RODRIGUEZ ROBINSON Elview ||« sudit
Simple Application Entry "
Penlication By View~ Formaty P Fraeze it Detach 1 wrap @) overideox v waming OK v
Underwriting Origination Stage Producer Contact el Duplicate
Pt Dt App = Sub Unit Status Code Producer Name Nu Buisting Customer Appiication Contact
Application Retrieval | 08/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
feparta Applicant || Business || Request | Collateral || Comments || Tracking || Verification
Producers.
Vendors Business  Business Search
Business Details o Audic
View~ Fomat~ [ Freeze i Detach W
Organiznbon Typs: {BusrcssTyps! | Busiess Catogoey Business Name Lagal Name Tax D # Start Dt Fof Em”“?;f; # of Employeas
" CCORP. SERVICE SETME INTERSHELL INTE.. INTERSHELL INTE. 0000987 01/01/1968 12 32
4 < >
“
Business Details
&a Retum
Organization Type C CORP £ of Employess({Cur) 12 Loan Cumrency Avg Checking 87790
Business Typs SERVICE # of Employess 32 Balonce
Business Category SETME SHARP # of Locations 34
Business Name  INTERSHELL INTERNATIONAL am Managemert Since 1580
corp 735334066 Existing Business.
Legs| Name INTERSHELL S DOLLAR. Existing Business Name UNDEFINED
INTERNATIONAL 2 o
&l - Existing Business # 0000000000
e ey Aug Chacking Balance 87,750.00
Start Dt 01/01/1968
Address = Telecoms = Finandals Liabilities = Partners  Affiliates  Other Details
> Servicing Address Information View || o Audit
> Collections View ~ Format+  [Ep Freeze i Detach | wrap W
> WFP Address Type Country Address # Gty State OwnjlLease Comment Fostal Type Street Pre
BUSINESS UNITED STATES 100 CORPORATE CANTON MASSACHUSETTS ~ RENT NORMAL ADDRESS  NORTH
> Tools < >
v
> Setup

For details on this screen, refer Business Tab of Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested tab

To complete Request tab:
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1. On the Application Entry tab, click Request tab.

Financial Services Lending and Leasing
iginati Close
T Origination x =
Origination Search/Task  Simple Application Entry: 0000001536 Review Reguests (Pending: 0)
Origination
Sy Application: 0000001536: RODRIGUEZ MILDRED view || o audit
Simple Application Entry - = =
‘Application Entry View v Formatw [ Freeze o Detach Virap @) OverideOK v  Waming OK v
Underwriting Qriginaticn Stage Producer Contact 3 Duglicate:
sl ot App# Sub Unit Status b Producer Name  {150UCE Existing Customer LBV Contact
Application Retrisval 09/05/2015 0000001536 APPROVED - FUN..  FUNDED CAD0003 : ACEH.. (818)-761-2277 ¥ ¥
Scenario Analysis >
Application Documents
Image Maintenance
Reports Applicant  Business  Request Collstersl Comments Tracking | Verification
Producers
Vendors PR
Requested i vew || o audt
View Format [ Freeze [ Detach Wrap ]
Credit Limit Advance Promotion
16,900.00 18,500.00 NONE
Requested
Kl <A Retum
“
Credit Limit 18,900.00 Advance 18,900.00 Promotion UNDEFINED
Itemization  Trade-In | Subvention
Itemization B view || 2 audit
Vieww Fomatv [Ep Freaze B4 Detach ol wrap ;]
Ttemization +- Requested Amt Comment
TTM OTHER FEE + 0.00
ITM AMOUNT PAID ON MY LOAN ACC... + 18,900.00
ITM AMOUNT PAID TO OTHERS ON M. + 0.00
ITM AMOUNT GIVEN TO ME DIRECTLY  + 0.00
Total Requestad 18,500.00
> Servicing
> collections
> WFP
> Tools
> Setup

For details on this screen refer Request Tab of the Underwriting chapter:

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screens: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
screens share. If you are entering an unsecured Lease, the Collateral tab is present but

inactive; in which case, skip this step.
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To enter vehicle information from the Collateral tab

1.

ORACLE"

Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral.

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Tmage Maintenance
Reports
Producers
‘Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination 5 [ Close
Search/Task | Simple Application Entry: 0000001536 = Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED fiew | o Audit
View w Format— [ Fre & Detach p W Override 0K v Waming OK ¥
Origination Stage Producer Contact 3 Duplicate
[ App % Sub Unit Status b Producer Name 1 o0U°e Existing Customer RS Contact
] 0sfos/2015 0000001536 APPROVED - FUN... FUNDED CADOG03 : ACEH... (B18)761-2277 ¥ B
< >
Applicant | Business || Request | Collateral || Comments | Tracking || Verification
Collateral
Home [Evew | o aui
Vieww Format [ Freeze E Detach ®
DY Eristing Assetld  Primary  Asset Class Asset Type Sub Type Occupancy Identification #  Country. Address =
N (> NEWVEHICE  HOME SINGLE FAMILY H.. (OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSET 5T
< >
“«
Valuation  Tracking
Vvaluation o Audt
View v Formatw B Freere Effi Detach &l o]
Loan Currency Usage Value Amt .
Qument | 0N CUTeNY Retall Base Amt () Valuation ot Source Currency Eition Supplement Whlesa
|2 19,000.00 15,500.00 0.00 0/05/2015 INVOICE US DOLLAR
< >
Addons View || of Audit
View v Formatv B Freeze &4 Detach (20}
Description value Amount Loan Currency Amount
ANTI THEFT 250.00 230.00

To enter home information from the Collateral tab

1.

ORACLE'

Financial Services Lending and Leasing

On the Application Entry tab, click Collateral sub tab.

DashBoard
Origination
Origination
Sales Lead
Simpie Application Entry
Application Entry
Underwriting
Funding
Apglication Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEFP

> Tools

> Setup.

Origination x (3] Close
Search/Task ~ Simple Application Entry: 0000001536 ~ Review Requests [Pending: 0) -
Application: 0000001536: RODRIGUEZ MILDRED Bl view || < Audit
View v Formatv [ Hipetach Wirap 8 ovemideok v Waming OK v
Dt AppE Sub Unit Status g:g;“am" S8 producer Name :ﬁb“‘;’ Contact  picting Customer E:;!I::;fm Contact
f | 08/05/2015 0000001536 APPROVED - FUN. FUNDED CA-D0003 : ACE H. (818)-761-2277 o -
>
Applicant | Business | Request| Collateral | Comments  Tracking || Verification
Collateral
Home [El view ||« Aud
View v Fomat~ [ Freeze g Detach i)
Xen0  Bastingassetld  Prmary  Asset Class asset Type Sub Type Oceupancy Identification £ Country Address & A
i~ ¥ NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 'UNITED STATES ‘480 NEPONSET S1
4 <
4
Home
{3 Retum
Buisting_ State MASSACHUSETTS Legal Deseription
Asset County NORFOLK Lot 23
Doy Sub Division
-ﬁ;mt u . Type & Description st
il Census Tract / BNA Code Niebes-Boninds.
t NEW HOME -
Aﬂﬁ‘ass o MSA Code Flood Zone
ReETipe GEO Code 1098 Not Required ¥
] quire
Sub Type SINGLE FAMILY HOME Condition GOOD CONDITIGNED
Occupancy OCCUPIED BY OWNER AS PRINCIPAL RESIDENCE Description 3015 INVERNIZZT e
Identification E26A119602 CONSTRUCTION CO VILLA
: Year 2015 Construction Permit Dt 01/30/2016
ey Age O Desd Dt 01/30/2016
g Make INVERNIZZI CONSTRUCTION D« F
Country UNITED STATES ueaidﬂatafﬂ Issue AMESBURY
P rties Bou om East
Address # 480 NEPONSET 5T R o roper undary from =
Address Line width 1200 N: i
west
] Length 3400 i
Address 15 RNy e -
o PO # 122 RABEIT
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If collateral is any other, the Collateral link displays information about that collateral.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Froducers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x (3 oze
Search/Task  Underwriting: 0000001533 | Review Requesis (Pending: 0) ~
Application: 0000001533: SIGG MARK A Edt || Elvew || & audt
View » Formatw  [E Freeze i Detach A Wrap B Overide 0K v Waming OK v
Origination Stage Producer Contact 2 Duplicate
Dt App = Sub Unit Status Code Producer Name Nur Existing Customer Application Contact
| 09/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACEH.. (818)-761-2277 N N
>
Summary | Applicant || Business || Request || Dedsion | Bureau | Collateral | Comments | Tracking | Document | Verfication | Comespondence = Teols
Collateral | Seller
Other Collateral E view | < Audit
View = Fomatv Freeze fiDetach | ol Wrap B Existing Asset 1d d
zsh;”g Existing AssetTd Primary  Asset Class Asset Type Sub Typs Status Year Age Make Model
In B ]
N oy NEW VEHICLE VEHICLE CAR NOT DEFINED 2015 0 AUDI A4
< > 5
Other Collateral
A ssveandadd | Bl Saveand Stay || [ Save and Retun || 3 Retum
Existing Asset Body z =
Existing Asset Id = Registration # UNDEFINED Zip Extn
* primary & P
Identification #
* Asset Class NEW ASSET [v] Gity
Description T
F—— State [v]
Aezel Tye [HOUEEHOLD HO00S ¥ Condition GOOD CONDITIONED [~ M ~
g v
= Sub Type | GENERAL HOUSEHOLD GOODS / EC[v | =
* Status |NOT DEFINED V] Address Usage Details
= Country UNITED STATES [v] %
Select Make and Model - " Start |0
Address # %
=Year 0 g u Basz 0
ddress Line 1 -
Age i =B 0
Make Bitelnet *Total 0
Model * Charge Amt 0.0
Valuation ~ Tracking v

For details on this screen, refer Collateral Tab of the Underwriting chapter.

Comments Tab

When using the Simple Application Entry screen, you can add comments to an application at
any time in the application entry process by clicking Comments tab.
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To complete the Comments tab

1. On the Application Entry tab, click comments.

ORACLE
Financial Services Lending and Leasing
DashBoard Oralntion x
Origination Search/Tesk  Simple Application Entry | Review Requests (Pending: 0)
Originaticn
s L i
el Application
Simple Application Entry - =
‘Application Entry View v Format~ Freeze G Detach ] Wrap @ Override 0K __ Warning OK __
undernriting Origination Stage Producer Contact
iy ot App % Sub Uit Status ik Producer Name ([ oCL<
2 to display.
Application Retrieval ke d(” o ol
Scenario Analysis
Application Documents.
Image Maintenance
Reports Applicant | Request = Comments —Tracking | Verification
Froducers
Vendors
Comments
View v Formstv B Freeze i Detach J wrap 6]
Aot Type Sub Type Comment
U REGULAR [v] | Loan oRIGINATION [v]
o
> Servicing
> Collections
> WFP
> Tools
> Setup

Bxisting Customer  Duplicate Contact

| Bl seve and stay || Bl save and Retum || Gagetum

dpadd | Aedi || 5 view || o audie

Application
>

Comment By Comment Dt

PRAKRRAQ' 102/04/2016 05:54:58 AM

For details on this screen, refer Comments Tab of the Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.

What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click the Tracking tab.

ORACLE & Welome, VAVAIDYA ~ o
Financial Services Lending and Leasing

R Origination x (3 Qlose

Origination Search/Tack ~ Simple Application Entry  Review Requests (Pending: 0)
Origination
Sales Lead Application e add | Edit View || < Audit

Simplz Agplication Entry
Application Entry View - Format~ [ Freeze {f! Detach Virap B Overide OK__ Wamning OK _

E:::r,:;mq ot App % Sub Unit Status O mkionsstage
Agplication Retrieval rT—

Scenario Analysis < >
Application Documents

Image Maintenance

Reports

Producers Apglicant || Request || Comments Tracking | Verification

Vendors

Duplicate
Producer Name CorExistng Customer i pion Contac

Tracking Attributes | Field Investigation

Tracking Attributes A Edit || of audit
View + Format= (B Freeze i Detach ol Wrap 7] o Load Tracking

Sub-Parameter Parameter Value
No data to display.

> Servicing
> Collections
> WFP
> Tools

©» Setup

For details on this screen, refer Tracking Tab of the Underwriting chapter

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

Ifitis an Error, the system will not allow you to change application’s status and approve Lease
until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed,;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

To validate a credit application

1. Enter all the information associated with the application on the Application Entry screen.
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2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing

& welcome, vavaova - [ElSETGIGN O

V Close
DashBoard Origination —

Origination Search/Task  Simple Application Entry Review Requests (Pending: 0)
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No data to display.
< >
Applicant | Request | Comments | Tracking Verification
Edits
Edit Types
View~ Format~ [ Freeze i Detach Wrap [o:] Edit Type [V] 48 check Edits
Date Edit Typ:
No data to display.
Edit Details
View w Formatw |58 Freeze [ Detach Wrap 50

Edit Name Result
No data to display.

Expected Value  Actual Value  Override Responsibility

> Servicing
> Collections
> WEP

> Tools

> Setup

For details on this screen, refer Verification Tab of the Underwriting chapter.

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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5.10 Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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6.1

6.2

6. Application Entry

Introduction

The first step in the Lease origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Application Entry screen enables

you to specify information from credit application into the system and request a credit bureau
report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in Applications
section. The product defines the type of credit application: Lease as well as any collateral,
such as vehicles or homes, associated with the Lease. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Lease such as Lease amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen. Pre-
qualification edits can be viewed from the 'Verification' sub tab.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

To enter a new application

1. Click Origination > Origination > Application Entry.
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2. The Application Entry screen appears, opened at the Search link’s Results screen.
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The Recreate Instance button appears only when the BPEL parameter is YES.

3.

Applications Entry screen opens at the Application Entry tab.

ORACLE’
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For details on this screen refer Applications section in Underwriting chapter.
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Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes sub screens
e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts
e Tracking Attributes

The system uses the information on the Financial and Liabilities sub tabs in determining the
applicant’s net worth. The system uses information on the Employments screen and Other
Incomes sub screen to calculate the applicant’s debt-to-income ratio.

To complete the Applicants Details screen

1. On the Application Entry tab, click Applicant > Applicant.
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For details on this screen refer Applicant Tab section in Underwriting chapter.

Business Applicants Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving the Lease
application during underwriting. The Business Applicant screen is available for Lease and

contains the following sub screens:

e Address
e Telecoms

6-3 ORACLE



6.5

e Financials

e Liabilities

e Partners

e Affiliates

e Other details

To complete the Business Applicant screen

1. If SME business information is included on the application, select SMALL BUSINESS

inClass field on Applications section and click Save.
The Business tab appears on the Application Entry screen.

2. On the Application Entry screen, click Business.
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For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested link

To complete the request tab:
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1. On the Application Entry tab, click Request tab.
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For details on this screen refer Request Tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays credit report (if pulled) for an applicant. If there is a need for another
pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab

1. Open the Application Entry screen and load the application you want to work with.
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2. Click Bureau

ORACLE’
Financial Services Lending and Leasing

e Close
T Origination x ]
Origination Search/Task | Application Entry | Review Requests (Pending: 0) -
Origination *
Sales Lead
Simple Appication Entry
Application Entry Applicalion padd | PEdt | [Fven | of Audt
Underariting view = Format v [f5H| Freeze  EffDetach 1] Wrap @ overideck _ WamingOK _
Funding oN
Application Retrieval ¢ % = ey — T
: 4 u rigination roducer xistng  Duplicat
Scenario Analysis Dt Ao = it Status Stage Code  Producer Name Contact Number Customer Appication  CoTaCt Sales Agent
Application Documents No data to dsplay.
Image Maint=nance G — = D
Reports
Producers
Vendors
Summary Applicant  Request | Decsion  Bureau  Contract Comments | Tracking Document | Verificstion — Correspondence
Consumer
Bureau Details qpadd | ZEdt | [ view | o Audi
g IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissible purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable
by a $2500 fine and/or 1 year in Federal prison per occurrence 4
View v Formatv  Ep Freeze ffiDetach | ol Wrap @) 3 submitRequest
Type Bureau # Status Dt Report S’:D‘fg;“;ea“
No data to display.
< NI r
Bureau Details
CaRetum
Bureau Details
Type Status Credit Bureau Reorder #
Bureau ot AppInd _
= Report
> Servicng Applicant/Customer Details
?» Collections Ei Brevious Next ast
> WFP
Type Suffix Address Line 2
> Tools First Name Include Debt State
> Setup ML Populate Debt __ Zip =

For details on this screen refer Bureau Tab section in Underwriting chapter.

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screen: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
link’s screens share. If you are entering an unsecured Lease, the Collateral link is present but
inactive; in which case, skip this step.

To enter vehicle information from the Collateral tab
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ORACLE
Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral. If the collateral is a vehicle, the
Collateral link displays information about the vehicle
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If the collateral is a home, the Collateral link displays information about the home.
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If the collateral is any other, the Collateral link displays information about that collateral.
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6.9

For details on this screen refer Collateral Tab section in Underwriting chapter.
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Comments Tab

When using the Application Entry screen, you can add comments to an application at any time
in the application entry process by clicking the Tracking tab.

To complete the Comments screen

On the Application Entry tab, click Comments.
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For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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To track attributes
1.

ORACLE’
Financial Services Lending and Leasing

On the application entry screen, click Tracking tab.

No data to display.
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For details on this screen refer Tracking Tab section in Underwriting chapter.

6.10

6.10.1

Document Tab

Document Sub Tab

Application Entry’s Documents screen enables you to view Application Documents and

Application Documents Details.
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For details on this screen refer Document Tab section in Underwriting chapter.
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Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Lease until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move application to queue of the user with required authority.)

To validate a credit application
1. Enter all the information associated with the application on the Application Entry screen.

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.
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Unddemmhng Dt App = tnt  Status Stage Code Producer Name Contact Mumber Customer Application C7¢t Sales Agent
Funding No data to display.
Application Retrieval o = o ¥
Scenario Analysis
Application Documents
Image Maintenance
Reports summary | Applicant = Request Dedsion  Bureau | Contract —Comments | Tracking  Document —Verfication | Correspondence
Producers
Vendors Edits | Audits | History
Edit Types
View = Format= B Freeze fiDetach firap @ Edit Type [=] {8 CheckEdis
Date Edit Type
No data to display.
4
»
Edit Details
View v Formatw B Freeze 5t Detach Wrap ;]
Edit Name: Result Expected Value Actual Value Override Responsibility
No data to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

For details on this screen refer Verification Tab section in Underwriting chapter.
Tools tab

The Tools tab calculates the payment amount, term, interest rate, Lease amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer Tools chapter.
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6.12.1

6.13

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE?” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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7. Underwriting

71 Introduction

Underwriting is the next step after application entry in Lease origination cycle. At the
beginning of underwriting process, the application has been entered into Oracle Financial
Services Lending and Leasing, receiving an application number. The application, then passes
through the initial prescreening checks, and receives a credit bureau report. (Credit bureau
pulls are based upon zip code setup.) The system assigns it a custom credit score and based
on this, the application automatically updates its status and sent to the appropriate queue. In
doing so, one of three things happen to the application:

The application passes all the prescreening requirements and is automatically approved
based on the auto-decisioning process. The system, then, automatically notifies the
producer with a decision fax. You can use the Underwriting screen to view the
application and decision information and proceed to funding.

The application fails the prescreening requirements and is automatically rejected based
on the auto-decisioning process. Again, the system notifies the producer with a decision
fax. You can use the Underwriting screen to view application and decision information.
Also, you can rehash the application.

The application receives a status requiring a manual review and is sent to the
underwriting queue. It is now up to the underwriter to verify data and manually change
the status of application using Underwriting screen.

This chapter explains how to use the Underwriting screen to complete the following tasks:

Loading an application on the Underwriting screen
Verifying the applicant information

Verifying the credit bureau data

Calculating and validate the debt-to-income ratios
Requesting a credit bureau report manually
Adding comments and tracking attributes

Making a decision about an application

Verifying the edits

Rehashing an application

Ageing an application.

Review Requests

7.2 Underwriting Screen - an overview

The underwriting process follows these basic steps:

Opening the Underwriting screen and loading the application you want to work with.
Viewing and verifying information about the applicant supplied during application entry.
Viewing information from the credit bureau report.

Viewing and verifying information regarding the collateral, if present.

Viewing and verifying information regarding the trade-ins, if present.

Calculating and validating the debt-to-income ratios.

Selecting the pricing for the application.
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7.3

7.3.1

e Specifying information regarding stipulations, itemizations, check lists, and rate
schedules (variable rate Lease only), if required. (The checklist can be configured to
display a list of tasks to follow when using the Underwriting screen.)

e Making a decision on the Lease (APPROVE, REJECT, or CONDITION).
e Performing an edits check to verify the information on Underwriting screen.

e Viewing errors and warnings from the edits check and make the required corrections to
the data.

e Changing the status of the application.

Loading an Application on the Underwriting screen

The first step in the underwriting process is to load the application you want to work with. For
details about using the Loading an application, refer Searching for an Application in the
chapter Search Function.

Applications

The Underwriting screen’s Applications section appears at the top of the screen opened from
Underwriting master tab. The screen displays the application number and name on the
header and contains information such as application purpose, product and producer.

In this section, you can perform any of the Basic Operations mentioned in Navigation chapter

ORACLE"
Financial Services Lending and Leasing

: o
DashBoard Origination —

Search/Task | Underwriting | Review Requests (Pending: 0)

Application
View~ Formatv B

No data to display.
< >

Application

Super Summary

Applicant

> Servicing
> Collections
> WFP

> Tools

> Setup

sssss

A brief description of the fields is given below:

Field: View this:

App # The application number

Dt The application date

Product The Lease product of the application.
Channel How the application information was received.
Priority The priority of the application.
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Field:

View this:

Company The company of the application.
Branch The branch of the company.
Status The status of the application.

Origination Stage Code

The origination stage code of the application.

Billing Cycle

The billing cycle of the application. System displays the
applicable billing cycle by default based on the product
and the calculation method defined at Setup > Products
screen. The editable nature of billing cycle is controlled by
the system parameter UIX_BILL_CYCLE_AL-
LOWED_IND. However, for Rent Factor type of lease cal-
culation, only ‘Monthly’ is applicable and system displays
an error on save if any other value is selected.

Purpose

The purpose of the application.

Producer

The producer type and producer of the application.

Producer Name

The name of the producer of the application. The Producer
Name is displayed as a hyperlink and clicking on the same
will open ‘Producers’ page with details of the producer.

Producer Contact Num-
ber

The system displays the contact number of the producer.

Region

The region of the producer.

Territory

The territory of the producer.

Existing Customer

Indicates if the customer is an existing customer.

Duplicate Application

Indicates if the application is a duplicate application.

Lease Currency

The Lease currency of the application.

Class The class of the application.

Sales Agent The sales agent of the application.

Contract Type The type of application. ‘Manual’ indicates OFSLL gener-
ated application, where as ‘eContract/Dealer’ indicates
that application is generated from external system.

Joint If selected, indicates this is a joint application.

Cosigned If selected, indicates this is a co-signed application.

Contact The contact of the application.

Lead # The lead number will appear in the list only if a lead is

already created using the Sales Lead link.
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7.3.2

Field: View this:

CRB Pull Check this box to pull an initial credit bureau report, after
the application passes the pre screen edits. Uncheck the
box, if you want to enter an application without pulling a
credit report. To use a previously pulled credit bureau
report, uncheck this box and specify the Bureau and
Bureau Reorder # fields on the Primary Applicant screen.

Override Ok Check this box to ignore the overrides.

If the application has been marked as ‘Override OK’ then
the system would allow you to change the application sta-
tus even when override condition exists.

Warning Ok Check this box to ignore the warnings.

If the application has been marked as ‘Warning OK’ then
the system would allow you to change the application sta-
tus even when warning exists.

Proxy for Underwriter If you are acting as a proxy for an Underwriter, then you
can select the Underwriter’s name from the adjoining
options list. The list displays all the associated Underwrit-
ers, Underwriting Supervisors, and Underwriting Manag-
ers.

However, this is not mandatory and can be used while
auctioning an application on behalf of another underwriter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Changing the Status of the Application

You can use underwriting screen’s Applications master screen to change the status and sub
status of the application.

To change the status of the application

1. On the Underwriting form’s Application master screen, change the status of application
to either APPROVED, CONDITIONED, or REJECTED in the Status field and click Save.

The system checks the information on the Underwriting form using guidelines
established during implementation.

The system finds an error based on these guidelines, a Warning message appears
stating “Validation Error exist, Unable to Change the status. Please check the Edits.”

2. Click the Verification link and begin verifying edits on the Edits screen (For more
information, see the Verification link section in this chapter.)

During status change:

e Ifthereis an errorin the edit, system displays an error message as ‘Errors exist. Cannot
change status. Please Verify Edits.” and previous status is retained.

e Ifthere is an edit which requires override, the system displays an override message as
‘Override Required. Do you want to continue?’

— If you select ‘Yes’, the system will continue with OVERRIDE_REQUIRED
processing by changing the status.

— If you select ‘No’, the system will change the status back to old status.
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7.3.3

7.3.4

7.4

During status change, if there is a warning in the edit, the system displays an error message
as ‘Warning Exists. Do you want to continue?’.

o If you select ‘Yes’, the system will continue processing by changing the status.
e If you select ‘No’, the system will change the status back to old status.

Rehashing an Application

Once the application moves to status of APPROVED, REJECTED, or CONDITIONED status,
you cannot amend the information. However, you can amend the application, by changing the
sub status of the application to REHASHING.

To Rehash the Application

1. Open the Underwriting screen and load the application you want to change with the
APPROVED, REJECTED, or CONDITIONED status.

2. Inthe Applications master section, select REHASHING in the Sub Status field and click
Save.

After you enter the information required in the application, you can change the status to
APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more information,
refer Decision Tab section in this chapter.)

Once the status is changed to Approved, Rejected, conditioned, or Withdrawn, you
cannot make further changes to the information on the Decision tab.

Aging an Application

The Underwriting screen can be configured so that applications will be moved to a separate
queue after a certain amount of time. (This time frame is determined in setup). This
applications receive a sub status of AGED APPLICATION. This housekeeping function allows
you to keep your system free of stagnant application by moving them into an archive.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, you can view the following details in their respective sections:

e Super Summary

e Applicant
e Ratios

e Bureau

e Checklist
e Collateral
e Trade-In

e Requested

e Approved

e Decision Itemizations

e Decision History

e Comments

e Stipulations/Adverse Actions
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To view the Super Summary
1. Open the Underwriting screen and load the application you want to work with.

2. Click Summary tab. By default the system opens the summary tab. Expand the Super

Summary section.

oRacLE
Financial Services Lending and Leasing
 DashBoard e B
Origination Search/Task | Underwriting: 0000001142 | Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000001142: WRIGHT JOHN / MARTY Z gt | B view | o auit
:M;:E;‘::w Ey View Fomaty B [[[|Freeze i Detach Wop @ Override OK v Waming Ok ¥.
;::;:;’;‘m"g ot Ap# Sub Unit Status QrmatOn T2 oroducr Name i R EEEHE:{"M Contact Sales Agent Branch Prou
Application Retrieval 1ifosfa0i2 0000001142 UNDEFINED NEW - REVIEW REQUIRED  REVIEW GA-00D4: ADVANCE LEA . . N N UsHQ LA
Scenario Analysis y
Application Documents
Tmage Haintenance
Reports
Producers Summary | Applicant | Request | Decision | Bureau | Collateral | Comments | Tracking || Document | Verification | Correspondence: | Tools
Vendors
Super Summary
Super Summary
Applicant Requested {
Relation Type PRIMARY SPOUSE Cap Cost 3000000 PrtAnt 50000
Name MARTY BWRIGHT Req. Term 36
S5 soc00c67 0006639
Birth Dt 02/13/1975 03/18/1973 Decision
Address 6344 DANBLRY LN AGANA GA 8544 DANBURY LN AGANA GA Capitaized Cost 30,000.00 Buy Rent Factor 0000000
aEEdl etk Rate(%) 7.0000 Rent Factor 0.002000
Phene (976}333-3211 (978)-233-2211 Approved Term 36 Recidual % 20.0000
Own or Rent. OWNS HOME OWNS HOME
Stated Amount{Monthly) 120000 120000 Contract
Actual Amount( 0 120000 Gross Cap Cost 30,000.00
Stated Time at Residence! 50 FistPmtDt 11/10/2012
> Servicing Actual Time at Residence s s
- Collections
> WEP Employment B Primary Collateral
. Tipe FULTINE Asset Class USED HOME tileage 0
S iy WA TOOCS B Year 2012 Wholesale Value 12,000.00
> Setup R i Hake PONTIAC Retail Value 12,000.00 v

The Super Summary tab provides a snapshot of all relevant details in a single screen and
contains details of Applicant, Employment, Ratios, Bureau, Requested financials, Decision
updates, Contract updates and Primary Collateral details. You need not have to navigate to
each of these tabs for specific information on the application. Also clicking on the hyperlinks
of Address, Employment, Ratios, and Trade-In helps you to directly navigate to respective
tab(s),

During the Underwriting and Funding stages, 'verified' button is displayed just below the
address and employment details for each of the applicants. This would be enabled only when
the Verified by and Verified Dt in the respective tabs are blank. You can verify the details from
the Super Summary tab. Clicking on Verified will do the following:

1. System will copy the stated values to Actual values.

2. System will stamp the “Verified By” as 'User Name' and 'Verified Date' as 'Current GL
Date' for the respective applicant.

3. If'Verified Details' are already updated in tab or if the details are stamped, this button will
be disabled.

4. ‘'Verified' button will be available when 'Actual Amount' equal to ZERO or 'Verified By' or
'Verified Date' is NULL.

You need not navigate to Address and Employment tab for verifying applicant details.

Decision details will be displayed when application has Origination Stage as “Review,
Decisioned, Contract or Funded”. In case an application is Rehashed, only Decision
information will be displayed and Contract information will not be displayed. Contract details
will be displayed when application has Origination Stage as “Contract or Funded”.

The system displays the collateral details maintained in the collateral tab on click of navigation
button under the headings Primary Collateral and Secondary Collateral. Collateral details for
Unsecured loan also will be displayed if they are maintained.
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7.5

All the trade-in details, if any, maintained in the application would be displayed on click of
Navigation button.

Applicant Tab

Having selected and loaded an application, you can view the information about applicant in
the Applicants tab. This is information that was recorded on the Application Entry screen or
gathered during the credit pull. You can edit data from the Application Entry screen at anytime
in the following steps. Remember to save your work with each change. Information from the
credit bureau pull is available to view only.

Using the information supplied on the application, complete the Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

e Tracking Attributes

Primary Applicant details are required for SME applications also. The system uses
information on the Financial and Liabilities sub tabs in determining the applicant’s net worth.
The system uses information on the Employments screen and Other Incomes sub screen to
calculate the applicant’s debt-to-income ratio.

To verify applicant information on the Underwriting screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Applicants tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

ORACLE HEAR > 1 Signout O
Financial Services Lending and Leasing
Close
> DashBoard Gopmation mg
Origination Applicant
Save and Stay Save and Retum Return
Origination * E 8 CB
Sales Lead P ksl A
. 1 = rior Applcant _ y Dischar B,
Simple Applicat Relation Type COSIGNER [+ ol Bankruptey Discharge Dt D
Existing Customer __
Application Ent Salutation =
Existing Customer 1D NONE [0] Kve
Underwiting S -
First Name: Existing Customer # 0000000000
Funding
ML Reference #
Applcation Re| Other Details
Scenaria Analy *Last Name | QERW/YH) Status [l
| “
Application Dog Famiy Name Name in Local
Image Mainten| FATCA
g i = Language B
Reports = Gender UNDEFINED =
Producers *Birth Dt 07/04/1990 bl Birth Place
: = Mother's Maiden N
Vendors =SSN NX0K-A554 R e =
5 Education [=] =
Class NORMAL [+ Permanent US Resident ]
*Language | ENGLISH -
: Email guage [z Status
B *Dependents 0
Time Zone [+] Power of Attorney
Marital Status [=]
Identity Information ECOA | INDIVIDUAL = Power of Attorney [ A
oy = Holder Name
*Nationality USA ) Address
Ethricity [+l
* National ID 4-654-1561 . Country
Passport £ Disabiity | Natonality
= *Privacy Opt Telephone Number
.l Passport Issue Dt ) ol
i ' Passport Expiry DE & * Marketing Opt
> Servicing Visa # * Share Credit Opt
* Collections s * prior Bankruptey [
> WP License State [=]
) Address | Employments || Telecoms || Summary || Credit Scores | Dupicate Applicant | Existing Accounts | Tracking Attributes
> setup

About.
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A brief description of the fields is given below:

Field

Do this

Relation Type

Select the relationship type from the adjoining drop-down list. For
example, primary, spouse, secondary, or cosigner.

Salutation Select the salutation from the adjoining drop-down list.
First Name Specify the applicant’s first name.

Mi Specify the applicant’s middle name.

Last Name Specify the applicant’s last name.

Family Name

Specify the applicant’s family name.

Suffix Select the name suffix/generation from the adjoining drop-down list.

Birth Dt Specify the applicant’s date of birth.

SSN Specify the applicant’s social security number.

Class Select the classification of the applicant from the adjoining drop-down
list. For example, NORMAL or EMPLOYEE. The system uses this
information to restrict access to the database by recognizing employ-
ees as ‘secured applications’.

You can create a SME (Small Medium Enterprise) application by
selecting SMALL BUSINESS. When you select SMALL BUSINESS
and save your entry, the Business Applicants link on the Applicants
link is available. (required).

Email Specify the personal Email ID of the applicant.

Time Zone Specify the time zone to which the applicant belongs. This information

appears when you enter and save the zip code for the primary appli-
cant’s current home address on the Address sub screen. You can also
manually complete this field.

Identity Informa

tion Section

Nationality Select the applicant’s nationality from the adjoining drop-down list.
National ID Specify the national identification number.

Passport # Specify the passport number.

Passport Select the date on which passport was issued.

Issue Dt

Passport Select the passport’s expiration date.

Expiry Dt

Visa # Specify the applicant’s visa number.

License # Specify the applicant’s license number.

License State

Select the state where the license was issued, from the adjoining
drop-down list.
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Field Do this

Prior Appli- Check this box to indicate that the customer is an existing customer.

cant

Existing Cus- | Check this box to indicate that this applicant has a previous account.

tomer

Existing Cus- | Specify the customer ID if the applicant is an existing customer.

tomer ID

Existing Cus- | Specify the customer number if the applicant is an existing customer.

tomer # On saving the applicant details, the data in ‘Existing Customer # is
displayed as a link in ‘Applicant’ section header and clicking on the
same will display the customer details in Search Results section of
Servicing module.

Update Cus- Check this box to indicate if system can override the existing cus-

tomer Info tomer information and create the record with latest address and com-

munication details of the customer.

Other Details section

Name in Local

Specify the applicant’s name in local language.

Language
Gender Select the gender of the applicant from the adjoining drop-down list.
Mother’s Specify the mother’s maiden name.

Maiden Name

Education Select the education of the applicant from the adjoining drop-down
list.

Language Select the applicant’s native language from the adjoining drop-down
list.

Dependents Specify the number of dependents.

Marital Status

Select the marital status of the applicant from the adjoining drop-down
list.

ECOA Select the ECOA (Equal Credit Opportunity Act) code, from the
adjoining drop-down list. This defines the various possibilities on who
is liable; individual, joint, cosigner and so on.

Race Select the applicant’s race from the adjoining drop-down list.

Ethnicity Select the applicant’s ethnicity from the adjoining drop-down list. This
is the information the Home Mortgage Disclosure Act requires to be
reported.

Disability Check this box if the application has a disability.

Privacy Opt Check this box to indicate that the applicant has elected to refrain

Out from the non-public sharing of information.

Insurance Opt
Out

Check this box to indicate that the applicant has elected to refrain
from insurance related inquiries.
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Field

Do this

Marketing Opt
Out

Check this box to indicate that the applicant has elected to refrain
from marketing related inquiries.

Share Credit

Check this box to indicate that the applicant has elected to refrain

Opt Out from financial information and share credit related inquiries.
Prior Bank- Check this box if prior bankruptcy exists.

ruptcy

Bankruptcy Enter the discharge date of prior bankruptcy (if one exists).

Discharge Dt

KYC Section

Reference #

Specify the reference number.

Status Select the status of the applicant from the adjoining drop-down list.
FATCA Section

Birth Place Specify the birth place of the applicant.

Birth Country | Select the country of birth of the applicant.

Permanent US | Check this box if the applicant has permanent US resident status.

Resident Sta-
tus

Power of Attorn

ey Section

Power of
Attorney

Check this box if you hold a power of attorney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the holder.

Country Specify the country of the power of attorney holder.
Nationality Specify the nationality of the power of attorney holder.
Telephone Specify the telephone number of the power of attorney holder.
Number

Military Service
details and can b

- this section can be used to capture applicant’s Active Military Duty
e validated with applicant Bureau Details.

Active Mili-
tary Duty

Check this box to indicate if applicant is on Active Military Duty.

Effective Dt

Select the date from when the applicant is on Active Military duty
using adjoining calendar.

Order Ref # Specify the Order Reference number which indicates the applicant’s
Active Military duty service.
Release Dt Select the date from when the applicant was released from Active Mil-

itary duty using adjoining calendar.
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7.5.1

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can verify the personal information about the applicant. Two check boxes indicate if
this is an existing customer or a prior applicant. The Existing Customer field enables you
to select the existing customer.

Address Sub Tab

You can specify more than one address for each applicant, such as a home address, second
home address, and vacation home address. However, at least one must be marked as
current. Also, only one address can be selected as the mailing address, and that address
must be marked as current. Finally, while you can have more than one Home type address,
only one can be marked as current.

To complete the Address sub tab
1. Click Address sub tab.

2. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

Based on the country chosen in the address tab, the fields for capturing the address will
vary.

A brief description of the fields is given below:

Field Do this

Address Type | Select the type of address from the adjoining option list.

Current Check this box if this is a current address.

The mailing address must be marked as current.

Confirmed Check this box if the address is the confirmed one

Mailing Check this box if this is the mailing address. Only one address entry
can be marked as the mailing address.

Permission to | Check this box if customer has provided permission to contact
Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Permission to | Check this box if customer has provided permission to contact

Text through text message.
Country Select the country of mailing address from the adjoining drop-down
list.

Address Details section

Postal Type Select the postal address type from the adjoining drop-down list.

Address # Specify the address number of the mailing address

Street Pre Select the street prefix (directional) from the adjoining drop-down
list.

Street Name Specify street name.
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Field

Do this

Street Type

Select the street type from the adjoining drop-down list.

Street Post

Select the street postfix (directional) from the adjoining drop-down
list.

Apt #

Specify the apartment number.

Address Line
1

Specify the first address line.

Address Line
2

Specify the second address line.

Address Line
3

Specify the third address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the extension of the zip code.

City Specify the city of the mailing address.

State ISelect the state of the mailing address, from the adjoining drop-down
ist.

Phone Specify the phone number.

Additional Information section

Own / Rent Select the ownership type from the adjoining drop-down list.
Landlord Specify the landlord’s name.

Landlord Specify the landlord’s phone number.

Phone

Contact Specify the person contacted on behalf of landlord.
Contact Title Specify title of the person contacted on behalf of landlord.

Contact Phone

Specify phone number of the person contacted on behalf of landlord.

Extn

Specify the extension of the phone of the person contacted on behalf
of landlord.

Census Tract/

Specify census tract/BNA (block numbering area). These are defined

BNA code by the US Census Bureau code.

MSA Code Specify the metropolitan statistical area (MSA) code. These are sim-
ilar in concept to a zip code, but used mostly on government reports.

Comment Specify a comment.

Address Rent M

ortgage Stated section

Years

Specify the stated number of years at residence.
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Field Do this

Months Specify the stated number of months at residence.

Currency Select the currency code of payment amount, from the adjoining
drop-down list.

Pmt Amount Specify the stated payment amount.

Frequency Specify the stated payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Address Rent Mortgage Actual section

Years Specify the Actual number of years at residence.
Months Specify the Actual number of months at residence.
Pmt Amount Specify the Actual payment amount.

Frequency Specify the Actual payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. |If there are more than one addresses associated with the applicant, click Save And Add
on the Address sub screen and add address details.

7.5.2 Employments Sub Tab

Use the Employment sub screen to record employment information about the applicant. You
can have more than one entry.

To complete the Employments sub tab
1. Click Employments sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Check this box if this is the current employment.

Permission to Call | Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-quali-
fication of the application. Else, an error message is dis-
played.
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Field:

Do this:

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Type Select the address type from the adjoining drop-down list.
Employer Specify the employer’s name.

Occupation Select the occupation from the adjoining drop-down list.
Title Specify the title.

Department Specify the department of the employer.

Employee ID Specify the employee identification.

Employer Address section

Country

Select the country from the adjoining drop-down list.

Address #

Specify the building number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the zip code extension.

City Specify the city.

State Select the state from the adjoining drop-down list.

Additional Information section

Phone Specify the work phone number.

Extn Specify phone extension.

Contact Specify the person contacted on behalf of the employer.
Contact Title Specify title of the person contacted on behalf of the employer.

Contact Phone

Specify phone number of the person contacted on behalf of
the employer.

Contact Extn

Specify the extension of the phone of the person contacted on
behalf of the employer.

Comment

Specify a comment.

Employment Details Stated section

Years

Specify the stated number of years with the employer.

Months

Specify the stated number of months with the employer.
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Field: Do this:

Pay Day Select the stated payment day of the month using the adjoin-
ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the stated payment frequency from the adjoining drop-
down list.

Currency Select the currency code from the adjoining drop-down list

Income Amt Specify the stated income.

Salary View the salary of the customer.

Employment Details Actual section

Years Specify the Actual number of years with the employer.
Months Specify the Actual number of months with the employer.
Pay Day Select the Actual payment day of the month using the adjoin-

ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the Actual payment frequency from the adjoining drop-
down list.

Income Amt Specify the Actual income.

Salary View the salary of the customer.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.3 Telecoms Sub Tab

The Telecoms sub screen only needs to be completed if additional phone numbers exist. If
not, this sub screen can be left blank.

To complete the Telecoms sub tab
1. Click the Telecoms sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the telecommunication type from the drop-down list.
Phone Specify the phone number.

Extn Specify the phone extension.
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7.54

Field Do this

Current Check this box if this Telecom number is current.

Permission | Check this box if customer has provided permission to contact through

to Call the specified phone number.
Atleast one phone number per application should have the permission
to call (flagged as 'Y') for the successful pre-qualification of the applica-
tion. Else, an error message is displayed.

Permission | Check this box if customer has provided permission to contact through

to Text text message.

Time Zone Select the applicant’s time zone from the drop-down list.

Start Time Specify the best time to start the call.

Period Select the time period for the best time to call start time, AM or PM, from
the drop-down list.

Best day to | Select the preferred day of the week to contact the customer from the

call drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM or PM, from

the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary Sub Tab

The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the

Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub

screen, the Liabilities sub screen during application entry, and the credit bureau pull.

To View Summary sub tab

1. Click the Summary sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field

Do this

What if Pmt Amt

Specify the payment amount you want to use in the ratios.

Score View the credit score for the application
Grade View the credit grade for the application
Totals

Amt

Monthly Income- Stated

The stated monthly income.
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Field

Do this

Monthly Debt- Stated
Amt

The stated monthly liability.

Monthly Income- Actual
Amt

The actual monthly income.

Monthly Debt- Actual
Amt

The actual monthly liability.

Assets Amt - Liabilities
Amt

The net worth amount.

Ratios

Debt - Stated Before (%)

The debt amount stated before.

Debt - Stated After (%)

The debt amount stated after.

Debt - Actual Before (%)

The actual debt amount before.

Debt - Actual After (%)

The actual debt amount after.

Disposable Inc - Stated
Before (%)

The disposable income stated before.

Disposable Inc - Stated
After (%)

The disposable income stated after.

Disposable Inc - Actual
Before (%)

The actual disposable income before.

Disposable Inc - Actual
After (%)

The actual disposable income after.

Revolving Debt - Stated
Before (%)

The stated revolving debt before.

Revolving Debt -Stated
After (%)

The stated revolving debt after.

Revolving Debt - Actual
Before (%)

The actual revolving debt before.

Revolving Debt - Actual
After (%)

The actual revolving debt after.

Pmt to Income - Stated
Before (%)

The stated income payment before.

Pmt to Income - Stated
After (%)

The stated income payment after.

Pmt to Income - Actual
Before (%)

The actual income payment before.

Pmt to Income - Actual
After (%)

The actual income payment after.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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Once the payment amount is approved in Decision screen, it will be copied and
displayed in the What if Payment field in Summary sub screen.

Calculating Debt Ratios

The system offers powerful tools to the underwriter for analyzing an applicant’s debt-to-
income ratios (total of an applicant’s debt obligation divided by that person’s regular income).
The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

An underwriter may also add information to the Incomes and Liabilities sections on the
Summary sub screen during the underwriting process.

The debt-to-income ratios in the Ratios section can be recalculated by including or excluding
information from the Incomes section, Liabilities section and Financials sub screen.

To calculate debt ratios
1. Open the Underwriting screen and load the application you want to work with.
2. In the Underwriting link bar, click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
Show in the Details column.

4. Click Summary sub tab.

5. On the Summary sub screen, view the display only data in the Totals section.

Field: View this:

Monthly Income (Stated) | The stated monthly income.

Monthly Income (Actual) | The actual monthly income.

Monthly Debt (Stated) The stated monthly liability.

Monthly Debt (Actual) The actual monthly liability.

Assets The assets.
Liabilities The liabilities.
Net-Worth The net-worth.

6. Inthe What if Pmt Amt field, enter the payment amount you want to use in the ratios.
Once the payment amount is approved in Decision screen, it will be copied in the What if
Payment field and the ratios are updated accordingly.

Whenever you modify the ‘What If pmt Amt’ field, system automatically calculates the
below ratio's:

— Stated Before DTI - if liabilities, stated income or applicant financials are updated.

— Stated After DTI - if decision payment amount, liabilities, stated income or applicant
financials are updated.

— Actual Before DTI - if liabilities, actual income or applicant financials are updated.

— Actual After DTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.
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— Stated PTI - if decision payment amount, stated income or applicant financials are
updated.

— Actual PTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

7.5.4.1 Financials Sub Tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

To complete the Financials sub tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

1. Click Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select financial type from the drop-down list. For example, liquid
assets, retirement assets, and so on.

Source Specify source; for example, stocks, 401K, rent received, and so on.
Account # Specify the account number.

Currency Select the currency code from the drop-down list.

Lease Cur- View the Lease currency amount.

rency Amount

Amount Specify amount.
Include Check this box to indicate that the Asset is included.
Comment Specify comment, if any.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.2 Liabilities Sub Tab

All the liabilities of the applicant that are entered during application entry are displayed in this
tab. For example: Rent. In addition, if you need to record additional liabilities for an applicant
the same can be done in this tab. Also any liability information of the applicant received
through credit pull will be displayed under 'Credit Bureau Data' in Liabilities sub tab.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Include Check this box to indicate that the liability is included.
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Field

Do this

Liability Type Select the liability type from the adjoining drop-down list.
Currency Select the currency code from the adjoining drop-down list.
Amount Specify the liability amount.

Lease Currency

View the Lease currency amount.

Amount
Frequency Select the frequency from the adjoining drop-down list.
Account Type Specify the account type.

Account Balance

Specify the account balance.

Lease Account Bal-
ance

View the Lease currency amount.

Comment

Specify a comment, if any.

Credit Bureau Data

Bureau View the name of credit Bureau.

Open Dt View the opening date of credit account.
Pmt Manner View the mode of payment.

Account # View the account number.

Status View the current status of credit account.
Account Type View the type of account maintained.

Creditor's Name

View the name of the Creditor.

Subscriber # View the Subscriber number.

ECOA View the ECOA (Equal Credit Opportunity Act) code.
Term View the term of credit.

Credit Limit View the total credit limit amount.

High Balance View the high balance amount if any.

Past Due Amt

View the total past due amount if any.

30 View the number of delinquency days.
60 View the number of delinquency days.
90 View the number of delinquency days.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Dedupe Liabilities button removes duplicate (“de-dupes”) liabilities that may be
present from subsequent (manual) credit bureau pulls for nonspousal joint applications
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7.5.4.3 Other Incomes Sub Tab

The Other Incomes sub tab only needs to be completed if other incomes exist on the
application. If not, this sub screen can be left blank.

To complete the Other Incomes sub tab

1. Click the Other Incomes sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the income type from the adjoining drop-down list.
Note: In case, the other income of the applicant is from Employment,
then the details of Actual Amount specified in the Employments
Sub Tab is auto populated. Also if the income is verified in the
Employments Sub Tab, then Verified By and Verified Dt details are
auto populated. You can also verify the details here using the current
system date.

Currency Select the currency from the adjoining drop-down list.

Stated Amount Specify the monthly stated income.

Frequency Select the income frequency from the adjoining drop-down list.

Lease Currency

View the Lease currency amount stated.

Amount Stated
Comment Specify a comment, if any.
Include By default the include check box is selected indicating that the other

income details are included. You can deselect the same if not
required.

When Include check box is selected system automatically adds the
‘Loan Currency Amount Stated’ and ‘Loan Currency Amount Actual’
details to Applicant > Summary Tab. Also system calculates the DTI
and PTI ratio's based on ‘Actual Amount’ specified.

Actual Amount

Specify the actual monthly income amount.

Lease Currency
Amount Actual

View the actual Lease currency amount.

Verified By The Verified By field is auto populated with the logged in user name
only after the record has been verified and saved.
Verified Dt You can verify the record by selecting the current system date from

the adjoining calendar icon.

Note: System displays an error message if any other dates is
selected apart from current system date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.5.4.4 Rescoring a Credit Bureau Report Manually

Any manually pulled credit bureau reports can be used to rescore an application.

To manually rescore a credit bureau report
1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click Applicants.

3. Onthe Applicants Details screen, select the applicant you want to work with and click
View.

4. Click the Credit Scores sub tab.

5. Inthe Rescore Applicant section, select in the Credit Report ID field, the bureau report
you want to use to rescore the applicant.

6. Click Rescore.

The system displays the new information in the Credit Scores and Parameters sections.
This new score automatically appears in the System Recommendation section on the
Decision link.

7.5.5 Credit Score Sub Tab

You can view the credit score based on the system’s internal scoring models in Credit Scores
sub tab.

To View Credit Scores sub tab

1. Click the Credit Scores sub tab.

You can view the following details:

e Credit Score
— Model
— Bureau
—  Credit Report ID
— Credit Grade
— Score
—  Current

e Parameters
— Parameters
— Value
— Score

Note

If you select No Bureau in the Credit Bureau Report ID field and click Rescore, the best
match internal scoring is used for rescoring the applicant without credit bureau report.

7.5.6 Duplicate Applicant Sub Tab

Click De-dupe Applicants to display the existing customer details of the applicant. While
reviewing the de-dupe results, if the current applicant's credentials are exactly matching with
an existing customer record, you can attach the current application to the existing customer.
The same can be done by just keying in the customer ID in the applicants tab and clicking
save.
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In case a particular customer has more than one account, on clicking De-dupe Applicants the
system displays only one account in ‘Duplicate’ sub tab. However, you can view all the
accounts held by customer in 'Existing accounts' sub tab.

To View duplicate applicant’s details, click Duplicate Applicant sub tab. In this section you
can view the duplicate applicant’s details.

A brief description of the fields is given below:

Field Do this

Source Type View the source type of the duplicate applicant

Applicant Id/ Cus Id View the applicant ID if the source type is applicant and the
customer ID if the source type is customer.

Application # View the application number of the existing applicant details
for the respective records.

Days since last appli- View the total number of days elapsed since the last applica-
cation tion date. System auto calculates this value as ‘Current sys-
tem date (minus) Last application date’.

ID View the applicant ID

First Name View the first name of the duplicate applicant

Middle Name View the middle name of the duplicate applicant

Last Name View the last name of the duplicate applicant

Date of Birth View the date of birth of the duplicate applicant

CIF View the CIF no of the duplicate applicant

SSN #/ National ID View the national ID or SSN number of the duplicate appli-
cant

Driving License # View the driving license number of the duplicate applicant

City View the city of the duplicate applicant

State View the state of the duplicate applicant

Zip View the zip of the duplicate applicant

7.5.7 Existing Account Sub Tab

The Existing Account Sub Tab displays the applicant's details, if it has been previously
maintained in the system. Also along with the applicant's details, the account number of the
applicant is displayed as a hyperlink. Clicking on the hyperlink will display the respective
account details through the Customer Service screen of Servicing module.

In case you do not see a hyperlink associated with the account number, then you might have
restricted access to the Servicing module. You can request your system administrator to
navigate to Setup > User > Access screen, and enable the ‘ACCESS TO SERCOLL UCS
CUSTOMER SERVICE TAB’ option in Security Access Definition section available in the
'Screen' tab. For more information, on defining user privileges, refer to ‘3.3.2 Screen’ section
in Setup guide.
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View the following details:

Field: View this:

Account # The account number.

Title The account title.
Relation The customer relationship.
Product The Lease product.
Payoff Amount The payoff amount.

Amount Due

The delinquent amount due.

Oldest Due Dt

The due date.

Status The account status.
Company The company.
Branch The branch.

Total Pay Off Amt

The payoff amount.

Total Amt Due

The total due amount.

7.5.8 Tracking Attributes Sub Tab

You can add tracking attribute information to an application at any time in the underwriting
process by using the Tracking Attribute tab.

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.

To track attributes

1. Click Tracking Attributes sub tab.

2. Select the item you want to track.

3. Click Edit to edit the following information:

Field

Do this

Sub-Parameter

View the sub-parameter

Parameter

View the parameter.

Value

Specify the information about the corresponding Value field.

4. Save changes you made to the account.

7.5.8.1 Create Tracking

1. Click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute

box.

e If your system has been configured to use the Sub Code field, only attributes in a
particular group appear in the Parameter display.
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7.5.9

7.6

2. Specify the requested parameter in the Value field and click Save.

Customer Search Tab

While creating an application for an existing customer, you can retrieve and copy the
customer details into the new application by using the Customer Search section of the
Simple Application Entry screen.

You can modify only the address, employment, financial details and not the demographic and
identification details.

To copy the Customer Details
1. On the Underwriting screen, click Applicants tab.
2. Click Customer Search tab.

3. Inthe Search Criteria screen, use the Comparison Operator and Values columns to
create the search criteria you want to use to find a customer.

4. Click the Search button.

The system locates and displays all the customer details that meet your search criteria
in the Search Results section.

Select Reset Criteria at any time to clear the Comparison Operator and Values columns
on the Criteria screen.

5. Inthe Search Results section, select a customer you want to load.

6. Select the relation type and click Copy Customer Details.

Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business section to assist in approving the Lease
application during underwriting. The Business Applicant screen is available and contains the
following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

If there are no business information associated with the application, the Business Applicant
tab is unavailable.

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on the Underwriting screen.
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2. Click BusinessTab.
ORACLE
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Organization Type Select the organization type.

Business Type Select the type of the business.

Business Name Specify the name of the business.

Legal Name Specify the legal name of the business.

Tax ID Specify the tax identification.

Start Date Specify the business start date.

# of Employees (Cur) Specify the current number of employees at the business.

# of Employees Specify the number of employees at the business after
financing.

Contact Person Specify the contact person at the business.

Business Checking Specify the bank name of the business’s checking account.
Bank

Bank Acc # Specify the bank account number.

Avg Checking Balance | Specify the average checking balance.

# of Locations Specify the number of locations of the business.
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7.6.1

Field:

Do this:

Management Since

4. Perform any of the Basic Actions mentioned in Navigation chapter

Address Sub Tab

You can enter more than one address for the business.

To complete the Address Sub Tab
1. Click Address Sub Tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Current

Check this box if this is a current address.

The mailing address must be marked as current.

Permission to Call

Check this box if customer has provided permission to
contact through the specified phone number.

Atleast one phone number per application should have
the permission to call (flagged as 'Y') for the successful
pre-qualification of the application. Else, an error mes-
sage is displayed.

Permission to Text

Check this box if customer has provided permission to
contact through text message.

Mailing Check this box if this is the mailing address. Only one
address entry can be marked as the mailing address.

Address Type Select the address type.

Country Select the country.

Address # Specify the building number.

Own /Lease Select the ownership type.

Comment Specify a comment.

Postal Type Select the address type.

Street Pre Select the street prefix (directional).

Street Name

Specify street name

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt #

Specify the apartment number.

Address Line 1

Specify the first address line.
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7.6.2

7.6.3

Field:

Do this:

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
Phone Specify the phone number.

3. Perform any of the Basic Actions mentioned in Navigation chapter

4. |f there are more than one addresses associated with business, click Save And Add and
add the address details.

Telecoms Sub Tab

The Business tab’s Telecoms sub tab needs to be completed, if additional phone numbers for
the business exist. If not, this sub tab can be ignored.

To complete the

Telecoms sub tab

1. Click Telecoms sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Permission | Check this box if customer has provided permission to

to Call contact through the specified phone number.
Atleast one phone number per application should
have the permission to call (flagged as 'Y") for the suc-
cessful pre-qualification of the application. Else, an
error message is displayed.

Permission | Check this box if customer has provided permission to

to Text contact through text message.

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current If selected, indicates that this is a current telecom.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Financials Sub Tab

The Business tab’s Financials sub screen only needs to be completed if financial assets exist
on the application for the business. If not, this sub screen can be left blank.
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To complete the Financials sub tab
1. Click the Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select financial type; for example, liquid assets, retirement assets,
and so on.

Source Specify source; for example, stocks, 401K, rent received, and so
on.

Currency Select the currency of the asset.

Amount Specify amount.

Lease Currency The system displays the Lease currency amount

Amount
Comment Specify comment, if any.
Include Check this box to include this record in calculations on the Other

Details sub section.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.6.4 Liabilities Sub Tab

The Business Applicant link’s Liabilities sub screen only needs to be completed if financial
liabilities exist on the application for the business. If not, this sub screen can be left blank.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Type Select the liability type.
Currency Select the currency.

Lease Currency Amount | The system displays the Lease currency amount

Amount Specify the liability amount.

Frequency Select the frequency.

Account Type Specify the account type.

Lease Currency The system displays available Lease currency account
Account Balances balance.

Account Balance Specify the account balance.
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7.6.5

Field:

Do this:

Comment

Specify comments, if any.

Include

Check this box to include this record in calculations on
the Other Details sub screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Partners Sub Tab

You can enter more than one partner for the business.

To complete the Partners sub tab
1. Click Partners sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

First Name Specify the partner’s first name.

Mi Select the partner’s middle name.

Last Name Specify the partner’s last name.

Suffix Specify the partner’s suffix.

SSN # Specify the partner’s social security number.
Birth Dt Specify the partner’s birth date.

Birth Place Specify the partner’s birth place.

Title Select the partner’s title.

Ownership (%)

Specify the percentage of ownership held by the customer.

Net worth

Specify the partner’s net worth.

Gross Income

Specify the partner’s gross income.

Language Specify the partner’s language.
Nationality Specify the partner’s nationality.
Country Select the partner’s country code.
Address # Specify the partner’s address number.
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7.6.6

Field: Do this:

Address Line 1 | Specify the partner’s first address.

Address Line 2 | Specify the partner’s second address line.

Zip Select the partner’s zip code.

For non-US country, you have to enter zip code.

Zip Extn Specify the partner’s zip extension.
City Specify the partner’s city.

State Select the partner’s state.

Phone Specify the partner’s phone number.
Extn Specify the partner’s phone extension.
Email Specify the partner’s email.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Affiliates Sub Tab

You can enter more than one affiliate for the business.

To complete the Affiliates sub tab
1. Choose Affiliates sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Organization Select the affiliate’s organization type

Type

Legal Name Specify the affiliate’s legal name

Business Name Specify the affiliate’s business name

Tax ID Specify the affiliate’s tax identification

Ownership (%) Specify the affiliate’s percentage of ownership

# of Employees Specify the affiliate’s number of employees

NAICS CODE Specify the affiliate’s North American Industry Classification
System code.

Country Select the affiliate’s country code.

Address # Specify the affiliate’s address number.

Address Line 1 Specify the affiliate’s first address line.

Address Line 2 Specify the affiliate’s second address line.
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Field: Do this:

Zip Select the affiliate’s zip code.

For non US country, you have to enter zip code.

Zip Extension Specify the affiliate’s zip extension.
City Specify the affiliate’s city.
State Select the affiliate’s state.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Other Details Sub Tab

The Other Details sub screen records information regarding monetary amounts associated
with the business such as profits, sales, and expenses.

To complete the Other Details sub tab
1. Click Other Details sub tab.

2. Click Edit.

3. Verify financial details as well as assets and liabilities linked to the business.

A brief description of the fields is given below:

Field:

Do this:

Other Details section

Currency

Select the currency.

Business Type

Select the type of business.

Analysis Frequency

Select the analysis frequency.

Lease Currency Gross
Margin Factor

The system displays the Lease currency business’s gross
margin factor

Gross Margin Factor

Specify the business’s gross margin.

Organization Type

Select the type of organization.

Lease Currency Income

The system displays the Lease currency business income
amount.

Income

Specify the business’s income amount.

Lease Currency Collec-
tion Average

Specify the Lease currency collection average.

Collection Average

Specify the collection average.

Lease Currency Proj
Coll Avg Annual

Specify the Lease currency annual projected collection aver-
age.

Proj. Coll.Avg.Annual

Specify the annual projected collection average.
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Field:

Do this:

Lease Currency Book
List

Specify the Lease currency business booklist.

Book List

Specify the business booklist.

Lease Currency Turn
Over

Specify the Lease currency turnover amount.

Turn Over

Specify the turnover amount.

Lease Currency Capital
Amount

Specify the Lease currency capital amount.

Capital Amt

Specify the capital amount.

Lease Currency Earned
Surplus

Specify the Lease currency earned surplus amount.

Earned Surplus

Specify the earned surplus amount.

Lease Currency Gross
Profit

Specify the Lease currency gross profit amount.

Gross Profit

Specify the gross profit amount.

Lease Currency Net
Profit

Specify the Lease currency net profit amount.

Net Profit

Specify the net profit amount.

Lease Currency Work-
ing Capital

Specify the Lease currency working capital amount.

Working Capital

Specify the working capital amount.

Lease Currency Annual
Sales

Specify the Lease currency annual sales amount.

Annual Sales

Specify the annual sales amount.

Lease Currency Pro-
jected Sales

Specify the Lease currency projected sales amount.

Projected Sales

Specify the projected sales amount.

Lease Currency Equity

Specify the Lease currency equity amount.

Equity

Specify the equity amount.

Open Delq

Specify the open delinquency amount.

Lease Currency Busi-
ness Expenses

Specify the Lease currency business expenses amount.

Business Expenses

Specify the business expenses amount.

Lease Currency Per-
sonal Expenses

Specify the Lease currency personal expenses amount.
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Field:

Do this:

Personal Expenses

Specify the personal expenses amount.

Lease Currency Total
Expenses

View the Lease currency total expenses amount.

Total Expenses

View the total expenses amount.

Lease Currency Annual
Proj Sales Amt

View the Lease currency annual projected collection amount.

Annual Proj Sales Amt

View the annual projected collection amount.

Lease Currency Annual
Proj Exp Amt

View the Lease currency annual projected expenses
amount.

Annual Proj Exp Amt

View the annual projected expenses amount.

Lease Currency Current
Assets

Lease currency current assets.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Lease Currency Fixed
Assets

View the Lease currency fixed assets.

Fixed Assets

View the fixed assets.

Lease Currency Intangi-
ble Assets

View the Lease currency intangible assets.

Intangible Assets

View the intangible assets.

Lease Currency Current
Liabilities

View the Lease currency current liabilities

Current Liabilities

View the current liabilities.

Lease Currency Long
Term Liabilities

View the Lease currency long term liabilities.

Long Term Liabilities

View the long term liabilities.

Lease Currency Total
Assets

View the Lease currency total assets

Total Assets

View the total asset amount.

Lease Currency Total
Networth

View the Lease currency total net worth amount.

Total Net worth

View the total net worth amount.

Lease Currency Total
Liability

Lease currency total liability amount.

Total Liability

View the total liability amount.

Debt Net worth Ratio

View the debt to net worth ratio.
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Field: Do this:
Current Assets/Liability View the current asset to liability ratio.
ratio
Title 1-4 Specify the title.
Signature1-4 Specify the signature.
Request Tab

You can calculate Payment, Interest Rate, Term and Lease Amount using Request tab’s
Calculate button. By default, system calculates for monthly repayment term basis. The
payment frequency can be changed only in the Underwriting tab during decisioning.

To complete Request section:

1. On the Application Entry tab, click Request tab.

ORACLE’
Financial Services Lending and Leasing
Origination [3€] Close
= - "
Summary | Applicant Request Dedsion  Contract Collateral = Comments | Tracking ~Document = Verification = Correspondence | Tools
Requested [El view || o Audit
View > Format~v Freeze £ Detach ] wrap 5]
Gross Capitalized Cost Adjusted Cap Cost (=) Capitalized Cost Reduction () Pmt Amt Term Signing Dt Prc B
12,000.00 12,000.00 0.00 0.00 12 01/01/2018 01,
4 e . 3 [
Requested
CaReturn
Gross Capitalized Cost  12,000,00 Pmt Amt 0.00 Signing Dt 01/01/2018 hJ
Capitalized Cost Reduction {-) 0.00 Term 12 Probable Delivery Dt 01/01/2018
Adjusted Cap Cost{=) 12,000.00 Balloon Amt  0.00 Promotion UNDEFINED
Ttemization = Tradedn = Subvention

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields are given below:

Field Do this

Gross Capitalized Cost Specify the value of gross capitalized cost.

Capitalized Cost Reduction | Specify the value of capitalized cost reduction which

(-) is the advance amount.

Adjusted Cap Cost (=) View the adjusted capitalized cost which is calcu-
lated as Gross Capitalized Cost - Capitalized Cost
Reduction.

Pmt Amt Specify the requested payment amount.

Term Specify the requested term (number of payments).
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Field Do this

Balloon Amt Specify the balloon amount (if exist).

Note: This field is displayed only if the lease calcu-
lation method is ‘Interest Rate’.

Balloon Amt Specify the balloon amount.

Note: This field is displayed only if the lease calcu-
lation method is ‘Interest Rate’.

Signing Dt Specify the signing date
Probable Delivery Dt Specify the probable delivery date.
Promotion Select the promotion type from the drop-down list.

Note: This field is displayed only if the lease calcu-
lation method is ‘Interest Rate’.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

If you want system to calculate,

1. Select the record you want to work with and from the drop-down option, select the option
you want system to calculate:

e CALCULATE PAYMENT

o CALCULATE INTEREST RATE
e CALCULATE TERM

e CALCULATE LOAN AMOUNT

2. Click Calculate. The system displays the requested calculation in the respective field.

Itemization Sub Tab

The Itemizations sub tab enables you to add or verify any itemized amounts associated with
the application. The list of itemizations is determined by the product you select in the master
screen during the application entry process. The ltemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the ltemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub tab on the Underwriting screen.

Application request details need to be essentially entered in the itemization sub tab for pre-
screening to be successful. Else, the system displays error and application would not proceed
to the next level in work flow. The details of down payment, trade-in, insurance, fees etc. and
the total sale price are recorded under itemization.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Iltemization View the itemization.

+/- View whether the itemized amount is added or subtracted
from the Lease amount.

Requested Amt Specify the requested amount.

Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Request > Trade-In.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-In

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Body Specify the body of the asset.

Identification #

Specify the identification number.

Description

View the asset description.

Valuation

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Pay Off Amt (-)

Specify the payoff amount.
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7.8

Field: Do this:

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supplement | Specify the valuation supplement.

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Subvention Sub Tab

With the Subvention sub tab, available only for Lease, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the

Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Decision Tab

If the application was initially approved automatically, the system displays its
recommendations on the Decision tab’s Approved section.

If the application was initially rejected automatically, the system displays its reasons on
the Decision link’s Stipulation sub tab.
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If you choose to approve or reject the Lease manually, you must manually select the
pricing (rule) set by the portfolio company for a specific product. The system validates this
pricing against the information in the System Recommendation sections. The information in
the Requested section comes from the application entry process and can be edited.

o If the data meets your approval, change the status of the application to either
APPROVED or REJECTED and enter any stipulations.

e If you reject the application, change the status to REJECTED and enter the reasons for

the adverse action on the Stipulations sub screen.

On clicking Calculate, you can calculate the Lease amount, rate, term, and payment.
You can use the calculator available in Tools section for completing this step. For
detailed information on using the Calculator tools, refer “Tools” chapter in the document.

To verify the application decision data

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Decision tab.

ORACLE’
Financial Services Lending and Leasing

Y

Origination 5
N D GRADE 500 2 7.0000
« I

Decision Information

Pricing

Current v Decision Dt 02/05/2018
il Pricng PRC-12 Underwriter REOINA
Approved
Decision Term 12 Capitalized Cost Reduction () 0.00
Pmt Amt 0.00 Adjusted Cap Cost (=) 12,000.00
Index PRIME RATE Residual % 0.0000

Maturity Index PRIME RATE
Maturity Margin Rt 7.0000
Balloon Amt  0.00

Index Rate 9.0000

Dedision Margin Rate  7.0000

Pricing Buy Rate 5,0000

Approved Buy Rate 5.0000
Gross Capitalized Cost  12,000,00

5.0000

[ Close

0.00 SURABHI PRC-12

4

{aRetum

Status APPROVED
Sub Status BLANK

Grade B GRADE
Score 879
Bureau 1 NONE
Bureau 2
Bureau 3
Comments

3. Perform any of the Basic Operations mentioned in Navigation chapter.

— A brief description of the fields is given below:

Field: Do this:

Pricing section

Current Check this box to indicate that this is the current deci-
sion.

Pricing View the pricing.

Decision Dt View the decision date.

Underwriter View the underwriter id.

Status View the application status.

Sub Status View the application sub-status.

Approved section

Decision Term

Specify the approved decision term.
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Field:

Do this:

Pmt Amt

Specify the approved payment amount.

Note: If the system parameter ‘Auto Calculate PMT’ is
set to Y’ in Setup > Administration > System > System
Parameter screen, the system auto calculates the pay-
ment amount whenever there is a change in Decision

Term or Decision Rate or Max Financed Amount fields.

Note: Once the payment amount is approved, it will be copied on to the What if
Payment field in the Summary sub screen of the Applicants Details screen.

Index

Select the applicable index type from drop-down list.

Index Rate

Specify the approved index rate.

Decision Margin Rate

Specify the approved decision margin rate.

Pricing Buy Rate

View the pricing buy rate.

Approved Buy Rate

View the approved buy rate which is by default the Pric-
ing Buy Rate displayed above. You can also specify the
required approved buy rate.

Rent Factor

Specify the rent factor.

Note: This field is displayed only if the lease calculation
method is ‘Rent Factor’.

Buy Rent Factor

View the buy rent factor.

Note: This field is displayed only if the lease calculation
method is ‘Rent Factor’.

Gross Capitalized
Cost

Specify the value of gross capitalized cost.

Capitalized Cost
Reduction (-)

Specify the value of capitalized cost reduction which is
the advance amount.

Adjusted Cap Cost
(=)

View the adjusted capitalized cost which is calculated
as Gross Capitalized Cost - Capitalized Cost Reduc-
tion.

Residual %

Specify the residual percentage.

Maturity Index

Select the approved maturity index.

Note: This field is displayed only if the lease calculation
method is ‘Interest Rate’.

Maturity Margin Rt

Specify the maturity margin rate.

Note: This field is displayed only if the lease calculation
method is ‘Interest Rate’.

7-40 ORACLE




7.8.1

Field: Do this:

Balloon Amt Specify the balloon amount (if applicable). System auto
populates the balloon amount specified in ‘Request’
tab.

Note: This field is displayed only if the lease calculation
method is ‘Interest Rate’.

Grade Select the credit grade.
Score Specify the credit score.
Bureau 1 Specify the Bureau 1.
Bureau 2 Specify the Bureau 2.
Bureau 3 Specify the Bureau 3.
Comments Specify comments, if any.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Select Pricing.

The system determines the best pricing match of all enabled Lease pricing strings in the
Setup menu and displays the results in the Pricing and Approved sections.

6. Re-Score

A 'Re-Score' button is available next to 'Calculate’. Whenever any sensitive Financial or
Collateral information is amended in the Application, OFSLL displays a warning
message 'Scoring sensitive information is changed. Re-score the application'. You need
to click on Re-Score to re-validate the grade and pricing accordingly.

The display of the warning message to Re-score the application can be controlled using
the respective System parameter. If the defined System Parameter is flagged 'Y, only
then the message is displayed.

If you are underwriting a Lease, record the following information on the Decision tab:

7. If you are approving the application, complete the Approved section with the values you
want to approve as an underwriter. You can update the default values that appeared
when you selected the pricing string in step 3. (The system calculator may be of use when
completing this section. For more information, refer the Tools chapter).

8. Click Calculate Tax. System calculates the ‘Lease Sales and Usage tax’ for upfront
category which is billed during application funding. For more details, refer to Sales Tax
Calculation at Origination section in Appendix chapter.

System Recommendation

The System Recommendation sub screen displays the system generated Score, Decision
and Grade. You will also be able to view the request details of the application under
'Requested' section itself.

A brief description of the fields in System Recommendation section are given below:

Field: Do this:
Score View the system recommended score.
Decision View the system recommended decision.
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Field:

Do this:

Grade

View the system recommended grade.

A brief description of the fields in Requested section are given below:

Field

Do this

Requested Advance Amt

View the requested advance amount

Pmt Amt

View the requested payment amount.

Term

View the requested term (number of payments).

Requested Rate

View the requested rate of interest.

Down Pmt%

View the down payment percentage

Down Pmt View the down payment amount

Approx Prc View the approximate cash price

Promotion View the promotion type from the drop-down list.
Balloon Amt View the balloon amount.

Signing Dt View the signing date

Probable Delivery Dt

View the probable delivery date.

Stipulations Sub Tab

The Stipulations sub screen allows to add any stipulations or reasons for adverse action you
want to attach to the application. Stipulations are items that need to be addressed before the
Lease can be funded.

If the application was automatically rejected during the application entry edits, the system
displays the automatically generated adverse action codes in this sub screen. If the
application is manually rejected by the Underwriter due to adverse action reasons received
from bureau or otherwise, the same can be recorded for each of the applicant.

In addition, you can enter comments against specific stipulations as required. Whenever a
Stipulation is marked as 'Not Applicable' it becomes mandatory to specify the reason in
comments field. Else, system prompts for the reason while processing the application.

To add or view stipulations or reasons for adverse action

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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7.8.2.2

7.8.2.3

A brief description of the fields is given below.

Field: Do this:

Type Select the reason type. Type can be Stipulation Reasons or Adverse
Action Reasons and Adverse Action Reasons can also be those
received from Bureau.

Name The system displays all applicant’s name in the drop down list. You

can select the name of the applicant for whom adverse action reason
needs to be recorded. In case the stipulation reason is at the appli-

cation level, then select ALL.

Code Select the reason.

Description Specify the required description.

Stips Satisfied Use the Yes/No/NA buttons to indicate if you verified the stipula-
tion(s) in the Type field

Comment Specify the comment.

Verified By The system updates the user ID of the person who verified the
details

Verified Dt The system updates the date when the details are verified.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

If your system is set up to manually load predefined stipulations, click the Load Stipulations
button (For more information, refer the following section, Loading Stipulations.)

Add Multiple

The system enables you to add multiple records to stipulations using the 'Add Multiple' option.
To add multiple stipulations
1. Click the drop down list adjacent to the 'Add Multiple' button.

2. Select the check box against to the required stipulations. You can also select ’All’ to load
all the available stipulations.

Click Add Multiple.

4. If required, you can perform any of the Basic Actions mentioned in Navigation chapter.

Copying Stipulations

The system enables you to automatically transfer stipulations from previous decisions on the
Stipulations sub screen with the Copy Stipulations button. This is particularly useful when you
are rehashing an application and want to use the same stipulations as those in place for the
previous decision.

Loading Stipulations

The system supports the automatic generation of default stipulations on the Underwriting
screen’s Stipulations sub screen. The default stipulations can be maintained by company,
branch, product, state, application status and application sub-status. When the application
status changes (either manually and automatically), the system populates the maintained
stipulations with a Stips Satisfied indicator of ‘No’. You can review and update the stipulations
accordingly.
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7.8.4

You have the option to manually load predefined stipulations by clicking the Load Stipulations
button on the Stipulation screen.

To load predefined stipulations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations.

Click Load Stipulations. The system loads the default stipulations on the Stipulations
sub screen.

4. Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the
stipulation(s) in the Type field.

5. Click Save on the Stipulations sub screen.

Itemization Sub Tab

The Itemizations sub screen enables you to add or verify any itemized amounts associated
with the application. The list of itemizations is determined by the product you selected in the
master screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the ltemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub screen on the Underwriting screen.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Iltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Lease amount.

Requested Amt Specify the requested amount.
Approved Amt Specify the approved amount.
Discount Rate Specify the discount rate.
Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)
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To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Decision > Trade-In sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade-in section

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuation section

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

7.8.5 Rate Schedule Sub Tab

The Rate Schedule sub screen is only available for variable rate Lease and displays the rate
adjustment frequency information based on product setup.

To view the Rate Schedule sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Decision > Rate Schedule sub tab. Click View.

A brief description of the fields is given below:

Field: View this:

Seq The rate adjustment sequence number.

Adjustment Frequency Type The rate adjustment frequency type.

Period The rate adjustment period for the frequency.

# of Adjustments The number of rate adjustments for the frequency.

Subvention Sub Tab

With the Subvention sub tab, available only for Lease, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Subvention Detail section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below.

Subvention Detail section:

Participant View the participant.
Participant Type View the participant type.
Collection Method View the collection method.
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Rate

View the subvention rate.

Rent Factor

View the rent factor

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Include

View if the subvention is included in the application or not.

Total Subvention Rate

View the total subvention rate.

Total Subvention Amt

View the total subvention amount.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Select the Initialize button to reset the subvention amount to zero.

8. Select the Calculate button to calculate the subvention amount.

Compensation Sub Tab

The Compensation (Lease) sub tab records and displays the terms of compensation between
the finance company and the dealer for Lease transactions.

To complete the Compensation (Lease) sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click the Decision > Compensation sub tab.

On the Compensation sub screen’s Compensation section, select in the Compensation
Plan section the compensation plan you want to use from the drop-down list. Note that,
the compensation plan will use decision information to calculate compensation.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method

View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Paid %

View the percentage of charge back paid.

Paid Basis

View the charge back paid basis.
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Field: Do this:

Paid Term View the charge back paid term.

Paid Days View the charge back paid days.

Charge off Calc Method | View the charge back calculation method (charge off).

Charge off % View the charge back percentage (charge off).
Charge off Basis View the charge back basis (charge off).
Charge off Term View the charge back term (charge off).
Days View the charge back days (charge off).

Calculation section

Spread Formula View the compensation spread formula.
Buy Rate Specify the buy rate.

Buy Rent Factor View the compensation buy rent factor.
Factor View the compensation factor.

Addl Factor View the additional compensation factor.
Max Spread View the maximum spread allowed.

Max Markup Or Percent | View the maximum compensation Markup.

Flat Amt View the flat amount.

Compensation Amt View the compensation amount.

5. Make any necessary changes in the Approved Buy Rate and Maximum Financed
Amount fields in the Decision tab.

6. Click Calculate.
The system displays the details and amounts for this compensation plan.

7.8.8 Tax Details

When you click ‘Calculate Tax’ on the Decision tab, the lease sales and usage tax are
calculated based on tax rules defined in setup screen. If there is any exemption for tax on the
current application, the same can be defined here so that the lease tax is not levied when the
application is funded.

Note

Tax exemption is allowed only if the exemption option is selected both here and in Setup
screen (Setup > Administration > System > Sales Tax screen).

For information on defining lease tax exemption in this tab, refer to Exempt Sales Tax in
Decision/Contract tab section in Appendix chapter.
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7.9

Customer Credit Limit tab

This tab is available only if the selected product has the ‘Customer Credit Limit’ check box in
selected in Products setup screen (Setup > Products > Products).

Customer Credit limit in general refers to the maximum amount of credit that a financial
institution can extend to a prospective customer which can then be leveraged by an
underwriter while funding an application.

In Oracle Financial Services Lending and Leasing, you can define the Customer Credit Limit
during underwriting stage based on the customer credit worthiness or historical customer
data. Using this limit, applications can be funded up to the credit limit amount allowed.
However, application funding with or without customer credit limit is controlled based on the
setup and applications can still be funded with the normal process when a particular customer
is not allocated with any credit limit.

A customer credit limit facilitates for quick decisioning by an underwriter and also facilitates
for auto approval of accounts on-boarded from external system with basic validations. While
approving, underwriter has to ensure that the sum of utilizations should always be equal to
the financed amount which can be distributed within applicants primary / secondary or
business categories.

A minimum of one application has to be funded to define customer credit limit for funding
subsequent applications and the defined information is updated into credit limit details. A
credit limit once defined can further be increased from servicing module by posting the

required transaction which is referenced in origination module during application funding.

On receiving a payment, the amount is reinstated to the credit limit balance which can be re-
used while funding next application. Similarly, the credit limit balance is also updated when
account is moved to VOID status. On reversing a payment, the Total Utilization of credit limit
is increased by the principal portion of the payment and decreased with the Available Amt
field. Also, the Suspended and Hold amount fields are increased and decrease based on the
respective transactions posted.

When two applications are being funded simultaneously (i.e. moving application to ‘Approved
Funded’ status), the utilization amount will be considered for first application while the second
one will be on HOLD since there could be a difference in the available credit limit after funding.
In such a case, you need to re-hash the application, fetch the details in Origination > Decision
tab, (if required) increase credit limit from servicing module, and then proceed for funding.

While processing applications using Customer Credit Limit, the ‘Update Customer Info’ (check
box in applicant tab) and ‘Link to Existing Customer’ (check box in contract tab) are selected
by default for all the existing customers. This is to ensure the application details are
propagated to customer accounts.

On funding a new application for an existing customer using customer credit limit, the details
are updated into the existing customer details in the Servicing module.

To define Credit Limit Details

1. Open Underwriting screen and load the underwriting application you want to work with.
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Click ‘Customer Credit Limit’ tab.

ORACLE’
Financial Services Lending and Leasing
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3. Perform any of the Basic Operations mentioned in Navigation chapter. A brief description
of the fields are given below: Perform any of the Basic Actions mentioned in Navigation

Field: Do this:

Relation Type View the relationship type. This field is pre-populated with
details from Applicant tab.

Customer #/ Busi- | This field is displayed blank for new customer/business and

ness # for an existing customer/business, the details are populated

from Servicing > Customer Service > Customer details.

Name View the customer name. This field is pre-populated with
details from Applicant tab.

Max Limit Specify the value of maximum credit limit amount that can be
provided to the customer.

For new customer/business, the amount is pre-populated
based on selected pricing in Decision tab for new applicant/
business. However, you can override the amount by entering
the required value.

Total Utilized Amt View the total credit limit amount utilized for previously
funded applications.

Available Amt View the available credit limit amount on the account which
is the difference of Max Limit - (Hold + Total Utilized + Sus-
pended) amount.

Hold Amt View the credit limit amount on hold which is based on the
Hold transaction posted in servicing.

Suspended Amt View the credit limit amount suspended which is based on
suspended transaction posted in servicing.

Grade Select the required grade from the drop-down list. There is
no validation performed on the selected grade and can be
selected based on customer credit worthiness.

Max Late Charge Specify the maximum late charge amount.

Limit Expiry Select the credit limit expiry date from the adjoining calendar.
The expiry date is validated if application is being funded
based on customer credit limit.

Limit Next Renewal | Select the date on which the credit limit has to be renewed
from the adjoining calendar.

Application Utilization section - This section allows you to define the portion
(either percentage or amount) of credit limit utilization against the financed amount.

For example,

if the amount financed it 10,000 $ and percentage of Utilization for Primary is 80%
then Utilized amount should be 10,000*0.8 = 8000 $.

Similarly, if the percentage of Utilization for Spouse is 20% the Utilized amount
should be 10,000*0.2 = 2000 $.

Note: On specifying either percentage or amount of utilization, the other field is auto
calculated based on financed amount.
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7.10

Field: Do this:

% of Utilization Specify the percentage of credit limit utilization allowed
against each applicant (Customer and business) added to
the application.

Utilization Amt Specify the amount of credit limit utilization allowed against
each applicant (Customer and business) added to the appli-
cation.

chapter.
Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

If there are any adverse comments received from the Bureau, system displays them under
'Exceptions/ Comments' section against the specific Bureau record to alert the User.
Following are some of the reasons:

1. Application Indicates Potential Fraud

Bureau Indicates Social Security Number Variance
Duplicate Application Exists

Bureau Indicates a Possible Current Delinquency
Bureau Indicates Bankruptcy

Bureau Indicates Consumer Statement

Bureau Indicates a Possible Repossession

Bureau Reports OFAC hit

9. Bureau Reports Applicant as Deceased

© N o g~ w D

10. Potential Delinquencies for Auto Loans in Past 12 Months
11. Customer Rate (APR) Exceeds the State Usury Rate

12. Open Consumer Credit Counselling

The reasons will also be displayed in the Summary tab in 'Bureau' details under 'Exceptions
/Comments' section.

To verify the credit bureau data using the Bureau tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Bureau.

ORACLE
Financial Services Lending and Leasing
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In the Bureau Details section, view the following information:

Field:

View:

Type

The credit bureau request type.

Bureau

The credit bureau.

#

The credit bureau request number.

Status

The status of credit bureau request.

Dt

The credit bureau request date.

Report

The credit bureau report type.

Credit Bureau
Reorder#

The credit bureau reorder number.

App Ind

If selected, indicates that a bureau was pulled for an application.

4.

In the Applicant/Customer Detail section, view the following information:

Field:

Do this:

Type

View the relation type.

First Name

Specify the first name.

Specify the middle name.

Last Name

Specify the last name.

Status

View the credit bureau request status.
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Field:

Do this:

Birth Dt Specify the date of birth.

SSN Specify the social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Suffix Select the generation.

Include Debt | Select to include credit bureau information in the Liabilities section of
the Summary sub screen.

Populate Select to load debt information from the credit bureau in the Liabili-

Debt ties section of the Summary sub screen.

Address Type | Select the address type.

Country Select the country.

Address # Specify the building number.

City Specify the city.

State Select the state code.

Street Pre Select the street pre type.

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street post type.

Apt #

Specify the apartment number.

Address Line
2

Specify the address line 2.

Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
Phone Specify the phone number.

5. In the Report Header section, view the following information:

Field: View:

Bureau The bureau.
First Name The first name.
Mi The middle initial.
Last Name The last name.
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Field: View:

SSN The social security number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Birth Dt The birth date.

Note: The SSN and Birth Dt fields in Report Header section are displayed in red if
there is a mismatch in the respective data present in the above Applicant/Customer
Details section.

Report Dt The report date.

Onfile Dt The on file date.

Credit Report | The credit report id.
id

Best Match The best match.

6. Click Bureau Report.

The system parcels out the details from the credit bureau report in the Bureau screen’s
sub tabs (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud
Messages, Inquiries, Also Known As, Consumer Statements, and Credit Scores).

7. Click Summary 1 sub tab.

8. You can view the following information:

Field: View:

Trades Records of extended installment payments, mortgage and revolving
credit, as detailed in the credit bureau report.

Bankruptcy | The total number of times the applicant has applied for Chapter 7,
Chapter 11 and Chapter 13 bankruptcies, recently and throughout life.

Past Due The total number of times the applicant has been past due on pay-
ments by 30, 60, or 90 days in the last year, two years, and throughout
life.

Public Number of legal actions, including liens, public records, and judgments

Records over the course of the applicant’s life, as well as any that are currently
open.

Collection Trades referred to an outside vendor for collection.

Credit View the FICO and bankruptcy scores.

Scores

Statistical Ages of the oldest and newest trades, as well as the average age of

Trade Ages | the open and total trades.

Derogatory | Tradelines that an action other than being late was reported; this
Trades includes collections, repossessions, charge offs, and bankruptcies.

9. Click Summary 2 sub tab
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10. You can view the following information:

In this .

. View:

section:

Trades Records of extended credit for auto, bank, credit card, retail, Lease
finance, and sales finance Lease, as detailed in the credit bureau
report.

Inquiries Requests for a credit report regarding Lease in the Trades section
over the last six months, as well as total requests over 6, 12, and 24-
month periods, as well as the newest and oldest request.

Balance The total balance of retail and bank trades, as well as the high balance
of each.

Open The following information for all of the customer’s open trade lines: the

Derogatory | shortest and longest period of time (in months) since the customer’s
most recent minor derogatory (30-60 days late), major derogatory (90-
180 days late), and derogatory (bankruptcy, repossession, or charge
off).

Derogatory | The following information for all of the customer’s total trade lines

(open and closed): the shortest and longest period of time (in months)
since the customer’s most recent minor derogatory (30-60 days late),
major derogatory (90-180 days late), and derogatory (bankruptcy,
repossession, or charge off).

11. Click Tradelines sub tab to view information about trade lines, such as the creditor’s
name, trade’s status, type and code and balance information

12. View the following details:

Field: View:

Creditors The creditors name.

Name

Status The status of the tradeline.

Type The type of tradeline, such as bank, first mortgage, travel card, and
SO on.

Type Code The code for the type of tradeline.

Past Due Amt

The past due amount

Balance The balance of the tradeline.

Balance Dt The balance date.

Open Dt The date the tradeline was opened.

History Dt The trade line’s history date.

History Data The trade line’s history data.

30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
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Field:

View:

920 The number of times the tradeline was 90 days past due.
Creditors The creditor’s subscriber number.

Subscriber #

Mop The method of payment.

Account # The account number.

Credit Limit The credit limit.

Term Pmt Amt

The term payment amount.

High Balance | The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.

Special Exclu-
sion

If selected, the tradeline is a special exclusion.

13. Click the Public Records sub tab to view information about public records, including each
one’s type, status, and amount, as well as the date the record was filed and resolved

14. View the following details:

Field: View:

Record The record type.
Type

Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt | The satisfied date.

15. Click the Fraud Messages sub screen to view information about fraudulent attempts to
use the applicant’s credit.

16. Click the Inquiries sub screen to view all the credit reports for the applicant in reverse
chronological order

17. View the following details:

Field:

View:

Inquirer Name

The inquirer’s name.

Inquirer Subscriber | The inquirer’s subscriber number.

#

Inquirer Industry The inquirer’s industry code.
Code

Inquiry Dt The inquiry date.
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7.10.1

7.10.2

Field: View:

Rate Shopping If selected, the inquiry concerned rate shopping.

Duplicate If selected, if the inquiry was a duplicate.

18. Click the Also Known As sub screen to view other names used by the applicant.

19. Click the Consumer Statements sub screen to view statements that the applicant has
issued to the credit bureau.

20. Click the Credit Scores sub screen to view the score model, the score factor, and the
score returned from the credit bureau report.

Printing the Credit Bureau Data as a Text/PDF Report

To print the credit bureau data as a text or PDF report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. In the Underwriting screen, click Bureau.

3. Inthe Bureau Report tab, the system displays the report in text format. You can also view
the report in PDF format by selecting ‘PDF’ option as View Report.

Note

Google Chrome does not support search functionality in the PDF format of the report.
Hence you have to enable the ad-hoc plug-in in chrome to use the search facility.

4. In the Print Report section, click Print Report to send the information to the default
printer.

Requesting a Credit Bureau Report Manually

The Credit Bureau Summary screen enables you to manually request a credit pull.
Information from a manual credit pull can be used to validate an application.

To manually request a credit bureau report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Bureau tab.
In the Bureau Details section click Add.

4. Specify the following information:

Field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau.
Report Select the credit bureau report type.

5. Click Create Request.
The system displays this information in the Bureau Details section.
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7.1

Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. Select Include Debt and Populate Debt in the Applicant/Customer Detail section to
populate the Liability section on the Applicants link’'s Summary sub screen with data from
the credit bureau pull.

7. If you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section. This enables you to receive a previously pulled credit report.

8. Inthe New Request section, click Submit Request.
The system displays the latest status of the currently requested bureau report in the Bureau

Details section. When the report pull process is complete, the Status field in the Bureau
Details section changes from PENDING to COMPLETED.

Collateral Tab

Having selected and loaded an application, you can view the information about the collateral
of the Lease.

The Collateral link opens screens with information regarding any collateral associated with an
a. Depending on the type of Lease, collateral can be a vehicle, home or something such as
major household appliances. The Collateral tab is unavailable if this is an unsecured Lease.

To verify information about the collateral
1. Open the Underwriting screen and load the application you want to verify.

2. Click the Collateral tab.

Depending on the type of collateral, information about the vehicle, home, or other type
of collateral appears.

If you are entering an unsecured Lease, the Collateral link is present but inactive; in
which case, skip this step.

3. Inthe Collateral Details section (This is information that was recorded during the
application entry process or gathered during the credit pull.)
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To enter collateral information

1.

On the Underwriting screen, click Collateral. If the collateral is a vehicle, the Collateral
link displays information about the vehicle.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Status

Select the asset status.

Type and Description

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year

Specify the year of the vehicle.

Age

View the age of the vehicle

Make

Specify the make of the vehicle.
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Field: Do this:
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
County Select the county.

Usage Details

Start Specify the start.

Base Specify the base.

Extra Specify the extra usage.
Total View the total usage.
Charge Amt Specify the charge amount.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Interface with VINTEK (If interface is installed)

Using the Vintek interface, the system retrieves the year, make, model and body of the vehicle
when you choose Vehicle Details. This time saving feature reduces data entry errors. Using
the VIN entered in the Identification Number field, the system populates following fields in the
Type & Description section:

e Year
e Make
° Model
e Body
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If the Vintek interface is unable to retrieve information based on the VIN entered in the
Identification Number field, the system displays an error message.

If the collateral is a home, the Collateral link displays information about the home.
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1.

A brief description of the fields is given below:

Perform any of the Basic Operations mentioned in Navigation chapter.

Field:

Do this:

Existing Asset

Indicates that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Select if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Occupancy

Select owner occupancy type.

Identification #

Specify the vehicle identification number.

Address section

Country

Select the country.

Address #

Specify the home number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.
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Field:

Do this:

State Specify the state.
County Select the county.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.

Type and Description

Census Tract/BNA | Specify census tract/BNA (block numbering area) code.
Code

MSA Code Specify the metropolitan statistical area (MSA) code.
GEO Code Specify the geographical code for the property.
Condition Select the condition of the home.

Description Specify a description of the home.

Select Make and
Model

Select the make and model from the drop-down list

Year Specify the year when the property was built.
Age View the age of the home.

Make Specify the make of the home.

Model Specify the model of the home.

Width Specify the asset width.

Length Specify the asset length.

Area Specify the area of the collateral

PO# Specify the asset purchase order number.

Legal Description

Specify the legal description.

Lot Specify the asset lot.
Sub Division Specify the asset sub division.
Parcel ID Specify the parcel id of the home.

Metes-Bounds

Check this box to indicate the home is considered Metes-Bounds.

Flood Zone

Check this box to indicate the home is in a flood zone.

1098 Not Required

Check this box to indicate that the home does not require 1098

Deed Details
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Field:

Do this:

Construction per-
mit Dt

Specify the date on when the construction is permitted.

Deed Dt

Specify the date on when the deed is issued

Deed Place Of
Issue

Specify the place where the deed is issued.

Properties Bound-
ary from East

Specify the boundary of the property from the east side.

North

Specify the boundary of the property from the north side.

West

Specify the boundary of the property from the west side.

South

Specify the boundary of the property from the south side.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

If the collateral is an

y other, the Collateral link displays information about that collateral.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.
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Field: Do this:

Asset Class Select the asset class.
Asset Type Select the asset type.
Sub Type Select the asset sub type.
Status Select the asset status.

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year Specify the year of the vehicle.
Age View the age of the vehicle
Make Specify the make of the vehicle.
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

State Select the state.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
County Select the county.

Usage Details

Start Specify the start.

Base Specify the base.

Extra Specify the extra usage.
Total View the total usage.
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Field: Do this:

Charge Amt Specify the charge.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Valuations Sub Tab

The Valuation sub tab contains information about the value of the asset. The Values section
enables you specify the value of the asset. The Addons section records information about any
add ons associated with the collateral.

To complete the Valuations sub tab
1. Click the Valuations sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value section

Current Select if this is the current valuation.
Valuation Dt Specify the valuation date.

Source Select the valuation source.

Currency Select the currency based on which the valuation is to be done.
Edition Specify the valuation edition.

Supplement Specify the valuation supplement.

Whole Sale

Lease Cur- Specify the Lease currency wholesale value.
rency Whole-

sale Base Amt

Wholesale- Specify the wholesale value.

Base Amt

Usage Specify the usage value; that is, the monetary effect that the current
mileage has on the value of the vehicle.

Retail

Retail Base Specify the retail value.

Amt

Addons Amt (+)

View the add-ons value.

Usage Value
Amt (+)

Specify the usage. This pertains to Lease and usually is entered as
the current mileage on the vehicle.

Total Value Amt
(=)

View the total value.
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Field: Do this:

Lease Cur- View the Lease currency retail value.
rency Retail
Base Amt

Lease Cur- View the Lease addons.
rency Addons
Amt(+)

Lease Cur- View the Lease currency usage value.
rency Usage
Value Amt (+)

Lease Cur- View the Lease total value.
rency Total
Value Amt (=)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Addons Section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the description for the attribute.
Value Specify the value of the attribute.
Amount Specify the add-on amount.

Lease Currency Specify Lease currency amount.
Amount

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Complete the Addons/Attributes, Value, and Amt fields for each of the asset’s add-ons
and attributes on the application.

7.11.2 Tracking Sub Tab

The Tracking sub screen enables you to record further information associated with the
collateral. What items you choose to track are setup during implementation.

To track attributes for the collateral

1. Click Tracking sub tab

2. On the Tracking sub screen, click Load Details.

3. Inthe Tracking ltems section, select the item you want to track.
4

Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Tracking Item View the tracking type
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Field:

Do this:

Disposition

Select

the disposition.

Start Dt

Specify the tracking start date.

End Dt

Specify the tracking end date.

Follow up Dt

Specify the next follow-up date.

Enabled

field.

Select to track the information from the start date in the Start Dt

Comment

Specify any comments regarding the tracking item.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Complete the Tracking Item Details section by entering information about a parameter
in the corresponding the Value field.

7.11.3 Seller Tab

The Collateral link’s Seller Details tab enables you to enter the seller details of the collateral

of the Lease.

To enter the Seller details
1. Click the Seller Details tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this

Seller Information section

Seller Type Select the seller type.

Seller Name | Specify the seller name

Nationality Select the seller’s nationality.

National 1D/ Specify the national identification number or registration number.
Reg #

Authorized Specify the authorized signatory of the seller.

Signatory

Seller Addres

s section

Mailing Select if this is the mailing address. Only one address entry can be
marked as the mailing address.

Current Select if this is a current address. The mailing address must be marked
as current.

Country Select the country code.

Address # Specify the address number.

Address Line | Specify the first address line.

1

AddressLine | Specify the second address line.

2

State Select the state.

Zip Select the zip code.
For non US country, you have to enter zip code.

Zip Extn Select the zip extension.

City Specify the city.

Phone Specify the telephone number.

Extn Select the telephone extension.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments Tab

When using the Underwriting screen, you can add/delete comments to an application at any
time in the underwriting process by using the Comments screen.

Whenever an application is decisioned by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Underwriter <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of
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User2, who is the concerned Underwriter. The concerned Underwriter's name will also be
selected in Application section > 'Proxy for Underwriter' field.

To add comments

1. Click Comments tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Alert Check this box to make the comment appear on the Customer
Service screen Alert section

Type Select the type of comment you are adding.

Sub Type Select the sub type of comment you are adding.

Comment Specify your comment.

Comment By The system displays your user ID.

Comment Dt The system displays commented date and time stamp.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.12.0.1 Deleting Comment(s)

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment

1. Select the row which consists of the comment and click Delete from the actions.

2. Click “Yes’ to confirm delete in the warning message displayed.
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7.13 Tracking Tab

When using the Underwriting screen, you can add tracking attribute information to an
application at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes
1. Click Tracking tab.

ORACLE' # Welcome, VAVAIDYA v o
Financial Services Lending and Leasing
—— ] Close
T Origination ®
Origination Search/Task | Underwriting: 0000001050 Review Requests (Pending: 1)
Origination
SalesLead Application: 0000001050: GURLEY JENNIFER / TODD JEit| By | o agit
Simple Application Entry
View Fomat» Freeze ) Detach Wrap Override OK ¥ Waming OK ¥
Applicaton Entry & djpec Al el L
e
Underwriing . Oriination tage Duplcate
ki ot hpp Sub Unit Status i Prodiucer ame g:awmng[us{nmm Aoviation Contact Siles Agent Branch Product
Application Rl 04062015 0000001050 UNDEFINED NEW - REVIEW REQUIRED - REVIEW FR-00002 : PORSCHEINDLL. . Y ¥ DEMOSALES U0 LOANYI
Scenario Analysis )
Application Documents
Image Vaintenance
Reports
Producers Summary  Applicant | Business | Request Decsion Bureau  Colltersl | Comments | Tracking | Document | Verification | Correspondence Tools
Vendors
Tracking Attributes Field Tnestigation
i Tracking Attributes A it | hudt
Views Fomate [ [ Freeze [ Detach wep @ Load Tracing f
SubParameter  Parameter Ve
APPLICATION LOAN ATTRIEUTE 001 A
APPLICATION LOAN ATTRIBUTE 002 "
APPLICATION LOAN ATTRIBUTE 003 "
APPLICATION LOAN ATTRIBUTE 004 W
APPLICATION LOAN ATTRIBUTE 005 A
APPLICATION LOAN ATTRIBUTE 006 1A
APPLICATION LOAN ATTRIBUTE 007 A
APPLICATION LOAN ATTRIBUTE 008 " b
» Servicing
> Collections
> WFP
> Tools
7 Setup

2. On the Tracking Attributes screen, click Load Tracking to load the tracking attributes.
3. Select the item you want to track.

4. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

5. Save changes you made to the account.

7.13.1 Field Investigation Sub Tab

The Field Investigation link enables lending institutions to perform field investigations and
verify an applicant’s contact points (address and employment information, for example) and
credentials (such as asset details). Clients can chose the details to be verified (address,
employment, asset or any combination of the three), as well as the verifying agency.

With the Underwriting screen’s Field Investigation screen, you can select which details from
application entry are to be verified. The verifying agency performs a field investigation of the
details and responds to the lending institution with either XML or a text file. The details are
entered in the system for an underwriter to review when making a decision.
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1. Click Field Investigation sub tab.

2. In Field Investigation section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Applicant

Select the applicant from the adjoining drop-down list

Verification Type

Select the verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the status from the adjoining drop-down list.
Spoke to Specify the name of the person applicant spoke to
Call Dt Specify the call date

# of Attempts Specify the number of attempts made.

Result Select the result from the adjoining drop-down list

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Verification Match

Check the box if the verification has matched.

Remarks

Specify remarks, if any

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Document Tab

The Document tab allows you to view documents attached to the application in the form of

GIF files, PDF files, DOC files, XLS files and TXT files and add comments regarding a

selected.

For more information, see the chapter Document Management in this User Guide.
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To view a document attached
1. Click Document tab.
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2. Inthe Application Document section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below.

Field: Do this:

Document Type View the document type.

Comment

Specify any comments regarding the document.

Field: View this:

Document Sub
Type

The document sub type.

Version
version will start with 1.0.)

The version. (Version numbers will be incremental by batch job, first

Page # The page number.

Document File
Type

The document file type.

Tracking #

The tracking number of the document.

Docket #

The docket number of the document.

Location

The location of the of the document.

Received Dt

The effective date of the document.
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Field:

View this:

Effective Dt The effective date of the document.
Expiry Dt The expiration date of the document.
Comment Any comments regarding the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

Checklist Sub Tab

The Checklist sub tab enables you to view tasks performed during the underwriting process.

To view the underwriting Checklist screen

1.

o M 0D

Click Document > Checklist.
If the Checklist section is empty, click Load Checklist in the Checklist section.

In the Checklist Actions section, click Regular sub tab.

In Checklist Actions section, complete the tasks listed in the Checklist Action column.

Use the Yes/No/NA buttons in the Yes No NA column to indicate whether you completed
the task or not.

Use the Comment field to add remarks regarding any of the tasks, if you choose.

When you are finished completing the tasks, choose Complete in the Checklist section.

= © ® N o

Click Save.

In the Checklist Actions section, click the Documents sub tab

0. In the Documents section, select the record you want to work with and click View in the
Details column.

11. In the Documents section, view the following information:

Field:

Do this:

Action

View the action to be performed.

Document Type

View the document type.

Document Sub
Type

View the document sub type.

Status Select the status of the action.

Response Use the Yes/No/NA buttons to indicate whether or not
you completed the task.

Comment Specify comment.
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Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning, or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Lease until you fix all the errors.

If it is a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed,;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Lease. Each one of these ‘edit types’ has its own set of ‘edit details’.

Note

The Edit Details section’s errors and warnings are created during the setup process.

Edit Sub Tab

To complete the Edits section

1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Edits.
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3. Inthe Edits screen’s Edit Type section, select the type of edit you want to verify.

4. Click Check Edits.

The system checks the data for the verification process selected in the Edit Type section
and displays the results in the Edit Details section.

The Edit Details section contains the following display only information:

Field: View this:

Edit Name The edit.

Result The result.

Expected Value The expected value.

Actual Value The actual value.

Override Responsibility The override responsibility, if an override is required.

5. Inthe Edit Details section, view the verification results and begin making corrections on
the Underwriting screen. Remember, edits resulting in ERROR must be corrected. Edits
resulting in WARNING can be by passed.

The system begins processing the credit application.

7.15.2 Audits Sub Tab

The Audits screen is a display only screen that enables you track changes to the contents of
predetermined fields (which fields are determined during set up). For example, the Audits
screen can be configured to monitor when the contents of the Status and Sub Status is
changed. The Audits screen lists the field that was changed, who made the change, when the
change was made, and the old and new values in the field.

To view the Audits
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Audits.

3. Inthe Audit Details section, view the following display only information:

Field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.

Old Value The old value of the column which was changed.

New Value The new value of the column which was changed.

Changed By | The user code who made the change.

Changed The date and time when the change was made.
Date

7.15.3 History Sub Tab

You can track the time it took a user to complete each stage of the application process with
the History section. It displays:

e The date and time when an application changed status / sub status
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e The user who changed the status / sub status
e The elapsed time of how long an application was in a particular status / sub status.

1. To view the History Open the Underwriting screen and load the application you want to
work with.

2. Click Verification > Historyln the Application Status History section, view the following
display only information:

Field: View this:

Status The application status.

Sub Status The application sub status.

User The user name.

Start Dt The date and time when the application moved to that status.

End Dt The date and time when the application moved from that sta-
tus.

Elapsed The elapsed time between the status change.

Time

7.16 Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’'s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

7.16.1 Correspondence Sub Tab

To generate an ad hoc correspondence

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Correspondence > Correspondence.
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ol 16003 SAMPLE LOAN APPLICATIONS PRIMARY oFsLL ORACLE: BI PUBLISHER
‘
Document Elements Bluen || o Audt
view v Format v [y Freeze  EffiDetach Virap 5]
Element Type Element Content
‘SYSTEM-DEFINED PRIMARY APPLICANT BIRTH DATE 08/16/1991
SYSTEM-DEFINED PRIMARY APPLICANT NAME BOBEURI MADHU
SYSTEM-DEFINED APPLICATION REQUESTED ADVANCE AMT. 10000.00 £
SYSTEM-DEFINED APPLICATION APPROX CASHPRC 0 i
SYSTEM-DEFINED APPLICATION ASSET DESC 0TOYOTA CAMRY
SYSTEM-DEFINED PRIMARY APPLICANT S5N X00K2511
SYSTEM-DEFINED APPLICANT ADDRESS1 23N NEAR YELLAMMA TEMPLE ROAD BCH N % 23
SYSTEM-DEFINED APPLICANT ADDRESS2 LE 2
- T SYSTEM-DEFINED APPLICANT ADDRESS3 COAMO PR 00763 US
jassending SYSTEM-DEFINED APPLICANT EMPLOYER NAVE GEE -
> Collections
> WP
> Tools Recipient Details dpadd | Ledt | Fvien || o audt
- Vien v Formatv B Freeze  EffiDetach @ Esend
Setup) Redpient Mode Troe FAEmai SentIndeator  Comments

[]Close

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Correspondence

Select the correspondence you want to generated.

ID

System displays the correspondence ID.

Date

System displays the correspondence generation date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Documents section displays all the types of documents available for the type of
correspondence you selected.

5. In the Documents section, view the following information for each document:

Field:

View this:

Document ID

The document ID.

Document

The document description.

Recipient

The recipient description.

E-Form Source

The e-form source.

Source Type

The source type.

Selected

If selected, indicates that this document is selected to be included
in the correspondence.

Generated

If selected, indicates that the system generated the document.

6. Inthe Documents section, select the correspondence you want to view.
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7. The Document Elements section displays the elements the system used to generate the
correspondence. You view the following information:

Field: Do this:

Element Type View the element type.

Element View the element description.

Content Specify/view the value of the element.

e Click All to view all elements in the correspondence.
- Or -
e Click User Defined, to view user-defined elements in the correspondence.

8. Inthe Document Elements section, click User Defined and complete the Content fields
for the Document Element fields you want to include in the correspondence.

9. In the Document Elements section, click Save.

10. In the Documents section, click Generate.

The system ‘locks’ the information included in the correspondence and prevents it from
being changed.

11. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

7.16.1.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Applicants,
Customers, Producers, and Others as either Fax or Email.

To add recipient details

1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.16.2 Letters Sub Tab

The Letters link enables you to generate letters using predefined letter templates for Lease.

Letters can be sent in hard copy or Email / Fax. Among the two options provided for each of
these options, you can select the required mode for sending letters.

e When 'Letters' option is selected the correspondences generated are displayed in a
table below with a button 'View Letter'.

e When 'Fax' radio button is selected, the correspondence table displays all
correspondence including those in Fax or email formats in the table below.

In addition to the above, a section for recording 'Recipient details' opens below. On clicking
'Add' you can specify recipient details, Mode, Type, provide comments and Save the same.
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Comments captured will be appended to Fax / Email sent to recipient. You will then need to
click on the 'Send' in the action block for email / fax to be sent from OFSLL. In case the
correspondence generation is dependent on any job run, then on click of 'Send' system
displays an error message "Fax / Letter not generated. Please try sending later”; else event
successful message is displayed.

On the Underwriting screen, these predefined correspondences are as follows:

e Decision Letter
e Adverse Action Letter
e Adverse Conditional Letter

To generate letters on the Underwriting screen
1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Letters.

3. Inthe Letters screen, select the type of letter you want to generate, and click View Letter.
UNDERWRITING:
— Ifyou select Decision Fax, and click View Letter, the system displays the decision
letter.

The predefined Decision letter is automatically sent after an application receives a
status of APPROVED, REJECTED, or CONDITIONED on the Underwriting screen.

The Decision fax/e-mail is available for Lease (fixed and variable rate).

— Ifyou click Adverse Action, and click View Letter, the system displays the adverse
action letter.

The predefined Lease Adverse Action letter is automatically sent to the producer after
a configurable number of days when an application receives a status of REJECTED on
the Underwriting screen.

The Adverse Action letter is available for Lease (fixed and variable rate).

— Ifyou click Conditional Adverse Action, and click View Letter, the system
displays the adverse conditional letter.

The predefined Conditional Adverse Action letter is automatically sent to the producer
a configurable number of days after an application receives a status of CONDITIONED
on the Underwriting screen.

The Conditional Adverse Action letter is available for Lease (fixed and variable rate).

4. In the Recipient Details section, you can send the ad-hoc correspondence. You can
specify the following details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

5. In the Recipient Details section, click Save.

6. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.17 Tools Tab

The Tools tab calculates the payment amount, term, interest rate, Lease amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

7.18 Review Request

The Review Requests screen is primarily a work flow tool used to flag an Application for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Application. The Review Request tab supports iterative review of
selected Application and also to process the review with multiple reviewers.
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7.18.1

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

To complete the above mentioned tasks for an Application Review Request, use Review
Request tab available in the Origination (Application Entry, Underwriting and Funding)
screens.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.
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Query .

Options Descriptions

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Applica-
tion

Displays the Application Entry screen with the Application details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section

enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Origination screen displays the following information for

each record:

Fields

Descriptions

Request #

View the system generated review request number. The same
can be used to query and track the review requests.
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Fields

Descriptions

Originator The user id of the review request originator.
Priority The request priority: HIGH, NORMAL, or LOW.
Receiver The recipient of the review request.
Application # The Application number which needs review.

Application Status

The Application status of the request being reviewed.

Applicant Applicant’s name in the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Reason Stated reason in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an
Application review request is forwarded to multiple reviewers and is reviewed or completed
by second or third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.
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Comments From | Descriptions

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt View the Date and time when the comment was posted.

7.18.2 Create and Send Review Request

The review request tab primarily allows you to flag an Application for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen

and select ‘Review Requests’ tab.

ORACLE’
Financial Services Lending and Leasing

Origination y [dose

Review Requests

Request # 12002 Sender Application Status NEW - BLANK
Originator * Application # 0000001029 Ad Applicant CRACLE MADHAN / MADHAN
*Pririty HIGH [~ *Resson REVIEW APPLICATION = Rl dae
Address  NORMAL ADDRESS - 745
/NEWYORK,MASSACHUSETTS, 34038
Status Email EDW.SIRSI@GMAIL.COM
Comment REQUEST TO REVIEW THE FUNDED CALCULATIONS. Date 09/18/2017 12:12:23 AM

*Receiver | ANAND SHEKAR ~

SendRequest [¥]

Comment History
vews Fomatw | [Ep | [[]|Freeze [HfiDetach e @
Type Sub Type Commen t Comment it By Comment tDt

No data to display.

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.
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In this field: View this:

Originator View the requester’s user ID auto generated by system upon
creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Application # Select the Application to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Application Status
Applicant

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

7-87 ORACLE



7.18.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Application # link opens the Review Request tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service x ~ DashBoard x [®] Glose
Origination Setup Admin
My User Queues | | Product Expiring in Next One Month Critical Batch Job Status
] ] ]
Desaription Count Product End Date Batch Job Status
Mo data to display. o data to display. Mo data ta display.

My Pending Review Requests By Applications

i

App = Priority
0000001044 NORMAL

My Pending Review Requests By Priority

|
Priority Count =
Servicing Producer Vendor
Number of Queues Hard Assigned Producers Count By Status ‘Vendors Count By Status
@ @ @
Queue Desarption Count Status Count Status Count
No data to display. acTVE £ ACTIVE 27
Number of Accounts Producers Expiring in Next One Month || vendors Expiring in Next One Month
® i} @
Queue Desaription Count Producer End Date Company Name End Date
No data to display. Mo data to display. No data to display.
My Pending Review Requests By Accounts Producers Count By ACH Status o
0 a

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service x || DashBoard ¢ Origination x [ Cose

SearchfTask | Application Entry | Review Requests (Pending: 1)

Review Requests
Fadd | SEit | Elven || o audt

e Email
User - Originator @ Receiver ©) Both view Al [F] Forwarded oy [ Originator £ Receiver
View v Format+ B Freeze i Detach Wrap @ 2 Cpen Application SendRequest  [f3 SendResponse [ Close Request  [igk Complete Request (3] Remove Fiter
Request = orignator Prierty Receiver Applcation * Applcation Status Applcant Phne Addr
11002 HARISH MACHA NCRMAL ANAND SHEKAR 0000001044 NEW - BLANK DMOEE DEP 12334 NORI
< i ] v
Comment History Ben
Views Fomatv [P | [ Freese liDetach » | @
Type b Type Comment Comment By Comment Dt
REVIEW REQUEST ORIGINATOR REVIEW PHONE NO HMACHA 05/14/2017 03:59:29 PM

2. In the Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Application’. The Application details are displayed in Application Entry >
Summary tab.

4. Review the details in particular to the details specified in the comment (if any).

7.18.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.
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7.18.5

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.

Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.
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7.18.6

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ Save andReturn | {aReturn

Request # 8002 Sender MAVEEN REDDY Days PastDue 0

Originator PRITAM JENA Account # 2000010011820 Total Qutstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bolonce

et AEISE TR, = Customer ALIVE PRI / DEA SPO

Phone 9728663378

i F
o Statis WAITING FOR RESPONSE S ——
Bl G300 07 09252 1. NEVIYORK, MASSACHUSETTS, 34038
Send Request [ Email EDW.SIRSI@GMAILL.COM

Comment History | View
view v Format > Fresze  fDetach wrap @R
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REV] REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM
SYSTEM GENERATED REVIEW REQUEST : 6002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  05/06/2017 09:35:45 AM
REVIEW REQUEST RECEIVER FWD SURABHIL 09/06/2017 09:34:31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

5. (Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.
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7.18.7

7.18.8

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Origination > Simple Application Entry / Application Entry / Underwriting / Funding screen
and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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8.1

8.2

8. Funding

Introduction

At this stage of the Lease origination process, the application has been entered into Oracle
Financial Services Lending and Leasing and approved manually by an underwriter or by the
system. The next step is to view and complete the contract information and make a funding
decision to finance or reject the application. This is accomplished by using the Funding
screen.

This chapter explains how to:

e Load an application on the Funding screen

e Change the status of the application to begin funding process
e Verify the applicant information

e View the credit pull and underwriting information

e Verify the collateral

e Add comments and tracking attributes

e Complete the Contract screens

e View an application’s contract edits

e Audit changed fields and status history

e Change the status at the end of the funding process.

Funding (an overview)

In Oracle Financial Services Lending and Leasing, the funding process follows these basic
steps:

1. Open the Funding screen and load the application you want to work with.

2. Inthe Funding screen’s Applications master screen, Change the status of the application
to APPROVED - VERIFYING.

3. Using the Funding screen’s Applicants link, view and verify information about the
applicant (data recorded from the Application Entry screen). This includes verifying the
applicant’s actual address and employment information.

4. Using the Funding screen’s Decision link, view and verify information supplied during the
credit bureau pull and underwriting process. This is display only information and cannot
be edited.

5. Using the Funding screen’s Collateral link, view and verify information regarding the
collateral for the application.

6. Using the Funding screen’s Contract link, complete the truth-in-lending information.

7. Inthe Funding screen’s the Applications master screen, change the status to FINAL
DOCUMENT CHECK.

8. Using the Funding screen’s Verification link, view any errors and warnings that prevent
the status change.

9. Make changes to the application data that correct the errors until you can change the
status.

When the system changes the status of the application to FINAL DOCUMENT CHECK, it
sends the application to a supervisor or Lease officer queue where it is viewed and verified.
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After this, the application’s status is changed to APPROVED - VERIFIED. If the supervisor/
Lease officer decides to fund the Lease, he or she will change status of the application to
APPROVED - FUNDED.

Loading an Application on the Funding screen

The first step in the funding process is to open the Applications form and manually or
automatically load the application you want to work with. You can manually select an
application using the Search tab’s Criteria and Results screens. If your system is configured
to load applications based on work queues, use the Queue field in the Quick Search section.

Refer the chapter Searching for Application for more information on the following:

e Using Search Criteria screen
e Using Quick Search section
e Using Result screen

e Loading an application

Funding Screen’s Master Screen

The Funding screen’s master screen displays information from the Application Entry and
Underwriting screens, such as the application number, product and producer. It also contains
the Status field that allows you to change the status/sub status of the application and begin
the funding process.

For details on this screen refer Applications section in Underwriting chapter.

After opening the Funding screen and loading the application you want to work with, you must
change its status to APPROVED - VERIFYING before you can begin the funding process. This
allows you to begin working with the application.

To change the status and begin work on the application on the Funding screen
1. Open the Funding screen and load application you want to verify.

2. Inthe Funding screen’s Applications master screen, use the Status field to select
APPROVED - VERIFYING.

3. Click Save on the Funding screen.
You can now begin making changes to the application.

Funding an Application

After you have verified the application, entered the contract information and completed the
contract edits, the application is ready to be funded. Applications can be approved
automatically or manually. To manually fund an application, change the status to APPROVED
- FUNDED.

After an application is funded, the Lease origination cycle is over. The system moves the
application to the Lease servicing module (Customer Service form) where it receives an
account number. The system also automatically creates a check requisition for the funded
account.

Funding tasks
1. Load the application on the Funding form
2. Change the status and initiate Funding process

3. Verify the applicant information
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8.5

Complete Contract (5) details

Verify the documents

Generate letters

Attempt to change the application status

Verify edits

© ©®© N o o &

Complete Funding

After you approve the application, the information on the Decision tab is unavailable. The
application remains in this status of Approved - Verified until a user (usually a supervisor)
changes the status to Approved - Funded. When the status is changed to Approved - Funded,
the account is created.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, the user can view the applicant details, asset details, ratios (only for
Primary Applicant), trade-In, requested details, approved details, itemization, decision history,
alerts, comments, and checklist details in the respective section.

To view the Summary

1. Open the Funding screen and load the application you want to work with.

2. Click Summary.
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For details on this screen refer Summary Tab section in Underwriting chapter.

Applicants Tab

Having selected and loaded an application, you can use the Applicants link to view
information about the applicant (s). This is information that was recorded on the Application
Entry screen or gathered during the credit pull. You can edit the data from the Application
Entry screen at anytime in the following steps. Remember to save your work with each
change. Information from the credit bureau pull is available to view only.
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To verify information about an applicant
1. Open the Funding screen and load the application you want to work with.
2. Inthe Funding tab, click Applicants.

3. Inthe Applicants Details section, select the applicant you want to verify and click Edit.
ORACLE
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For details on this screen refer Applicant Tab section in Underwriting chapter.

Business tab

If this application is an SME Lease (defined in the Applications section Class field as SMALL
BUSINESS), the Business Applicant link appears on the Funding link bar. This link displays
the small business information recorded on the application entry process. You can edit the
Funding screen at anytime in the following steps. Remember to save your work with each
change.

If there is no business information associated with the application, the Business Applicant link
is unavailable.

For more information about the individual fields in this section, see the Application Entry
chapter.

To verify business information from the Business Applicant link

1. Open the Funding screen and load the application you want to work with.
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2. Click Business Applicant.
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For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

System displays the calculated Payment, Interest Rate, Term and Lease Amount in the
Request tab.

For details on this screen refer Request Tab section in Underwriting chapter.

Decision Tab

With the Decision tab, the system displays information gathered during the underwriting
process. Depending on the type of application you are working with, system displays Lease
information. On Clicking Calculate, the user can calculate the Lease amount, rate, term, and

payment.
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The fields on the Decision screens and sub screens are described in detail in the Underwriting
chapter.
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For details on this screen refer Decision Tab section in Underwriting chapter.

8.9 Customer Credit Limit tab

This tab displays the customer credit limit details captured during the underwriting process
and is validated during application funding. Depending on the type of application you are
working with, system displays Lease information.
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For details on this tab, refer Customer Credit Limit tab section in Underwriting chapter.
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Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab
1. Open the Funding screen and load the underwriting application you want to work with.
2. Click Bureau
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For details on this screen refer Bureau Tab section in Underwriting chapter.

Contract Tab

The screens associated with the Contract link are the core of the funding process. They allow
you to perform the important task of completing the truth-in-lending details. These screens
include information mandated by Regulation Z; information about the financed amount, the
payment schedule, the total of these payments, the finance charge, the resulting annual
percentage rate (calculated according to Federal/Central bank guidelines; that is, within 125%
of the Treasury OCC calculated APR) for the conventional Lease, and internal rate of return
for Islamic Lease. Use the Lease packet to supply the required information.

In completing the truth-in-lending details on the Contract link, you will enter Lease information.
The truth-in-lending details must be completed before a Lease can be funded.

The tabs opened from the Contract link share the following sub tabs:
e Contract (2)
e Repayment
e Itemizations
e Trade-In
e Subvention
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e Insurances

e ESC

e [Escrow

e Compensation
e Proceeds

e Disbursement

o Fees
e ACH
e Coupons

e PDC
e References
e Real Estate

On clicking Calculate, you can calculate the Lease amount, rate, term and payment. You can
use the calculator available in Tools section for completing this step. For detailed information
on using the Calculator tools, refer “Tools” chapter in the document.

To enter the contract details
1. Open the Funding screen and load the application you want to work with.

2. On the Funding screen, click the Contract tab.
e If the application you opened is for a Islamic Lease, the Lease screen appears.
3. Using the information in the contract packet, complete the Contract section.
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(The system calculator may used when completing this section. For more information, see
the Tools chapter.)

4. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Contract section

Contract Dt Specify the contract date.
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Field:

Do this:

Instrument

Select the required instrument from the drop down list and click
on Load Instrument Details.

Amt Due at Sign-
ing

Enter the prepaid amount.

Total of Pmts

Enter the estimated total of payments.

(Estimated)

Due Day Specify the due day.

1st Pmt Dt Specify the first payment date.

Maturity Dt Specify the maturity date.

Index Select the applicable index type from drop-down list.
Note: If the lease calculation method is selected as ‘Rent Factor’,
then Flat Rate Index type is applicable by default.

Index Rate Specify the approved index rate.

Contract Margin
Rate

Specify the contract margin rate.

Contract Rate

Specify the contract rate.

Balloon Method

View the balloon payment method.

Note: This field is displayed only if the lease calculation method is
‘Interest Rate’.

Balloon Amt

Specify the balloon amount.

Note: This field is displayed only if the lease calculation method is
‘Interest Rate’.

Security Deposit

Specify the security deposit amount.

Gross Capitalized
Cost

Enter the gross capitalized cost.

Capitalized Cost
Reduction (-)

Enter the cap cost reduction.

Adjusted Cap
Cost (=)

Enter the adjusted cap cost.

Residual %

View the residual percentage.

Residual Value (-)

Enter the residual value.

Depreciation
Value (=)

Specify the depreciation value.

Rent Charge (+)

Enter the rent.
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Field:

Do this:

Rent Factor

View the rent factor.

Note: This field is applicable only if the lease calculation method
is selected as ‘Rent Factor’.

Total of Base Pmts

=)

Enter the total of payments.

Lease Term (/)

Enter the term.

Base Payment (=)

Enter the payment amount.

Estimated Sales
Tax (+)

Enter the sales tax amount.

Sales Tax

View the sales tax percentage.

Estimated Pmt (=)

Enter the payment amount percentage.

Rcvd Dt Specify the date on which deposit is received.
Verified Dt Specify the contract verification date.
Verified By View the user id who verified the contract.

Depreciation section

Depreciation Start
Dt

View the date from when asset depreciation is applicable.

Depreciation
Method

View the method by which depreciation is calculated.

First Last Year
Conv

View the first to last year conversion.

Payment Caps

Max Pmt Increase
/ Year

The maximum payment that can be increased for the year.

Max Pmt Increase
/ Life

The maximum payment that can be increased in the life of an
application.

Instrument Details — An instrument is a contract with specific rules tied to it. An instru-
ment associated with the application indicates OFSLL of the type of contract being
used for the approved lease. Items defined in the contract are “locked in” when you
select the instrument from drop down list and click on "Load Instrument". These values
cannot be changed on the funding screen.

Any changes to the instrument in account will be handled by monetary/non-monetary

transactions.

The system loads all the rules established by the company that are required at the time
of funding; for example, the accrual method, billing method, type of billing, tolerance,
due dates, extensions and so on.

Accrual Method

View the accrual calculation method.

ORACLE



Field:

Do this:

Start Dt Basis

View the accrual start basis.

Base Method

View the accrual base method.

Bill Method

View the billing method.

Bill Type

View the billing type.

Time Counting
Method

View the time counting method.

Calendar Method

View the Calendar Method.

Installment
Method

View the installment methods.

Stop Accrual Days

View the accrual stop days.

Lease Type View the type of lease such as Direct Finance or Operating
Lease.

ACH Fee Ind Indicates that the ACH fee should be applied or not. Depending
on the status of check box, the ACH fee is applied based follow-
ing conditions:

- When the check box is selected and the fee amount is ZERO,
system will not apply the ACH fee.

- When the check box is selected and the fee amount is BLANK,
system will apply the ACH fee from Contract setup.

- When the check box is selected and the fee amount is specified,
system will apply the specified amount and overrides the ACH fee
amount mentioned in Contract Setup.

- When the check box is not selected, system will apply the ACH
fee amount mentioned in Contract Setup.

Tax section

Sales Tax Method

View the sales tax method used for tax calculation.

Sales Tax Mode

View the sales tax mode.

Tax Life

View the tax life.

Ads Life

View the ads life.

Tax Salvage Value

View the tax salvage value.

EOT Value

View the EOT value.

Tax Book Type

View the tax book type.

Early Termination section

Allowed To Termi-
nate

If checked, indicates that early termination of lease contract is
allowed.

Billed Term

View the total billed amount on the lease contract.
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Field:

Do this:

Lease Amt Recov-
ered %

View the percentage of lease amount recovered against the lease
contract amount during early termination.

Residual Details section

Minimum Resid-
ual %

View the minimum residual percentage valid with lease contract.

Maximum Resid-
ual %

View the maximum residual percentage valid with lease contract.

Residual Value In
Final Bill

If checked, indicates that residual amount (if exist) can be
included in the final bill.

Residual Valuation

View the type of residual valuation method.

PDC section

PDC Ind

If selected, indicates that the customer has opted for PDC.

PDC Security Ind

If selected, indicates that the customer has submitted the PDC as
a security.

Rate Caps and Adjustments section

Note: This section is displayed for ‘Interest Rate’ type of lease calculation method.

Increase Per Year

View the maximum rate increase allowed in a year.

Increase Max Life-
time

View the maximum rate increase allowed in the life of the Lease.

Increase Floor

View the rate cap (minimum).

Increase Ceiling

View the rate cap (maximum).

Decrease Per
Year

View the maximum rate decrease allowed in a year.

Decrease Max
Lifetime

View the maximum rate decrease allowed in the life of the Lease.

# of Adjs / Year

View the maximum number rate changes allowed in a year.

# of Adjs / Life

View the maximum number of rate changes allowed in the life of
the Lease.

Post Maturity section

Note: This section is displayed for ‘Interest Rate’ type of lease calculation method.

Default Rate

If selected, indicates the default rate is available.

Index

Select the post maturity index.

Post Margin Rate

Specify the past maturity rate.

Recourse Details
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Field: Do this:

Recourse View the recourse indicator. If selected, it indicates that there is a
recourse associated with the Lease and the following recourse
details can be specified.

Recourse Type Select the recourse type as either 'Partial' or 'Full' from the drop-
down list.

Recourse Rea- Depending on the type of recourse selected, you can select the

son following type of recourse reason from the drop-down list.

For recourse type as 'Partial’, system defaults the recourse rea-
son as ‘Partial’.

For recourse type as 'Full', you can select one of the following
options:

- Fraud

- Titles

- Fraud and Titles
- Full

- Full and Titles

Recourse Max % | Specify the maximum percentage of recourse allowed. Ensure
that the specified amount does not exceed 100% or the amount
defined at Contract.

Note: You can specify the recourse either in percentage or as flat
amount in the below field.

Recourse Amt If ‘Recourse Max %’ is not specified, you can specify a flat
amount to be allowed for recourse.

Others
Rent Collection View the type of rent collection method as either Advance or
Method Arrears.
For ‘Interest Rate’ type of lease calculation, both Advance and
Arrears are applicable. For ‘Rent Factor’, only Advance method is
applicable.
Contract Expiry View the total number of days the lease contract is valid after the
Letter Days contract expiry.

Stmt Preference Select the account statement preference mode from the drop-
Mode down list.

By default, the option selected in ‘Product’ setup screen (Setup >
Administration > Products > Contract screen) is displayed.

Promotion Details - If applicable, enter information regarding any promotion associ-
ated with the application in the Promotion section. The Promotion details maintained in
Setup > Products > Promotions are populated here.

Promotion Select the promotion.

Type View the promotion type.
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Field:

Do this:

Dlg Days View the delinquency days.
Period Type View the period type.
Period View the promotion period.

Tolerance Amt

View the tolerance amount (displays only).

Index

View the promotion index (displays only).

Index Rate

View the promotion index rate (displays only).

Promotion Margin
Rate

View the promotion margin rate (displays only).

Promotion Rate

View the promotion rate.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Contract (2) Sub Tab

The Contract sub screen records the application’s servicing branch and collector. It also
displays additional information regarding the contract not covered on the Lease screen, such
as the tolerance, delinquencies, due dates, billings, and extensions.

To complete the Contract sub tab

Open the Funding screen and load the application you want to work with.

In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

2. Click the Contract > Contract sub tab.

A brief description of the fields is given below:

Field:

Do this:

Servicing Branch

Select the servicing branch for the contract.

Collector

Select the collector for the contract.

Funder

If you are acting as a proxy for a Funder, then you can select
the Funder’s name from the adjoining options list. The list
displays all the associated Funders, Funding Supervisors,
and Funding Managers.

However, this is not mandatory and can be used while auc-
tioning an application on behalf of another Funder.

Misc section

Link To Existing Cus-
tomer

Select to link the application to the existing customer.

Anniversary Period

View the anniversary term.

Default Pmt Spread

View the spread.
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Field: Do this:

HMDA section

Lien Status Select the lien status.

HOEPA Select the home owner equity protection act (HOEPA) code.

Rate Spread

Specify the rate spread. You can calculate this spread from a
tool on the Home Mortgage Disclosure Act (HMDA) website.

Others section

1st Pmt Deduction

View the first payment deduction indicator. If selected, the
first payment deduction is in use.

Days

View the first payment deduction days.

1st Pmt Refund

View the first payment refund indicator. If selected, the first
payment refund is in use.

Days

View the first payment refund days.

Pre-Pmt Penalty

View the prepayment penalty indicator. If selected, a prepay-
ment penalty can be applied.

% of Term for Penalty

View the prepayment penalty percentage of term.

Pay Off Fee

View the payoff fee indicator. If selected, a payoff fee can be
applied to the Lease.

Rebate section

Rebate Method

View the rebate calculation method.

Rebate Term Method

View the rebate term method.

Rebate Min Fin Chg
Method

View the rebate minimum finance charge calculation
method.

Rebate Min Fin Chg
Value

View the minimum finance charge value.

Acquisition Charge
Amt

View the acquisition charge amount.

Tolerance section - This section displays the tolerance details as defined in Setup >
Products > Contract screen.

Refund Allowed

View the refund allowed indicator. If selected, the refund pol-
icies in this section are in use.

Refund Tolerance

View the refund tolerance amount.

Pmt Tolerance Amt

View the payment tolerance amount.

Pmt Tolerance%

View the payment tolerance percentage.
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Field:

Do this:

Promise Tolerance
Amt

View the ‘Promise to Pay’ tolerance amount.

Promise Tolerance %

View the ‘Promise to Pay’ tolerance percentage.

Writeoff Tolerance

View the write-off tolerance amount.

Delinquency section

Late Charge Grace
Days

View the late charge grace days.

Delq Grace Days

View the delinquency grace days.

Delq Category
Method

View the delinquency category method.

Time Bar Years

View the total number of years allowed to contact the
customer starting from the first payment date as defined in
Setup > Products > Contract screen.

Due Date section

Max Due Day Change | View the maximum due days.

Days

Min Due Day View the minimum due day.

Max Due Day View the maximum due day.

Max Due Day Change | View the maximum due day changes allowed (year).
Year

Max Due Day Change | View the maximum due day changes allowed (life).
Life

Extension section

Max Extn Period /
Year

View the maximum extension allowed (year).

Max Extn Period / Life

View the maximum extension allowed (life).

Max # Extn / Year

View the maximum number of extensions allowed (year).

Max # Extn / Life

View the maximum number of extensions allowed (life).

Minimum # Payments

View the minimum number of payments.

Extension Gap in
Months

View the extension gap in months.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.2 Repayment Sub Tab

The Repayment sub screen records the application’s advance information, repayment
schedule, and skipped repayment months for variable rate Lease.
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To complete the Repayment sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Repayment sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Repayment section:

Flexible Repay- | If this display only check box is selected, then the flexible repay-

ment Allowed ment functionality is set up and allowed for this application's prod-
uct type.
Type Select the flexible repayment schedule you want to use from the

following: SKIP PERIOD, USER DEFINED, UNDEFINED.

If you select the repayment schedule type of SKIP PERIOD, you
then select the months for which borrower won't make any pay-
ments in the Skip Months section.

If you select the repayment schedule type of USER DEFINED, you
then enter the repayment schedule requested by borrower in the
Schedule section; for example, $300.00 for first 12 months,
$350.00 for next 18 months, and so on.

Note: The borrower may not provide a complete repayment sched-
ule with the contract. Provisions are available with the system to
compute the repayment schedule for remaining periods at a later
time, if borrower provides partial repayment schedule.

Skip Months section

Jan If selected, indicates that repayment is skipped for January.
Feb If selected, indicates that repayment is skipped for February.
Mar If selected, indicates that repayment is skipped for March.
Apr If selected, indicates that repayment is skipped for April.

May If selected, indicates that repayment is skipped for May.

Jun If selected, indicates that repayment is skipped for June.

Jul If selected, indicates that repayment is skipped for July.

Aug If selected, indicates that repayment is skipped for August.
Sep If selected, indicates that repayment is skipped for September.
Oct If selected, indicates that repayment is skipped for October.
Nov If selected, indicates that repayment is skipped for November.
Dec If selected, indicates that repayment is skipped for December.
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Field:

Do this:

Extendable Balloon section

Max Term

Specify maximum number of payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Repayment Schedule section, click View.

6. View the following information:

Repayment Schedule section

Note: Complete the Schedule section only if you have entered USER DEFINED in the

Repayment section’s Type field. Click Add to make new entries.

Seq Specify the sequence number of the repayment schedule.

Pmt Amt Specify the repayment amount borrower agreed to pay during the
schedule.

# of Pmts Specify the number of payments borrower agreed to pay for stated
repayment amount during this schedule.

Generated If selected, indicates that the schedule is system generated.

Enabled If selected, indicates that the schedule is enabled.

7. Inthe Payment Change Schedule section, click View.

8. View the following information:

Payment Change Schedule section

Seq Specify the payment sequence number.
Option Type Select the option type.

Frequency Specify the payment change frequency.
Period Specify the period.

# of Adj Specify the number of adjustments.
Value Specify the adjustment value.

8.11.3 Itemizations Sub Tab

The system lists the distribution of the Lease proceeds on the Itemizations sub screen when
you choose Select Instrument on the Contract link. It lists amounts paid to the borrower
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ behalf
to third parties. Itemizations are categorized according to advances, finance fees, prepaid
fees, producers or escrows. If you have entered itemization amounts during application entry
or underwriting, you will see these values in the Amount or Approved Amt columns.

The Itemizations sub screen offers the option of computing the values for itemization

according to a itemization formula associated with the selected instrument based on system
setup.
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If yo
com

u require any new itemizations, you can add them using the Setup menu Products
mand. (For more information, see the Products chapter in the Setup Guide.)

To complete the Itemizations

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Itemizations sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:
Field: Do this:
Itemization View the itemization.
+/- View whether the itemization is added or subtracted.
Amount View the amount.
Approved Amt | View the approved amount. This is information recorded on the

Underwriting screen.

Discount Rate | Specify the discount rate.

Tax View whether the itemization is taxable (Sales) if box is selected.
Sir View the seller payment.
[temization View the itemization type.
Formula
Itemization View the itemization type.
Type
Prefunding View the prefunding status.
Status
Pmt Dt View the payment date.
Pmt Ref # View the payment reference number.
Comment Specify additional comments, if any.
4. Choose the option button for the type of itemization you want to use: Advance, Financed
Fees, Pre-Paid Fees, Producer or Escrow.
5. In the Amount column, enter the amount corresponding with what is listed in the
Itemization column.
6. If the Itemization Formula field contains an entry other than UNDEFINED, you can

choose Compute to auto-compute the value in the Amount field using a predefined
itemization formula.

Itemization formulas are created on the Product Setup screen’s Origination Fees
screens. (For more information, see the Org. Fees tab section of the Products chapter
in the Setup Guide.)

To ensure you create the correct computed value, choose Compute after entering
values for all base itemizations; that is, values of all such itemizations with an
Itemization Formula of UNDEFINED.

You can also manually enter amounts for auto-computed itemizations.
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If you click Initialize, the system sets the values of auto-computed itemizations to 0

(zero).

7. If you choose, use the Comment field to add remarks.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.4 Trade-In Sub Tab

If there is any information regarding an itemized trade-in, use the Trade-In sub screen to enter
the details in the system (This sub screen might already contain information supplied during
the underwriting process.)

To complete the Trade-In sub screen

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Trade-In sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade In section

Asset Type

Select the asset type.

Asset Sub Type

Select the asset sub-type.

Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuations section

Wholesale Amt

Specify the wholesale amount.

Base Retail Amt

Specify the retail amount.

Addons Amt (+)

Specify the add ons amount.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total amount.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.
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Field: Do this:

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.5 Subvention Sub Tab

With the Subvention sub screen, you can enter the subvention information and calculate the
subvention amount, as well as override the calculated subvention amount. The participant’s
information is automatically populated based on the selected subvention plan.

To use the Subventions sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Subventions sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:
Field: Do this:
Subvention section:
Plan Select the subvention plan code.
Description View the subvention plan description
Sub Plan Select the sub plan.
Sub Plan Description Select the subvention sub plan.
Subvention Type View the subvention type
Subvention Amount View the subvention amount for the plan.
Include If selected, indicates that the subvention is included.

5. Click View in the Subvention Details section.

View the following:

Participants section:

Participant View the participant.

Participant Type View the participant type

Collection Method View the collection method.

Rate View the subvention rate.

Rent Factor View the subvention rent factor.
Calculation Method View the subvention calculation method.
Factor View the factor.
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Calculated Amount View the calculated subvention amount.

Subvention Amount Specify the subvention amount.

Total Subvention Rate View the total subvention rate.

Total Subvention View the total subvention amount.
Amount
Include If selected, indicates that the subvention is included.

6. Click Initialize to reset the subvention amount to zero.
7. Click Calculate to calculate the subvention amount.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.6 Insurance Sub Tab

If there is any information regarding an itemized insurance amount, enter the details on the
Insurance sub screen. The Insurance sub screen also enables you to calculate the
commission if there is a commission rule defined during Contract setup.

To complete the Insurance sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Insurance sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Insurance Plan Select the insurance plan associated with the financed insurance
product.

Insurance Type View the insurance type associated with the insurance plan.

Sub Type Select the insurance sub type offered under the insurance plan.

Insurance Com- Specify the insurance company associated with the insurance

pany plan. The system populates the default insurance plan defined

during product setup.

Policy # Specify the insurance policy number.
Effective Dt Specify the insurance effective date.
Term Specify the insurance term.

Expiry Dt Specify the insurance expiry date.

Commission Rule | View the insurance premium amount.

Premium Amt Specify the insurance premium amount.

Commission Amt | View the insurance commission amount.

Phone Specify the insurance company’s primary phone number.
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Field: Do this:

Extn Specify the insurance company’s primary phone extension.
Phone Specify the insurance company’s alternate phone number.
Extn Specify the insurance company’s alternate phone extension.

Beneficiary section

Primary Specify the primary beneficiary of the insurance.

Secondary Specify the secondary beneficiary of the insurance.

Cancellation/Refund section

Cancellation If selected, a refund is allowed. A selected box indicates that the

Refund Allowed insurance premium can be rebated to the customer in case of
early payoff.

Grace Days View the number of grace days allowed for cancellation without

charging a cancellation fee.

Calculation View the insurance premium refund/rebate calculation method to
Method be used when insurance is cancelled.

Grace Days Can- | If selected, indicates that cancellation fees during grace is
cellation Fee allowed.
Allowed

Cancellation Fee | View the amount of the cancellation fee to be charged when the
insurance is cancelled.

Deduct Fee From | View the option defined in setup screen (Setup > Administration >
Products > Insurances) to deduct the cancellation fee.

‘Premium Amount’ indicates fee is deducted upfront before
computation and ‘Rebate Amount’ indicates fee is deducted after
computation.

4. |If you click the Calculate button, the system computes the commission based on the
commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Policy Information section.

It also appears on the Itemizations sub screen.
You can overwrite the suggested value if you choose.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.7 ESC Sub Tab

If there is information regarding an itemized extended service contract or warranty amount,
enter the details on the ESC sub screen.

To complete the ESC (extended service contracts) sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > ESC sub tab.
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3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:

Field: Do this:

Warranty Information section

Service Con- View the extended service contract type.
tract
Policy # Specify the ESC number.

Effective Date | Specify the ESC effective date.

Term Specify the ESC term.

Expiration Dt Specify the ESC expiry date.

Premium Amt | View the ESC premium amount

Commission View the commission amount.

Amt

Commission View the commission rule.

Rule

Warranty Specify the ESC company’s name.

Company

Comment Specify comment if any.

Phone No Specify the ESC company’s primary phone number.
Extn Specify the ESC company’s primary phone extension.
Phone No Specify the ESC company’s alternate phone number.
Extn Specify the ESC company’s alternate phone extension.

Cancellation/Refund

Allowed Check this box to allow cancellation/refund.
Method Specify the method of cancellation/refund.
5. In the Cancellation/Refund section, view the following information.

6.

7.

— Ifthe Allowed box is selected, a refund is allowed. A selected box indicates that the
ESC premium can be rebated to the customer in case of early payoff.

— The Method field displays the refund method.

If you click the Calculate button, the system computes the commission based on the

commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the

Warranty Information section.
It also appears on the Itemizations sub screen.
You can overwrite the suggested value if you choose.

Perform any of the Basic Actions mentioned in Navigation chapter.
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8.11.8 Escrow Sub Tab

If there is escrow information selected on the Itemization sub screen, enter information about
it on the Escrow sub screen. The Escrow sub screen records escrow details regarding
disbursement, insurance, and property tax -- information that is parsed to the Customer
Service screen on the Customer Service (2) master tab, where it is available for maintenance.

This sub tab is available if escrow is allowed for the instrument selected on the Lease screen.

The Escrow Analysis screen enables you to view and perform the initial escrow analysis. You
can perform multiple analyses; however, the system records only the most recent analysis.

To complete the Escrow sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Escrow sub tab.

3. The Escrow Information section displays information regarding the escrow recorded on
the Itemization sub screen. In this section, you can perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: View:
Escrow The escrow itemization code and description.
Escrow Type The escrow type.

Escrow Sub Type | The escrow sub type.

Advance Amt The amount that’'s been approved for the Item in the itemiza-
tion screen under the escrow.

Required Escrow If selected, indicates that this is mandatory itemization and
customer can not opt out of this escrow item.

Cushion Allowed If selected, indicates that cushion is allowed.

4. Select the Opt Out box only if you want to ignore this particular escrow.

5. In the Disbursement section, enter the following information:

Field: Do this:

Rule Select disbursement rule.

Yearly Amt Specify yearly disbursement amount.
Account # Specify reference account number for vendor.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Vendor Specify the vendor name.

Maturity Dt Specify the maturity date, if one exists.
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6. If this escrow involves an insurance, use the Insurance section to enter the following
information:

Field: Do this:

Coverage Type Specify the coverage type.

Coverage Term Specify the coverage term.

Policy # Specify the policy number.
Coverage Amt Specify the coverage amount.
Effective Dt Specify the effective date.
Expiration Dt Specify the expiration date.

7. If this escrow involves a tax, use the Tax section to enter the following information:

Field: Do this:

Property Tax Type Specify property tax code.

Comment Specify a comment.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.9 Compensation Sub Tab

The Compensation (Lease) sub tab records and displays the terms of compensation between
the finance company and the dealer for Lease transactions.
To complete the Compensation (Lease) sub screen

1. Open the Funding screen from the Origination master tab’s Funding bar link and load
the application you want to work with.

2. Click the Contract > Compensation sub tab.

3. Onthe Compensation sub screen’s Compensation section, select in the Compensation
Plan section the compensation plan you want to use.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field: Do this:

Compensation section

Compensation Plan View the compensation plan.
Disbursement Method View the compensation payment method.
Calculation Method View the compensation calculation method.

Chargeback section

Paid Calc Method View the charge back calculation method (early payoff).

Paid % View the percentage of charge back paid.
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Field: Do this:

Paid Basis View the charge back paid basis.
Paid Term View the charge back paid term.
Paid Days View the charge back paid days.

Charge off Calc Method

View the charge back calculation method (charge off).

Charge off % View the charge back percentage (charge off).
Charge off Basis View the charge back basis (charge off).
Charge off Term View the charge back term (charge off).
Days View the charge back days (charge off).

Calculation section

Spread Formula

View the compensation spread formula.

Buy Rate

Specify the buy rate.

Buy Rent Factor

View the compensation buy rent factor.

Factor View the compensation factor.
AddI Factor View the additional compensation factor.
Max Spread View the maximum spread allowed.

Max Markup Or Percent

View the maximum compensation Markup.

Flat Amt

View the flat amount.

Compensation Amt

View the compensation amount.

5. Make any necessary changes in the Buy Rate field.

6. Click Calculate.

The system displays the details and amounts for this compensation plan.

8.11.10 Proceeds Sub Tab

The Proceeds sub screen displays the payment amount due to the dealer, based on the
Compensation and Itemization sub screens. It is a view only sub screen, though you can
record comments.

To use the Proceeds
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Proceeds sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field: Do this:
Itemization View the proceed itemization.
+/- View whether the itemization is added to or subtracted from the

total proceeds.

Amount Specify the amount.
Currency Specify the currency of the proceed.
Comment Specify a comment.

Total Amount View the total amount.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.11 Disbursement Sub Tab

The Disbursement sub screen records how the Lease payment is disbursed and records
payments to third parties such as the Department of Motor Vehicles. This sub screen needs
to be completed if there is an itemized disbursement.

To complete the Disbursement sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Disbursement sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Disbursement section

Validate Payee Check this box to validate payee.
Description View the disbursement description.
Number Specify the disbursement party’s number.

Payment Mode Select the payment mode.

Name Specify the company name.

Account # Specify the account number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,

XXXXX1234.
Amount View the payment amount.
Currency Specify the currency.
ACH Account Specify the account type.

Type
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Field:

Do this:

Account # Specify the ACH account number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is setto Y, this appears as a masked number; for example,
XXXXX1234.

ACH Bank Specify the bank number.

ACH Routing #

Specify the routing number.

BIC

Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN

Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Comment

Specify a comment.

Country

Select the country.

Address Line 1

Specify the address line 1.

Address Line 2

Specify the address line 2.

Zip Specify the zip code.
For non US country, you have to enter zip code.
City Specify the city.
State Select the state.
Phone 1 Specify the primary phone number.
Extn Specify the primary phone extension.
Phone 2 Specify the alternate phone number.
Extn Specify the alternate phone extension.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Disbursement tab will display the records only if a third party itemization is maintained
during contract setup.
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8.11.12 Fee Sub Tab
The Fee sub screen is a view-only table displaying what fees on the Lease instrument are in
use, based on the contract.
To view the Fee
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Fee sub tab.

3. Inthe Fee sub screen, view the following display only information:

Field: Do this:

Fee View the fee type.

Fee Calc Method View the fee calculation method.

Txn Amt From View the minimum transaction amount.

Gross Capitalized | View the minimum value of gross capitalization cost.

Cost From

Percent View the maximum percentage.
Min Amt View the minimum fee amount.
Max Amt View the maximum fee amount.
Enabled If selected, the fee rule is enabled.

8.11.13 ACH Sub Tab

The ACH sub screen records details about automatic clearing house, if this is a direct deposit
payment account; otherwise, it remains empty. This information is used to receive payments,
primarily when working with the Payments screen.

To complete the ACH
1. Open the Funding screen and load the application you want to work with.
2. On the Funding screen, click the Contract tab, then choose the ACH sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Bank Name Specify the bank name.

Routing # Specify the routing number.

Status Select the required ACH status from the drop down list. By default,

the ACTIVE status is selected.

Default By default, this check box is selected indicating that the current
ACH is the default one. If not, you need to uncheck the same.
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Field: Do this:

Start Dt Specify the ACH start date. By default the first payment date of the
contract is auto populated and can be edited.

End Dt Specify the ACH end date.

Account Type Select the account type.

Account # Specify the account number. Note: If the organizational parameter
UIX HIDE RESTRICTED DATA is settoY, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business ldentifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces,
and checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT _NL) is defined
by default with length of IBAN as 18.

Pmt Day Specify the payment day. By default the payment due day specified
for the contract is auto populated and can be edited.

Pmt Amt Specify the payment amount. By default the payment amount
decided for the contract is auto populated and can be edited.

Note: If the payment amount is specified as ZERO, system will
automatically consider the EMI amount.

Pmt Amt Specify the additional payment (if any). This is the additional amount
Excess over and above the regular EMI. Appropriation of this amount is
based on the ‘Spread’ defined in the contract.

Pmt Freq Select the payment frequency. By default the bill cycle frequency
defined for the contract is auto populated and can be edited.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. If there are more than one ACH banks and an optional End Date, click Add and repeat
steps 3 through 5.

8.11.14 Coupon Sub Tab

The Coupon sub screen enables you to order (or re-order) new coupon books. This sub
screen is only available if the bill type for this application is a coupon payment, not a
statement.
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8.11.15

To complete the Coupon

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Coupon sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:

Order Select to order coupon book.

Order Dt Specify the coupon book order date.

Ordered By Select the user id of the user who ordered the coupon book.

# of Coupons

Specify the number of coupons.

First Pmt Dt

Specify the first payment date.

Coupon Start-
ing #

Specify the starting number of the coupon book.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

References Sub Tab

The References link enables you to enter any number of people as a reference on the

application.

To complete the Reference screen (Contract link)

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > References link in this section, you can perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Relationship Select the reference type.

Name Specify the reference name.

Status Select the status of the reference from the drop-down list.
Years Specify the number of years.

Months Specify the number of months.

Comment Specify a comment.

Country Select the country.

Address Line
1

Specify the address line 1.
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Field:

Do this:

Address Line
2

Specify the address line 2.

State Select the state.
Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
Phone 1 Specify the reference’s primary phone number.
Extn Specify the reference’s primary phone extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

Phone 2

Specify the reference’s secondary phone number.

Extn

Specify the reference’s secondary phone extension.

Permission to
call

Check this box if customer has provided permission to contact
through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

If you want to add another reference, click Add and repeat steps 3 and 4.

8.11.16 Real Estate Sub Tab

The Real Estate Fields screen records additional information regarding manufactured home

Lease.

To complete the Real Estate Fields screen

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Real Estate.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.
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A brief description of the fields is given below:

Field:

Do this:

Note Transmittal Number

Specify the note transmittal number.

Deed Transmittal Number

Specify the deeding transmittal number.

Cancel/Cashout Transmittal
Number

Specify the deeding cancel/cash out transmittal
number.

Deed Input Date

Specify the deed input date.

Deed Recording Date

Specify the deed recording date.

Deeding Book Number

Specify the deeding book number.

ConDeeding Page Number

Specify the condeeding page number.

Mortgage Recording Date

Specify the mortgage recording date.

Mortgage Book Number

Specify the mortgage book number.

Mortgage Page Number

Specify the mortgage page number.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.11.17 PDC Sub Tab

The PDC sub screen displays any post dated checks associated with the contract.

To complete the PDC

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > PDC sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:

PDC Ind If selected, indicates that this account involves a post dated check as
a method of repayment.

PDC Type Select the post dated check type, SECURITY CHECKS or POST
DATED CHECKS FOR PAYMENT.

Account # Specify the account number, on which the cheque is drawn.

Routing # Specify the routing number of the cheque. It is the number printed on
the cheque, also called MICR number (Magnetic Ink Character Rec-
ognition).

Account Specify the type of the account

Type

Bank Name Specify the bank name of the customers cheque
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Field:

Do this:

Branch Specify the Branch name of the customers cheque

Name

Docket # Specify the docket number where post dated checks are supposed
to be stored.

Check # Specify the starting cheque number.

Check Dt Select the check date. In case there are multiple checks being
deposited that have sequential serial numbers, the date of the first
cheque in the series would be entered in the date field. The remain-
ing cheque dates would be anniversary dates based on the fre-
quency set up.

For example, the cheque range could be from 111 to 180. If the date
on the first cheque-111 is October 12, 2003 and the frequency is set
to Monthly, the next cheque would be picked up for processing on
November 12, 2003.

Check Amt Specify the appropriate cheque amount.

No of Specify the total number of checks in the range.

Checks

Billing Cycle | Select the frequency at which the checks are to be sent for collec-
tion.

Comments Specify any remarks for the details.

4. Click Generate.

5. Inthe PDC Table section, select the record you want to work with and enter, view or edit
the following information:
Field: View this:
Select If selected, indicates that this is the current record.
PDC Type The type of post dated check in use.
Account # The account number of the post dated check.
Bank Name The bank name of the post dated check.
Check # The check number of the post dated check.
Status The status of the post dated check.
Check Dt The check date of the post dated check.
Check Amt The check amount of the post dated check.
Account The account type of the post dated check.
Type

6. Perform any of the Basic Actions mentioned in Navigation chapter.
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8.12

Collateral tab

Having selected and loaded an application, you can view the information about the collateral
of the Lease.

The Collateral link opens screens with information regarding any collateral associated with an
account. Depending on the type of Lease, collateral can be a vehicle, home, or something
else, such as major household appliances. The Collateral link is unavailable if this is an
unsecured Lease.

A detailed explanation of the fields found on the Collateral link’s screens and sub screens can
be found in the Application Entry chapter.

To verify information about the collateral
1. Open the Funding screen and load the application you want to work with.

2. Click the Collateral link.

Depending on the type of collateral, information about the vehicle, home or other type
of collateral appears.

3. Verify the information regarding the collateral and its sub screens. (This is information that
was recorded during the application entry process or gathered during the credit pull.)

If the collateral is a vehicle, the Collateral link displays information about the vehicle.

ORACLE
Financial Services Lending and Leasing

& Welcome, VAVAIDYA ~ =

iginatic | Close.
e Origination ]
Origination Search/Task | Underwriting: 0000001533 Review Requests (Pending: 0) .
Origination
S Application: 0000001533: SIGG MARK Elwew || o muit
Simple Application Entry
kg View v Fomatv [ Freeze G Detach Wep | @ OvemideOK v Warming OK ¥
Underwriting o b Duplicate
ik ot App # Sub Unit Status StaProduce lame CorBxitng Cstomer i 21c2e Con
ApriEain Hefriors 09/05/2015 0000001533 APPROVED - FUNDED F_. CA-00003 : ACE HEADQUA . (.. N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Summary || Applicant | Business || Request || Dedsion | Contract  Collateral | Comments | Tracking | Document || Verffication | Correspondence | Tools
Vendors
Collateral | Seller
Vehicle
View v Formatv B Freeze ¢ Detach | wrap o0
EXEENS pscet Class Primary  Description Identification #  Asset Type Sub Type Existing Asset Td Status Ye
N NEW VEHICLE 5 2015 AUDI A% 'WAUAF78E26A119.. VEHICLE CAR NOT DEFINED 20
bl L4 >
4
Vehicle
G Retum
Existing Asset__ Body. Zip Extn
Existing Asset 1d Registration # UNDEFINED City BELLINGHAM
Primary ¥ Age 0 State MASSACHUSETTS
Asset Class NEW VEHICLE Description 2015 AUDIL A4 County NORFOLK
Asset Type VEHICLE Condition GOOD CONDITIONED
SubType CAR Usage Details
Status NOT DEFINED Address Start 12
Country UNITED STATES Base 10
Type & Description Address # 480 NEPONSET ST Extra 2
Year 2015 Address Line 1 Total 24
Make AUDI Address Line 2 TURNPIKE ST Charge Amt 200.0000
Model A4
> Servicing Identfication = WAUAF7BEZ6A119602 zp 02019
> Collections Valuation  Tracking
> WEP
» Tools Valuation El view | « audit
> Setup View » Formatw B Freeze i Detach rap o) v
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If the collateral is a home, the Collateral link displays information about the home.

ORACLE

Financial Services Lending and Leasing

4 Origination
Sales Lead
Simple Application Entry
Application Entry
Undenwriting
Funding
Application Retrieval
Scenarie Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination s [ Close:
Search/Task  Underwriting: 0000001536  Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED View | o audit
View v Formatw [ Freeze i Detach Al wirap @ Override 0K v  Waming OK v
o b Duplicate
Dt App 2 Sub Unit Status Ste Producer Name Coi Existing Customer v Contad
o Ny Applicoton
177 09j05/2015 0000001536 APPROVED - FUNDED F.. CA-00003 : ACE HEADQUA.. (.. ¥ ¥
>
Summary || Applicant | Business || Request || Dedsion || Contract | Collateral || Comments || Tracking || Document || Vertfication | | Comrespondence
Collateral | Seller
Home [E] view || « audit
View - Format~ B Freeze i Detach 5]
BXSNS  existing Asset1d  Primary  Asset Class et Typie SbiTyre iy ldenification # | Coumtry Address #
] ¥ NEW VEHICLE HOME SINGLE FAMILY H.. OCCUPIED BY OW... EZ6A119602 UNITED STATES 480 NEPONSE
4 < >
‘4
valuation Tracking
Valuation Bl view || 2 audit
View v Formatw [ Freeze [l Detach o Wrap {50}
Loan Currency . Usage value Amt
Cument o LOBNCUTEISY  Retai Base Amt 17 veluation Dt Source Currency Edition Supplement \
iv 19,000.00 19,500.00 0.00 08/05/2015 INVOICE US DOLLAR
< >
Addons Sl wew || o aude
view ~ Format~ [ Freeze [fiDetach | o wrap (50
Description Value Amount Loan Currency Amount
ANTL THEFT 230.00 230.00

If the collateral is anything other than a vehicle or home, the Collateral link displays
information about the other type of collateral.

ORACLE’

Financial Services Lending and Leasing
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Simple Application Entry
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< >
Summary || Applicant  Business || Request | Decision | Bureau | Collateral | Comments | Tracking | Document | Verification | Comespondence | Tooks
Collateral  Seller
Other Collateral dradd | At | 5 vew | o Audic
View~ Format~ [B Freeze i Detach B Existing Asset Id ¥ o Load Details
zﬁ;”g Existing Asset Id Primary  Asset Class Asset Type Sub Type Status Year Age Make Model
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N oY NEWVEHICLE  VEHICLE R NOT DEFINED 20150 AUDE A%
< > i
Other Collateral
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Existing Asset__ Body Zp ]
R * Registration 2 UNDEFINED Zip Bxin
* Primary el T
s Identification # i
* Asset Class NEW ASSET [~ " aity
Description T
. e State [v]
At Tye \REUSEHOND GonDS [v] Condition GOOD CONDITIONED [v] =
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* Sub Type GENERAL HOUSEHOLD GOODS / E[~] 2
= Status NOT DEFINED [v] Address Usaqe Details
*Country UNITED STATES & 7
Select Make and Model v 7 —
Address 2 =
*Year 0 i Base 0
=z ddress Line 1 iz [
Mok Gl *Total 0
Model *Charge Amt 000
Valuation  Tracking v

For details on this screen refer Collateral Tab section in Underwriting chapter.
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8.13

8.14

Comments Tab

When using the Underwriting screen, you can add comments to an application at any time in
the underwriting process by using the Comments screen.

Whenever an application is funded by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Funder <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of User2,
who is the concerned Funder. The concerned Funder’s name will also be selected in Contract
Tab > 'Funder field.

To add comments to an application
1. Open the Funding screen and load the application you want to work with.

2. Click Comments.

ORACLE
Financial Services Lending and Leasing

Origination (30 s

Application o || Sl || P nude
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(m} ReGULAR ~| | LoAn oRIGmNATION |~ VAvAIDYA 02/03/2016 12:09:56 AM

> sarvicing
> Collections
> wrp

> Tools
> Setup

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

When using the Funding screen, you can add tracking attribute information to an application
at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes for an application
1. Open the Funding screen and load the application you want to work with.
2. Click the Tracking tab.

ORACLE

& Welcome, DEMOSUPR ~ 13 signout O
Financial Services Lending and Leasing

= Glose
»| DashBoard Origination (3l
Origination Result/Task Funding Search Review Requests (Pending: 0) 2
"/ Origination o
Sales Lezd Application Aedt | Elven | o audt
Simpie Appication Entry: view - Format - | B Frecze | fefiDetach P T overrideok [1 warningok [
T T T -
Application Entry [ [ Producer |
i |Grignation Stage | |Existing
| | | I |Mumber |
Funding
No data to display.
Application Retrieval o - .
Scenario Analysis
Application Decuments
Image Maintenance
G erne Summary Applicant Request Dedsion Bureau Contract Comments Tracking Document Verification Correspondence
Producers Tracking Attributes Field Investigation
Vendors .
Tracking Attrubutes
Eseveandstay | [ sove andRetun | Garewm |
view v Format v | B Freeze  iff Detach Wrap =)
_ |sub-parameter  |Parameter [value
o data to display.
4
4

For details on this screen refer Tracking Tab section in Underwriting chapter.
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8.15

8.16

Document tab

The Document Maintenance link allows you to view documents attached to an application in
the form of GIF files, PDF files, DOC files, XLS files, and TXT files and add comments
regarding a selected document.

For more information, see the chapter Document Management in this User Guide.
To view a document attached with an application
1. Open the Funding screen and load the application you want to work with.

2. Click Document.

ORACLE’
Financial Services Lending and Leasing

PR — [=)

(3] Qlose

e Origination »

Origination Search/Tesk | Funding | Review Requests (Pending: 0)

Origination
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Checklist  Document

Checklist

View v Formatw [ Freeze i Detach Wirap @ o Load Checkist
Checklist Type Checklist
No data to display.
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485 Complete
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Regular | Document

Checklist Actions # Edit
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Action Comment.
No data to display.

Elview || o audit

Respanse

< >
> Servicing

> Collections
> WFP

> Tools
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For details on this screen refer Document Tab section in Underwriting chapter.

Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Lease until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)
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The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Lease. Each one of these “edit types” has its own set of “edit details.”

Note

The Edit Details section’s errors and warnings are created during the setup process.

To complete the Verification tab
1. Open the Funding screen and load the application you want to work with.

2. In the Edit Type drop-down list, select 'Application Approval Edits' and click on 'Check
Edits' button.

Edit details are displayed in the table below along with the result, expected value, actual
value and the override responsibility. This is based on the product and contract set up
details that is done initially.

For more information, refer to Configuring Lending and Leasing setup guides.

3. Specify all the information associated with the application on the Funding screen.

ORACLE’ 2 Welcome, PRAKRRAO + o
Financial Services Lending and Leasing

T Origination 3§ Clos=

Origination Search/Task | Funding | Review Requests (Pending: 0)
Origination
Sales Lead

Application A et || [Eview || o audit

Simple Applicatiol -
Application Entry View v Fomate [ Frezze (i Detach Wrap T Override OK__ Waring OK _
Underwriting Origination Stage Producer Contact i Duplicate
ik Dt App # Sub Unit Status Code Producer Name Number Buasting Customer Application Contact sa

fa t
hoplication Retriy||| Mo data to dispiay. *
Scenario Analysis
Application Docur
Image Maintenan
Reports Summary Applicant Request | Decision Bureau Contract Comments = Tracking Document Verification Correspondence
Producers
Vendors Edits | | Audits || History

Edit Types

View = Fomatw Ep Freeze {4 Detach Wirap W Edit Type [V] 8 check Edits
Date Edit Type
No data to display
“
‘
Edit Details
View w Formatw [ Fresze EfiDetach | ¢ Wrap (%]

Edit Name Result Expected Value Actual Value Override Responsibility
No data to display.

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

e If there are edits with 'Error' entries, verify and correct the data in the respective tabs
and repeat step 2 until the 'Error' entries are cleared.

e When there are only 'Warnings' left you can choose to change the status of the
application to the next stage in the Origination cycle.

4. When you are finished entering data, on the Funding link bar, click Verification.

For details on this screen refer Verification Tab section in Underwriting chapter.
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8.17

8.18

Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

To generate an ad hoc correspondence
1. Open the Funding screen and load the application you want to work with.

2. Click Correspondence.

ORACLE" . . & weicome, vavaya - [ElSENOGE C
Financial Services Lending and Leasing
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> Servicing Element Type Element Content
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For details on this screen refer Correspondence Tab section in Underwriting chapter.

Escrow Analysis Tab

If escrow is allowed for the selected instrument, the Escrow Analysis link is available on the
Contract drop-down link. This screen enables you to view and perform the initial escrow
analysis. When you are satisfied with the analysis, complete the Approval Dt field in the
Approval section and save your entry.

The escrow payment for the Lease account starts on the 1st date of the Lease payment
month. The disbursement happens on the 10th of the month (as per the disbursement rules).
The escrow analysis lasts for a year (12 months) irrespective of the Lease term.

You can perform multiple analysis; however, the Escrow Analysis screen only records the last
analysis performed. No record of any earlier analysis is currently available.

To complete the Escrow Analysis screen

1. Open the Funding screen and load the application you want to work with.
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2. On the Funding screen, Click Escrow Analysis tab.
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b
-

3. Inthe Escrow Analysis section, view or enter the following information:

Field: View:

Escrow The escrow item.

Disbursement Rule The escrow disbursement rule.

Yearly Amt The escrow disbursement yearly amount.

4. Click Analyze.

5. Information on the Analysis Details screen is based on expected cash flow from contract
and escrow disbursement setup. Payments received appear before escrow disbursement
in any given month. Click View in Escrow Analysis section.

6. In the following section, enter, view, or edit the following information:

Field: View:

Parameters section

Date The date.

From Dt The FROM date for the escrow activity.
To Dt The TO date for the escrow activity.

Opening Bal (Act) The opening balance actual amount.

Opening Bal (Est) The opening balance estimated amount.

Calculation: cushion amount + low required balance

Cushion Type The cushion type.
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Field: View:

Cushion Value The cushion value.

Cushion Amt The cushion amount.

Calculation: as per the shortage /cushion Rule maintenance

Results section

Std Pmt Amt The standard payment amount.

Escrow Pmt Amt (+) The escrow payment amount.

Calculation: Yearly Amount/12.

Spread Pmt Amt (+) The spread payment amount.

Calculation: Surplus amount / 12

Other Pmt Amt (+) The other payment amount.

New Pmt Amt = The new payment amount.

Calculation: standard payment amount + escrow payment
amount + spread payment amount + other payment amount

Surplus section

Surplus /<Shortage The surplus shortage amount.

Amt> . .
Calculation: escrow account balance - opening balance

Refund Amt The refund amount.

7. Click View in the Analysis Details section.

8. On the Analysis Details sub screen, view the following information:

Field: View:

Txn Dt The transaction date.

Transaction The escrow transaction.

Vendor The vendor name.

Txn Amt The amount of the transaction.
Balance Amt (Est) The estimated amount of balance.
Balance Amt (Act) The actual amount of balance.

Information on the Analysis Details sub screen is based on expected cash flow from
contract and escrow disbursement setup. Payments received appear before escrow
disbursement in any given month.

9. If you want to re-analyze the escrow analysis, change the escrow information on the
Contract link’s screen and sub screens.
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8.19

8.20

If you want to approve the escrow analysis, complete the following information fields on
the Approval section:

Field: View:

Approval section

Approval Dt The approval date.

Approved By | The person who approved the Lease.

10. Click Save on the Funding screen.
Tool Tab

The Tools tab calculates the payment amount, term, interest rate, Lease amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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9.1

9. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Lease and Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed. They cannot be copied to the application / contract.

Whereas, Tools that appear as a sub-tab in Underwriting and Funding Tabs, allows you to

import the contract values, do necessary calculations and copy the calculated values to the
respective Contract / Decision tabs.

Lease Calculator

The Lease Calculator screen facilitates you to calculate various lease parameters such as
Payment, Interest Rate, Residual Percent, Gross Capitalized Cost, Term and Lease Amount.
You can define flexible repayment options, repayment/rate schedule and generate
amortization schedules.

This screen is similar to the Lease Calculator screen opened from Underwriting or Funding
screens; however, calculators opened from Tools master tab are standalone and do not link
calculations or lease information to any specific application.

Based on the type of lease calculation method, the following calculation parameters are
available in Lease Calculator screen:

I&Itzatzigalculation Calculation Parameters Available | To Calculate
Rent Factor Calculate Payment Base Payment
Calculate Rate Rate
Calculate Residual Percent Residual %
Calculate Gross Capitalized Cost Gross Capitalized Cost
Interest Rate Calculate Payment Base Payment
Calculate Interest Rate Rate
Calculate Term Term
Calculate Lease Amount Gross Capitalized Cost
Note

If you want to clear (or “refresh”) the lease calculator at any time, click Initialize in the
Lease Calculator section.
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To calculate a lease payment

1. On the Oracle Lending and Leasing home screen, click Tools > Tools > Lease

ORACLE" 3 BSHEKAR ~  1g)
Financial Services Lending and Leasing
Lease Calculator x [l clos=
Lease Calculator =
Parameters
© Calculate Payment(©) Calculate Interest Rate () Calculate Term ©) Calauiate Lease Amount. Initalze || [ Calaate B, Print Quote
*Rate 0.0000 *Time Counting Method | ACTUAL DAYS [=]
“HiCakeMettiod {NIERES LRATE = Total of Base Pmts (=) 0.00 * Instalment Method | EQUATED PAYMENTS [
= Contract Dt 04/09/2018 ) *Term 0 *Bil Method | LEVEL [+
*FirstPmtDt 04/09/2018 [E) Base Payment (=) 0,00 Acarual Start Dt Basis
Maturity Dt 04/09/2018 *Balloon Pmt Amt 10,00
Acarual StartDays 0
Gross Capitalized Cost 0.00
c Calculator Options
Capitalized Cost Reduction 0.00 First Period
Adjusted Capitalized Cost 0.00 =
RESEVHER 0 Rent Collection Method | ARREARS 2] Calendai Doy 70 |
f Residual % |0.0000 *Biling Cyde | MONTHLY [+ Interest 0.0000
Depredation Value (<) 0.00 *Baloon Method | N + 1PMTS [+
Rent Charge (+) 0.00 * Acrual Base Method | ACTUALJACTUAL [=]

Repayment Options

Flexible Repayment Alowed 7] Skip Months
Type 3an [ Feb [ mar [ apr
vay (] 3un ] 30 (] Aug
sep [] 0ct [ Nov [ Dec
Repayment Schedule
View = Format~ Freeze (i Detoch Wrap W e n Save 9§ Clear User Payments
*Seq * Pt Amt * # of Payments * Generated

Mo data to display.

2. Inthe ‘Parameters’ section, Calculate Payment option is selected by default and the
lease calculation method as ‘Rent Factor’. Select the required calculation method and the
calculation parameter to display the applicable fields in Lease Calculator screen.

3. Inthe Lease Details section, complete the following fields:

Field: Do this:

Calc Method Select the type of lease calculation method as one of
the following:

e RENT FACTOR (selected by default)
e INTEREST RATE

Note: Based on the above selection, some of the fields
in Lease Calculator screen are either enabled or
disabled, and if enabled some may be displayed in view
only mode with default supported option. The same is
detailed in respective fields.

Contract Dt Enter the contract date.

First Pmt Dt Enter the first payment date. Ensure that the payment
date is later than the contract date.

Note: This field is disabled for ‘Rent Factor’ type of
lease calculation method and the value is defaulted
from Contract Date. However, for ‘Interest Rate’ type of
lease calculation, this field is either editable or dis-
played in view mode based Rent Collection Method.

Maturity Dt View the maturity date.

Gross Capitalized Cost Enter the gross capitalized cost.
Capitalized Cost Reduction Enter the capitalized cost reduction.
Adjusted Capitalized Cost View the adjusted cap cost.
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Field:

Do this:

Residual Value (-)

View the residual value.

Residual%

Enter the residual percentage.

Depreciation Value (=)

View the asset depreciation value.

Rent Charge (+)

View the rent.

Rate

Enter the rate.

Rent Factor

View the rent factor.

Note: This field is displayed only if the lease calculation
method is ‘Rent Factor’.

Total of Base Pmts (=)

View the total of payments.

Term

Enter the term.

Base Payment

View the base payment amount.

Balloon Pmt Amt

Specify the balloon payment amount.

Note: This field is displayed only if the lease calculation
method is ‘Interest Rate’.

Calculator Options section

Note: Except for Rent Collection Method (as Advance or Arrears), the other fields in this
section are available only for ‘Interest Rate’ type of lease calculation method and the
default values are populated from Setup > Contract screen. Also the Rent Collection
Method field is view only for ‘Rent Factor’ calculation method.

Rent Collection Method

Select the applicable rent collection method from the
drop-down list.

If the lease calculation method is selected as Rent
Factor, the rent collection method is set to ADVANCE
by default. For Interest Rate calculation method, you
can either select ADVANCE or ARREARS.

In case of ADVANCE, the first payment date is
displayed in view only mode and value is automatically
populated from contract date. The first bill would be
generated on contract date.

In case of ARREARS, you can specify the first payment
date as future date (but not the contract date) and bill
would be generated from first payment date.

Billing Cycle

Select the billing cycle frequency from the drop-down
list. System displays the applicable billing cycle by
default based on the product and the calculation
method defined at Setup > Products screen. The edit-
able nature of billing cycle is controlled by the system
parameter UIX_BILL_CYCLE_ALLOWED_IND.
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Field: Do this:

Balloon Method If the lease calculation method is selected as Interest
Rate, then the balloon payment method for accounts
funded using this instrument is ‘N + 1 PMTS’ by default.
Amortization happens based on N+1 payments.

Accrual Base Method Select the accrual method used to calculate interest
accrual for this instrument from the drop-down list.

Time Counting Method Select the time counting method used to calculate inter-
est accrual for this instrument from the drop-down list.

Installment Method For ‘Interest Rate’ type of lease calculation method, the
installment method by defaultis EQUATED PAYMENTS
where-in, the installment amount is same for all billing
cycle.

Bill Method Select the billing method for accounts funded using this
instrument from the drop-down list.

Accrual Start Dt Basis This field will be enabled only if the product category is
selected as Islamic.

Select to define the start date from when the interest
accrual is to be calculated for this lease instrument. If
Effective Date is selected, then the interest is calcu-
lated from Contract date and if Payment Date is
selected then the interest is calculated on basis of (first
payment date minus one billing cycle).

Accrual Start Days This field will be enabled only if the product category is
selected as Islamic.

Select the actual date from when to start interest
accrual for lease is to be calculated.

First Period section

Calendar Days View the number of calendar days between contract
date and the first payment date. The calendar days will
differ based on the calendar method selected.

Interest View the profit accrued for the calendar days.

4. Inthe Lease Calculator section, click Calculate to view the results. You can further
proceed with below sections to define flexible repayment options, repayment/rate
schedule and generate amortization schedules.

9.1.1 Repayment Options

If the calculation involves flexible repayment options, you can include the same through the
following options:
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Note

— This section is not available for ‘Rent Factor’ type of lease calculation method.

Option

Description

Flexible Repay-
ment Allowed

Select the check box to include a flexible repayment schedule in cal-
culation.

On selection, the ‘Payment Change Schedule’ and ‘Rate Schedule’
sections are displayed in addition to ‘Repayment Schedule’ and
‘Amortization Schedule’ sections.

Type

Select any of the following repayment type that you want to use from
the drop-down list.

e UNDEFINED
e SKIP PERIOD
e USER DEFINED
e GRADUATED PAYMENT
will enable the months that can be selected for skipping payments,

but not the maturity month and applicable only for MONTHLY PAY-
MENTS AND ARREARS METHOD.

1. Depending on the repayment type selected, complete the following sections:

e If you have selected the type as UNDEFINED (default), you can only amortize the
payment schedule in respective section.

e If you have selected the type as SKIP PERIOD, the ‘Skip Months’ section is enabled and
allows you to select the months which you want to exclude in repayment schedule by
selecting the adjacent check box. However, you cannot exclude the maturity month and
also this is applicable only for ‘Monthly’ payments and ‘ARREARS’ type of ‘Rent
Collection Method'.

e If you have selected the type as USER DEFINED, You can update ‘Repayment

Schedule’ or ‘Rate schedule (explained in step 2 below) in the respective section. Click

Add in ‘Repayment Schedule’ section and specify the following information:

Field: Do this:
Seq Specify the sequence number of the repayment schedule.
Pmt Amt Specify the repayment amount borrower agreed to pay during

the schedule.

# of Payments

Specify the number of payments borrower agreed to pay for
stated repayment amount during this schedule.

Generated

View if the repayment schedule is generated.

e If you have selected the type as GRADUATED PAYMENT, click Add in ‘Payment
Change Schedule’ section and specify the following information:

Field:

Do this:

Seq

Specify the sequence number in which the repayment is calcu-
lated. It prioritizes the calculation.
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Field: Do this:

Option Type Select one of the following repayment option type:
STEP UP
STEP DOWN
BULLET
Frequency Select the frequency of payment. The default value is TERM.
Period Specify the loan period.
# of Adj. Specify the number of times the STEP UP, STEP DOWN or

BULLET needs to happen.

Value Specify the value.

For STEP DOWN, value ranges from 1 to 99
For STEP UP, value ranges from 1 to 990

For BULLET, value ranges from 1 to 99999999

2. If the calculation includes a promotion, complete the ‘Rate Schedule’ section. Click ‘Add’
and specify the following information:

Field: Do this:
Seq Specify the sequence number of the rate schedule.
Rate Specify the repayment amount borrower agreed to pay during

the schedule.

Start Dt Specify the date on which the borrower agreed to make the
first payment.

3. After you specify all the required information click ‘Calculate’. The system computes the
payment change schedule and populates the Repayment Schedule section.

When you fund the lease application, system copies repayment schedule information to
the lease account on Customer Service screen where it appears in the Repayment
Schedule section.

9.1.2 Amortization Schedule

You can use the calculated payment data to derive the Amortization Schedule. Click
Amortize in the ‘Amortization Schedule’ section. System generates an amortized schedule
with the calculated data and based on the ‘Rent Collection Method’ the first bill is generated
with the following headers:

Field: View this:

Seq Payment number.

Pmt Dt Payment date.

Pmt Amt Payment amount.

Principal Component of the payment amount allocated towards reduction
Amt of the principal balance.
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9.1.3

9.14

9.2

Field: View this:

Interest Amt | Component of the payment amount allocated towards reduction
of the interest balance.

Balance Remaining principal balance.
Amt

You can click Print Report to extract a PDF version of the generated amortized schedule.

Printing a Quote

You can generate a summarized report using the calculated lease details in the format of
quote with lease details and charges.

In the Lease Calculator screen, click Print Quote. The system generates a PDF document to
the default downloads repository consisting of the following information in the respective
headers:

Lease Details

The Lease Details section consists of Contract Start Date, Contract End Date, First Payment
Date, Total Lease Term, and Rate.

Payment/Finance Charge

The Payment/Finance Charge section consists of gross capitalized cost, adjusted capitalized
cost, percentage of residual value, rent factor, base payment, and total of base payments
including rental charges.

Copy Calculation to Contract or Decision tab

Depending on the screen from where you have accessed the tools sub tab, you can copy the
calculated values to either Contract or Decision tab. If you are in Underwriting stage, you can
copy the values to decision tab. Similarly during Funding stage, you can copy the values to
contract tab.

1. Click Initialize and reset the calculator.
2. Click Import values. System displays basic values entered in previous tabs.

3. Select one of the following option “Calculate Payment/Calculate Rate/Calculate Residual
Percent/Calculate Gross Capitalized Cost” and click Calculate. System displays
calculated values based on selection.

Click Copy to Contract/Decision. The calculated details are copied to the respective fields in
Contract/Decision tab.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.
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To calculate a vehicle value

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Tools > Tools
> Vehicle Evaluator

ORACLE
Financial Services Lending and Leasing

> Sotup < =

2. In the Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. |If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-or-
Complete the fields in the Vehicle section.

7. In the Vehicle Evaluator section, click Evaluate.

— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification numbe